Contents

Chapter 1: Getting Started ................................................................. 1
  System Hardware .............................................................................. 1
  About Computer Sound Hardware .................................................. 1
    Recommended Configuration ......................................................... 1
    Minimum Configuration .............................................................. 1
  External Hardware ......................................................................... 2

SmaartLive Installation Procedure ..................................................... 4
  Installing SIA SmaartLive for the First Time .................................... 4
  Installation Instructions ................................................................. 5

Navigating in SmaartLive ................................................................. 6
  The Menu Bar .................................................................................. 7
  Plot Title and Clock ........................................................................ 7
  Cursor Readout .............................................................................. 7
  The Plot Area .................................................................................. 8
  Reference Trace Controls .............................................................. 8
  The Device Bar ................................................................................ 8
  On and Pause Buttons .................................................................... 9
  Display Mode Buttons .................................................................... 9
  Mode Specific Controls ................................................................. 9
  FFT Parameters ............................................................................ 10
  Spectrograph Range and Time Window Controls ............................. 10
  External Device Controls ............................................................... 10
  System Preset Controls ................................................................. 11
  Signal Generator Controls ............................................................. 11
  Signal Level / SPL Display ............................................................. 12
  Input Level Meters ......................................................................... 12
  Show / Hide Trace Buttons ............................................................ 12
  Internal Delay Control ................................................................... 13
  Auto Delay Locator Buttons .......................................................... 13
Chapter 2: SmaartLive Functions ................................................................. 14

Spectrum and SPL Measurements .................................................................. 14
Spectrum Mode Overview .................................................................................. 14
The RTA Display ............................................................................................... 16
The Spectrograph .............................................................................................. 17
The SPL History Display ................................................................................... 18
Spectrum Mode Measurement Parameters ......................................................... 20
Averaging ........................................................................................................... 20
Weighting Curves ............................................................................................. 20
FFT Parameters and Frequency Resolution ......................................................... 21
FFT Parameters .................................................................................................. 22
Timed Spectral / LEQ Measurements ................................................................ 23
SPL Logging ......................................................................................................... 23
Timed Averaging and Logging ............................................................................ 23

Frequency Response Measurements .............................................................. 26
Transfer Function Overview .............................................................................. 26
The Phase Display .............................................................................................. 28
Unwrapped Phase Display ................................................................................. 29
Deviation from Minimum Group Delay ............................................................... 29
Time Windowing .................................................................................................. 30
Averaging and Smoothing .................................................................................. 32
Averaging Data Types: Vector vs. RMS ............................................................. 32
Averaging Schemes ............................................................................................ 32
Smoothing ........................................................................................................... 34
Coherence and Coherence Blanking ................................................................. 34
Coherence Overview .......................................................................................... 34
The Live Coherence Trace .................................................................................. 35
Coherence Blanking ............................................................................................ 36
Magnitude Thresholding ................................................................................... 36

Delay and Impulse Response Measurements ................................................ 38
Impulse Mode Overview ..................................................................................... 38
How The Impulse Response Recorder Works ................................................... 38
Impulse Mode Measurement Parameters ......................................................... 39
Working with Impulse Response Data ............................................................... 40
Automatic Delay Locator .................................................................................. 43
SPL Measurements ................................................................................................................. 44
  Calibrating to SPL .............................................................................................................. 44
    Preferred SPL Calibration method ..................................................................................... 45
    “Quick and Dirty” SPL Calibration .................................................................................. 46
  The Signal Level / SPL Readout .......................................................................................... 47

Working with Stored Measurement Data ........................................................................... 48
  Storing and Comparing Traces ........................................................................................... 48
    Capturing a Reference Trace ......................................................................................... 49
    Displaying Reference Traces .......................................................................................... 50
    Averaging Reference Traces ............................................................................................ 50
  Saving and Retrieving Reference Files .............................................................................. 51
    The General Tab .............................................................................................................. 51
    Tabs A, B, C, D, and E ..................................................................................................... 52

External Device Control ....................................................................................................... 53
  External Device Control Interface ....................................................................................... 53
  Configuring External Devices ............................................................................................ 56

Configuring SmaartLive ...................................................................................................... 57
  Configuring the Screen ...................................................................................................... 57
  Saving and Restoring Program Configurations ................................................................ 58
  Restoring The Default Configuration .............................................................................. 58
  System Presets .................................................................................................................. 58
  Configuring Other Options and Properties ....................................................................... 60
  Jumping to Other Programs ............................................................................................. 60

Measurement Setup ............................................................................................................ 62
  Typical “Real-World” Transfer Function Measurement Setup ......................................... 62

The Internal Signal Delay .................................................................................................. 63

Internal Signal Generator .................................................................................................. 65
  Synchronous Stimulus Signals ......................................................................................... 66
  User Defined Stimulus Signals .......................................................................................... 67

The Locked Cursor ............................................................................................................. 67

Weighting Curves ............................................................................................................... 68

Making a Screen Capture ..................................................................................................... 69
Control Menu ........................................................................................................................... 95
Smaart On ................................................................................................................................. 95
Pause ........................................................................................................................................ 95
Instantaneous ........................................................................................................................... 96
Generate Signal ......................................................................................................................... 96
Reseed Averages ....................................................................................................................... 96
MIDI Program Change ............................................................................................................. 97
Active Input ............................................................................................................................... 97
Reference Commands ............................................................................................................. 98
  Show ..................................................................................................................................... 98
  Select and Capture ................................................................................................................ 98
  Select Next and Capture ....................................................................................................... 98
  Move to Next Register .......................................................................................................... 98
  Capture .................................................................................................................................. 98
  Flip Reference Trace .......................................................................................................... 99
  Erase Reference Trace ......................................................................................................... 99
  Use E as an Averaging Register ........................................................................................... 99
  Hide All Reference Traces ................................................................................................. 100
  Erase All Reference Traces ............................................................................................... 100
  Show Reference Information .............................................................................................. 100
  Save Active Reference Trace ............................................................................................. 103
Delay Time .............................................................................................................................. 103
Locked Cursor Commands ..................................................................................................... 104
  Move Commands ................................................................................................................ 104
  Find Peak ............................................................................................................................. 104
  Find Next Higher ................................................................................................................. 105
  Find Next Lower ................................................................................................................ 105
  Find Low .............................................................................................................................. 106
  Track Peak ........................................................................................................................... 106
  Show Harmonics ................................................................................................................ 106
  Next/Previous Harmonic .................................................................................................... 106
  Remove ............................................................................................................................... 107
System Presets ....................................................................................................................... 107
Amplitude View ....................................................................................................................... 121
Continuous Mode .................................................................................................................... 122
Flip Inputs ............................................................................................................................... 122
Set Delay To Peak ................................................................................................................... 123
Assign Locked Cursor To (Delay Preset) .................................................................................. 123
Compare Delay Presets ........................................................................................................... 124
Auto-Locate Delay Large ......................................................................................................... 125
Auto-Locate Delay Small .......................................................................................................... 126

**View Menu** .......................................................................................................................... 126
Frequency Range ..................................................................................................................... 126
  Primary Frequency Range Controls ...................................................................................... 127
  Secondary Frequency Range Controls .................................................................................. 127
Frequency Scale ...................................................................................................................... 129
Frequency Range Presets (Zooms) .......................................................................................... 129
Amplitude Range ..................................................................................................................... 130
  Primary Amplitude Range Controls ...................................................................................... 130
  Secondary Amplitude Range Controls .................................................................................. 131
Shift Active Trace .................................................................................................................... 132
Shift Reference Trace .............................................................................................................. 132
Cursor ..................................................................................................................................... 132
  Track Nearest Data Point ...................................................................................................... 132
  Show THD ........................................................................................................................... 133
  Move Cursor ........................................................................................................................ 133
Quick Zoom ............................................................................................................................. 133
Device Bar ................................................................................................................................. 134
Input Bar ................................................................................................................................ 135

**External Devices Menu** ....................................................................................................... 136
Devices ................................................................................................................................... 136
External Device Mode ............................................................................................................. 136
Select Next/Previous Filter ...................................................................................................... 137
Flatten Selected Filter ............................................................................................................. 137
Increase/Decrease Frequency .................................................................................................. 138
Increase/Decrease Boost ......................................................................................................... 138
Increase/Decrease Width ......................................................................................................... 138
<table>
<thead>
<tr>
<th>Options Menu</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>139</td>
</tr>
<tr>
<td>Color</td>
<td>139</td>
</tr>
<tr>
<td>Delay</td>
<td>140</td>
</tr>
<tr>
<td>Devices</td>
<td>142</td>
</tr>
<tr>
<td>Graph</td>
<td>144</td>
</tr>
<tr>
<td>Impulse/Locator</td>
<td>147</td>
</tr>
<tr>
<td>Input</td>
<td>150</td>
</tr>
<tr>
<td>Printing</td>
<td>152</td>
</tr>
<tr>
<td>Spectrograph</td>
<td>153</td>
</tr>
<tr>
<td>SPL History</td>
<td>155</td>
</tr>
<tr>
<td>Zooms</td>
<td>156</td>
</tr>
<tr>
<td>Clock</td>
<td>157</td>
</tr>
<tr>
<td>External Devices</td>
<td>158</td>
</tr>
<tr>
<td>Signal Generator</td>
<td>159</td>
</tr>
<tr>
<td>SPL</td>
<td>162</td>
</tr>
<tr>
<td>System Presets</td>
<td>164</td>
</tr>
<tr>
<td>Volume Control</td>
<td>167</td>
</tr>
</tbody>
</table>

### Shortcuts

<table>
<thead>
<tr>
<th>Chapter 5: Basic Concepts and Terminology</th>
<th>170</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Concepts</td>
<td>170</td>
</tr>
<tr>
<td>Averaging</td>
<td>170</td>
</tr>
<tr>
<td>Coherence</td>
<td>170</td>
</tr>
<tr>
<td>Data Window Functions</td>
<td>171</td>
</tr>
<tr>
<td>Decibels</td>
<td>171</td>
</tr>
<tr>
<td>Fast Fourier Transform (FFT)</td>
<td>173</td>
</tr>
<tr>
<td>Frequency Resolution</td>
<td>173</td>
</tr>
<tr>
<td>Impulse Response</td>
<td>175</td>
</tr>
<tr>
<td>Pink and White Noise</td>
<td>175</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>176</td>
</tr>
<tr>
<td>Signal Alignment</td>
<td>177</td>
</tr>
<tr>
<td>Trace Smoothing</td>
<td>177</td>
</tr>
<tr>
<td>The Transfer Function</td>
<td>178</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>179</td>
</tr>
<tr>
<td>Selected Bibliography</td>
<td>182</td>
</tr>
</tbody>
</table>
Chapter 1: Getting Started

System Hardware

Recommended Configuration

- Microsoft® Windows® 98SE, ME, NT 4.0 (or higher), 2000 or XP
- 500 MHz or faster Intel® Pentium® or compatible microprocessor
- 256 Mb system RAM
- 1024 x 768 x 32k-color Super VGA (XGA) display
- Windows-compatible sound hardware with stereo line level input(s), 16-24 bit resolution, selectable sampling rates from 5512 to 48k, capable of full-duplex operation

Minimum Configuration

- Microsoft® Windows® 95, 98, 98SE, ME, NT 4.0 (or higher), 2000 or XP
- 233 MHz or faster Intel® Pentium® or compatible microprocessor
- 64 - 128 Mb system RAM
- 800 x 600 x 256-color Super VGA display
- Windows-compatible sound hardware with stereo line level input(s), 16 bit resolution, 44.1k sampling rate

When installed, the program and support files require approximately 18 Mb of hard disk space but keep in mind that audio data files can take up a lot of disk space. Digital audio waveform (*.wav) files, also called wave files, can be quite large as can SmaartLive’s native reference (*.ref and *.rgp) files and due to the nature of the data these files contain, they don’t compress very well (if you use disk compression software).

About Computer Sound Hardware

SIA SmaartLive does not address computer sound hardware directly. All audio data is obtained through Windows low-level audio APIs and so this program will work with virtually any Windows-compatible sound device. Only the A/D and D/A portion of the computer’s sound hardware are actually used so SmaartLive will work well with a wide variety of computer audio input devices including “off-the-shelf” sound cards for desktop machines and the built-in sound hardware in many notebook computers.

Two independent external line-level input channels (typically in the form of a single, stereo connector) are an absolute requirement for transfer function and impulse response measurements. We would not recommend using the microphone level
inputs on most computer sound cards for any type of measurement application. For microphone measurements, an external mixer or microphone preamp should be used with the computer’s line-level inputs. Additionally, the sound hardware must be capable of full-duplex operation if you intend to use the SmaartLive’s internal signal generator as your stimulus signal source for measurements.

SIA-SmaartLive makes no use of the sound hardware’s synthesis capability (if any). For our purposes the major differentiating factors between sound hardware are the maximum sampling rate, sampling resolution (bits per sample) and signal-to-noise (S/N) ratio. If your computer does not have sound hardware, lacks a line-level input, or you feel that its existing hardware may be problematic for any other reason, there are a number of add-on computer sound devices on the market that you can utilize for audio input and output.

When selecting a sound hardware device for use with SIA-SmaartLive, we recommend you look for the following features and audio characteristics:

• Full-duplex (simultaneous play and record) capability
• 2 independent, external line-level input channels
• 16- to 24-bit sample resolution
• Digital inputs for use with external A/D converters (optional but highly recommended)
• User-selectable sampling rates: SmaartLive supports a number of sampling rates from 5512 up to 48 kHz. An audio input device intended for use with SmaartLive must support 44.1k and/or 48 kHz sampling rates and ideally should support at least one lower sampling rate, somewhere in the range between 4 kHz and 12 kHz.

External Hardware

In addition to your computer and SIA SmaartLive, several pieces of outboard gear may be required to make measurements in the field. The following is a list of equipment you may wish to consider to complete your measurement kit:

• Measurement Microphone: We recommend the best omnidirectional microphone with the flattest frequency response you can reasonably afford. A high-quality microphone preamp and an external phantom power supply are also very useful additions to a measurement tool kit.
• **Mixer or other level adjustment device:** Although you can set relative signal levels at the computer in many cases, it is very helpful to be able to adjust signal levels externally. Also, being able to quickly switch the signals reaching the sound card’s inputs can greatly expedite the measurement process in many cases. A compact mixer with quiet microphone inputs and built-in phantom power is ideal, as it puts several pieces of “the puzzle” in one box.

• **Cables and adapters:** Y-cables are useful for tying the measurement system into sound systems. Also, as most sound cards use unbalanced (2-conductor) inputs, several sets of adapters that allow balanced to unbalanced connections may be necessary.

• **Microphone Calibrator and/or Sound Level Meter:** To make accurate Sound Pressure Level (SPL) measurements with SmaartLive, the program must be calibrated using some external reference. The most accurate way to calibrate to SPL requires the use of a piston microphone calibrator. You can also do a fairly effective job of calibrating SmaartLive to SPL using an SPL meter as a reference if a microphone calibrator is not available. Note that a high quality sound pressure level meter with an audio output can also be very effective as a measurement microphone.
SmaartLive Installation Procedure

Installing SIA SmaartLive for the First Time

Installing SmaartLive on any computer for the first time is a two-stage process. The initial installation will install a temporary, 21-day time limited copy of SmaartLive to enable you to begin using the program immediately. Permanent installation of SmaartLive requires a Permanent Install Code to be created specifically for your machine by SIA. During the initial installation, the SmaartLive installer will generate a text file containing the information you need to register your installation. You can simply send this file to SIA or (outside the USA) the distributor from whom you purchased your copy of SmaartLive, via fax or e-mail, to obtain a Permanent Install Code.

A Word About the Legalities

Notice that when you install SIA SmaartLive, the installation requires you indicate your acceptance of the terms of the End User License Agreement. In doing so, you are agreeing to be legally bound by the terms of this agreement.

*We strongly encourage you to read the terms of the user license before accepting but if you don’t actually read the licence agreement, please read this:*

SIA SmaartLive is licensed on a single-user or, in the case of multi-station site license, a single-station basis. That means that each single user copy or single station installation can be used legally by one person on one machine at any one time.

The SmaartLive installation and copy protection mechanisms are intended to help enforce this restriction. They are not intended to create any sort of hardship for licensed users or prevent any legitimate use of the software. If you need to install your copy of SmaartLive to a second machine for your own use, e.g., on both your office machine and the notebook you computer you use in the field, that is perfectly permissible. Simply perform the initial installation on the second machine as you did on the first and send the in the registration text file generated by the installer to obtain a Permanent Install Code for the second machine. If you require additional installations for additional users, any copy of SmaartLive 5 can be converted to a multi-user site licence which allows you to add additional workstations to the license at a reduced price at any time you need them.
Reinstalling SmaartLive to the Same Computer

Once you have obtained a Permanent Install Code for a specific computer, this same code should work if you need to reinstall the software to that same computer again later for some reason. When reinstalling, the installer will ask if you already have a Permanent Install Code for this machine and if so, you can simply re-enter that code to bypass the temporary installation and registration procedure. If for some reason the installer will no longer accept the original Permanent Install Code issued for a given machine, just proceed with the temporary installation as you would for a new machine and send in the registration information generated by the installer to receive a new Permanent Install Code from SIA.

Installation Instructions

Installation of SmaartLive is a fairly straightforward procedure. The installation program should start automatically when insert the installation CD in your CD or DVD drive and the will guide you through installation process. If for some reason the installer does not start automatically just double-click the My Computer icon on the Windows desktop then double-click the icon for the drive in the My Computer window.

We strongly recommend that you close all other Windows programs, particularly any automatic anti-virus and/or system monitor software you may have running, before attempting to install SmaartLive. Virtually every installation problem ever reported for SmaartLive has turned out to be the result of conflicts between the installer program and third-party anti-virus and/or system monitor utilities.

If you are installing SmaartLive to this machine for the first time, you will be asked to enter the license code from the card that was included in your package along with your name, company name and other contact information. If you are reinstalling to a machine for which have already obtained a Permanent Install Code, select the reinstall option and enter your code to go directly to the permanent installation procedure. When the installation process is completed, restart your computer if you are prompted to do so. Otherwise, you can begin using SmaartLive immediately. Just double click the SmaartLive icon on the Window desktop or click the Start button on the Windows Taskbar, then select Programs > SIA SmaartLive > SIA SmaartLive. If you experience any problems during or after installation, refer to Chapter 6 of this manual, beginning on page 184, for troubleshooting and technical support information.
Chapter 1: Getting Started

Navigating in SmaartLive

The SmaartLive interface is designed to put the functionality required for most sound system measurement, optimization and control applications literally at your fingertips. On-screen controls give you one-click access to the most commonly used functions. The extensive use of context sensitive dialog boxes and pop-up mouse menus means you may never have to open a menu to get at all but the most advanced features.

In most cases, simply clicking the label or readout field for an on-screen control or readout will allow you to access nearly any associated parameter or option you are likely to need. Advanced users will find the high level of control and flexibility one would expect in a truly professional measurement and control platform easily accessible through menu commands, hot keys, and the Options dialog box.

A brief description of the basic elements of the SmaartLive program window follows. Detailed information on SmaartLive displays and functions can be found in Chapter 2 of this manual. Chapter 4 contains complete listing of all menu commands and options.
The Menu Bar

SmaartLive’s most frequently-used functions and commands are available as on-screen controls, pop-up menus and dialog boxes and/or keyboard shortcuts. Pull-down menus, accessible from the Menu Bar, provide an alternate means of selecting virtually all of these same functions, in addition to providing access to a some of SmaartLive’s less frequently used features.

To activate a pull-down menu from the Menu Bar, click on its name using your mouse or hold down the [Alt] key while pressing the key corresponding to the underscored letter in the menu name. When a menu is active, commands may be selected by clicking on their names with your mouse or by typing the underscored letter.

Menu commands followed by ellipses (three periods...) call dialog boxes. An arrow-head to the right of a menu item indicates that this command activates a nested, “fly-out“ sub-menu. Note that menus in SmaartLive also list the associated shortcut keys for each command (if applicable). A complete listing of all SmaartLive menu commands and options begins on page 90.

Plot Title and Clock

The plot title text is set from the Graph tab of the Options dialog box (see page 144 for details). Clicking on the plot title field with your mouse opens Graph options in any display mode except Impulse mode. To the left of the plot title field is a clock display. The clock display has several options you can access by clicking on the clock with your mouse (see Clock on page 157).

Cursor Readout

The cursor readout above the plot area in SmaartLive give you a numeric coordinate values for the location of the mouse tracking cursor in amplitude/magnitude, frequency or time, phase shift, etc., depending on the current display type and options selected. For example, when the Locked Cursor (see page 67) is present, three sets of cursor values appear in this readout, the locked cursor position, the mouse tracking cursor position and the difference (delta) between the two cursors (locked and movable).
Chapter 1: Getting Started

The Plot Area

The largest section of the SmaartLive program window is *Plot Area*, used for all of SmaartLive’s primary data displays. More information about SmaartLive data displays can be found in *Chapter 2* of this manual beginning on page 14.

Reference Trace Controls

The reference trace controls are used to capture, store, and display “snapshots,” of the live traces in both *RTA* and *Transfer Function* modes. For more information about SmaartLive’s reference trace feature, please refer to *Working With Stored Measurement Data*, beginning on page 48.

The Device Bar

The *Device Bar* in SmaartLive gives you one-click access to external devices assigned to buttons on the bar. The device bar is visible above the title label for the plot area when you select *Device Bar* from the view menu or click the *Bar* button above the *selected device* field to the right of the plot (see next page). The number of device bar buttons available can vary according to your screen resolution and the SmaartLive program window size.

Configured devices can be assigned to buttons through the *External Device Information* dialog box or bar by simply clicking any unused button with your mouse when the bar is visible. You can *change* the device assigned to any button or un-assign a device button by clicking on it with your *right* mouse button then selecting *Edit Button* or *Remove Device From Button* from the pop-up menu.

For more information on configuring and controlling external devices in SmaartLive, please refer to The *External Device Control Interface* on page 53 and the *Configuring External Devices* dialog box description on page 56.
On and Pause Buttons

In all real-time (RTA, Transfer Function, or Spectrograph) operating modes, clicking the On button starts the SmaartLive analyzer and begins plotting data from your sound card’s inputs in real time. The Pause button to the left of the On button freezes the display leaving the live trace(s) displayed in the Plot Area. On and Pause are a toggle commands, meaning that clicking either button (or pressing [O] or [P] keys on your keyboard) will stop or pause the analyzer when it is running and start the analyzer if it is paused or stopped.

Display Mode Buttons

The Display Mode buttons switch the SmaartLive analyzer between the four main display modes (operating modes). For more information about SmaartLive display modes, please refer to the following topics in Chapter 2 of this manual:

- Spectrum Mode Overview (page 14)
- Transfer Function Overview (page 26)
- Delay and Impulse Response Measurements (page 38)

Mode Specific Controls

The controls in the area just below the primary display mode selector buttons (see above) and immediately to the right of the plot will change based on the primary display mode currently selected. For example, in Transfer Function mode, this area contains buttons for the phase display and coherence function, swap functions. In Spectrum mode, there are buttons for selecting from the three available main display types (RTA, Spectrograph and SPL History) plus other controls specific to those displays. For more information about SmaartLive main display modes, please refer to the sections on Spectrum and SPL Measurements, Frequency Response Measurements and Delay and Impulse Response Measurements in Chapter 2 of this manual beginning on page 14.
Chapter 1: Getting Started

FFT Parameters

The FFT Parameters control, shown here on the left, provides information about the current analyzer input parameters and allows you to make changes. Clicking on this control with your mouse will pop up a dialog box that allows you to select values for any of the FFT parameter displayed here. See Spectrum Mode Measurement Parameters on page 20 and Impulse Mode Measurement Parameters on page 39 for details.

Spectrograph Range and Time Window Controls

In RTA mode, the Spectrograph Range control appears immediately below the FFT Parameters readout. This control provides a legend for the for the range of colors that represent magnitude values on the Spectrograph display (see page 153). Clicking on this control with your mouse takes you to the Spectrograph tab of the options dialog box where you can change display properties for the Spectrograph.

External Device Controls

The external device controls are used to access SmaartLive’s external device control interface. When one or more devices are configured in Smart Live, clicking on the Ext. Device label field with your mouse pops up a menu that allows you to select any...
configured device/channel as the current device. Selecting *Configure* on this menu will open the *External Device Information* dialog box. If no devices are configured, clicking this field opens the *External Device Information* dialog box immediately to allow you to configure a new device definition. Clicking the *Bar* button to the right of the *Ext. Device* label field turns the Device Bar on and off.

For more information about controlling external devices in SmaartLive please refer to the *External Device Control Interface* section in Chapter 2, beginning on page 53.

**System Preset Controls**

The system preset controls give you on-screen access to SmaartLive’s *System Presets* (macros). The *Store* and *Load* buttons can be used to save current settings as a preset or recall any existing preset. Clicking on the *Presets* label (above the *Load* and *Store* buttons) with your mouse opens the System Presets dialog box allowing you to create, browse, edit and recall program settings stored as presets. For more information about this feature, see *System Presets* on page 58, and the sections on System Preset commands (page 107) and System Preset options (page 164).

**Signal Generator Controls**

The signal generator controls give you one-click access to SmaartLive’s internal signal generator. The button labeled *Gen* turns the signal generator on and off. The spinner to the right of the *Gen* button sets the output level in decibels. Clicking anywhere in the output level readout or the *Generator* label field opens a dialog box with additional controls for the signal generator. For more information, please refer to *Internal Signal Generator* on page 65 and *Signal Generator* (options) on page 159.
Signal Level / SPL Display

The Signal Level / SPL Display gives you a numeric readout of the overall signal level for one of the two input signals and can be calibrated to provide Sound Pressure Level (SPL) readings. For details about this feature, refer to The Signal Level / SPL Readout on page 47, Calibrating to SPL on page 44, and SPL on page 165.

Input Level Meters

The input level meters in SmaartLive show you the levels of the two input signals relative to the maximum input voltage (regarded as 0 dB) for the A/D converters on the selected input device. Each meter includes a clip indicator that lights if the input signal level exceeds the A/D converter’s maximum input voltage.

Clicking on either meter in RTA mode will make the corresponding trace active and bring it to the front of the RTA display z-axis stacking order. Note that the Signal Level/SPL Display (see above) also tracks the active input. The Active label fields below the two meters indicate which input is active. Clicking anywhere on either meter in Transfer Function mode brings the live transfer function trace to the top of the z-axis stacking order on the plot and assigns the corresponding input to the Signal Level/SPL Display. See Active Input on page 97 for more information.

Show / Hide Trace Buttons

The two buttons immediately below the input level meters can be used to show/hide either of the two live traces in RTA mode. See Show Inputs on page 109 and Show (Traces) on page 118 for more information.
Internal Delay Control

![Delay Control](image)

The on-screen delay control provides access to SmaartLive’s internal signal delay. The internal delay can provide up to 750 milliseconds of internal delay (in 1/100-millisecond increments) for one of the two input signals, mainly used to provide signal alignment for transfer function measurements. For more information, see *The Internal Signal Delay* on page 63.

Auto Delay Locator Buttons

The *Auto Sm* and *Auto Lg* buttons activate SmaartLive’s *Automatic Delay Locator* using either the small or large time window preset (respectively). For more details, see *Automatic Delay Locator* on page 43.

![Set Delay To Peak](image)

Note that in Impulse mode, this feature is not required and so the *Auto Sm* and *Auto Lg* buttons are replaced by a *Set Delay To Peak* button used to call the *Find Peak* command (see *Locked Cursor* on page 67 for more information).
Chapter 2: SmaartLive Functions

Spectrum and SPL Measurements

Spectrum Mode Overview

SIA SmaartLive’s primary analysis and display modes are divided into three main categories: Spectrum, Transfer Function and Impulse Response. Of the three, new user’s will probably find Spectrum mode to be most immediately familiar because it includes a software implementation of one of the most widely used audio analysis tools, the real-time audio spectral analyzer (RTA Display). The RTAs display, allows you to see the amount of energy present in various frequency ranges, typically fractional octave bands, across the audible spectrum.

Real-time spectral analysis is an excellent tool for any number of applications including feedback hunting, ear training, and monitoring the frequency content of program material. In the past, RTAs were also commonly used for sound system equalization but their usefulness in this application has proven severely limited. This is why dual-port FFT analyzers such as SmaartLive, along with earlier systems based on Time Delay Spectrometry (TDS) and Maximum Length Sequence (MLS) measurement techniques have gradually replaced RTAs as the tools of choice for professional sound system equalization and optimization.

Dual-FFT, MLS and TDS analyzers all use very different approaches to measuring the response of a system. Of the three, FFT-based analysis offers the greatest flexibility and ease of use however it also requires a lot more computing power than MLS or TDS and really only became a practical option for PC-based analysis systems in the mid-1990s. One thing all of three techniques have in common though, is that they enable you to see all three “dimensions” of sound (frequency, energy, and time) whereas a simple RTA is completely blind to the element of time.

System tuning aside, a good RTA is still a very handy tool to have on hand for other applications and SmaartLive provides you with a very powerful and flexible set of tools for real-time spectral analysis. In addition to the standard RTA display, a second Spectrum mode display type called the Spectrograph, is a way of looking at changes
in RTA data over some period of time. The Spectrograph display plots time (in FFT frames) on the x-axis and frequency on the y-axis with amplitude represented by color.

The third Spectrum mode display type is the SPL History display which allows you to look at changes in broadband signal level or Sound Pressure Level (SPL) over some period of time. SPL is a broadband measurement encompassing all audible frequencies although it is typically measured with a frequency-dependent weighting curve of some kind (typically ANSI/IEC “A” or “C” weighting). Note that for SPL measurements, SmaartLive must be calibrated to SPL. For more information on SmaartLive’s sound level measurement capabilities, see Signal Level/SPL Readout on page 47 and Timed Spectral/LEQ Measurements on page 23.

**Selecting Display Types in Spectrum Mode**

Any of the three Spectrum mode graph types, RTA, Spectrograph or SPL History can be displayed alone or on a split screen display with either of the other two. The default Spectrum mode display, i.e., the one that comes up first when you open SmaartLive is the RTA graph. To display a second graph type along with the RTA display click the Spectro (Spectrograph) or SPL (History) buttons. This will shrink the RTA display to fit the lower half of the plot area and insert the second graph type in the space above it. When two graphs are displayed together in SmaartLive the lower one is considered the primary graph and the one above is regarded as the secondary.

The idea of primary and secondary graphs is mainly of interest for two reasons:

- There are separate sets of menu and keyboard commands for setting the frequency and magnitude ranges of the primary and secondary graphs (see Frequency Range and Amplitude Range on pages 126 and 130 for details).

- When two graphs are displayed together, clicking the button for the third graph type swaps out the secondary graph. For example, if the RTA and SPL History graph are currently displayed with the RTA graph on the bottom, clicking the Spectro button will replace the SPL History graph with the Spectrograph. Clicking the RTA button would then make the Spectrograph expand to fill the entire plot area and would
become the primary graph so that if you subsequently clicked the RTA or SPL buttons again, the corresponding graph type would appear above the Spectrograph in the secondary position.

The RTA Display

The RTA display in Spectrum mode functions as a dual-channel, FFT-based real-time spectrum analyzer. This display plots the spectrum (magnitude values by frequency) of either or both of the two sound card inputs. The colors of the bars or traces correspond to the colors used in the left and right input level meters to the right of the plot. **Real-Time operation of the SmaartLive analyzer begins when you press the Smaart On button.**

The RTA plot puts magnitude on the (vertical) y-axis and frequency on the (horizontal) x-axis. When the RTA display is active, time-domain audio data from the A/D converter of your sound hardware is continuously transformed into the frequency domain using a mathematical technique called the Fast Fourier Transform (FFT). The FFT data can be plotted on the RTA display in real time, either in its raw “narrowband” form or processed into octave or fractional-octave bands. The magnitude for each frequency band (or data point) on each of the two input channels is updated several times per second — exactly how fast the RTA display updates will depend on the speed of your computer and on the FFT size and sampling rate being used. The (y-axis) magnitude range of the RTA plot can be changed using the Amplitude Range Zoom and Move keyboard or menu commands.

Using the default “Full Scale” display calibration, the maximum magnitude value of 0 dB is equal to the maximum A/D amplitude value obtainable at the current sampling resolution (e.g., 16 or 24 bits per sample). That means that a sine wave input signal with amplitude exactly equal to the maximum input voltage of your sound hardware’s A/D converter should yield 0 dB at the sine wave’s frequency on the RTA plot. Full Scale calibration is perfectly adequate for any number of applications where you are primarily concerned only with the relative differences between frequencies. SmaartLive also includes a calibration function that allows you to “move” the decibel range of the raw incoming data up or down to correlate to Sound Pressure Level (SPL) or any other external reference.
The frequency scale (x-axis) of the RTA plot may be displayed in octave, 1/3-, 1/6-, 1/12-, or 1/24-octave resolution. Narrowband resolution with linear or logarithmic scaling is also available if the “Allow Narrowband RTA” option is selected on the Graph tab of the Options dialog box. The frequency range of the RTA plot may be changed by recalling one of four user-configurable Frequency Range Presets (Zooms) or the X Range Zoom and Move keyboard or menu commands.

**The Spectrograph**

The SmaartLive Spectrograph is a second type of RTA display that provides a way of looking at the frequency content of an input signal over some period of time. Instead of showing you just the results of one FFT measurement at a time (whether averaged or instantaneous), as is the case on the RTA display, the live Spectrograph can show you a record of the most recent 100 frames or more.

One way to think about the Spectrograph display is in terms of a common real-time spectrum analyzer (RTA). On a typical RTA display, magnitude values for each fractional octave frequency band are indicated by vertical bars of varying height. If, instead of rising to a different height, each frequency band (or individual FFT bin) changed color to indicate higher or lower magnitude, you would end up with a horizontal line made up of different colored segments that showed the spectrum of a signal at a given moment. If you then rotated that line 90°, you would have one vertical slice of a Spectrograph display. Stack a number of these slices side by side and you would have a plot that shows you how the spectrum of the input signal changed over some period of time. That’s the SmaartLive Spectrograph.

The Spectrograph display effectively shows you three dimensional data (time, frequency and energy) on a two dimensional plot with time on the x axis, frequency on the y axis and magnitude represented by color. Exactly which color represents which magnitude value is determined by the magnitude range currently specified and the number of colors used and the selected start and end colors. All of these options, along with the time range of the plot (in FFT frames) can be set from the Spectrograph tab of the options dialog box. Out of range values above the current magnitude range
specified for the Spectrograph are indicated on the plot in white. Magnitude values below the current magnitude range are indicated in black.

The magnitude range of the Spectrograph plot is displayed on the Spectro Range spinner that appears to the right of the main plot area in Spectrum mode. Clicking this control with your mouse will take you directly to the Spectrograph options dialog to allow you to make changes. The Spectrograph magnitude range can also be changed using the (Primary or Secondary) X Range controls in the View menu and their associated keyboard commands.

The frequency scale of the Spectrograph can be set by the Scale spinner that appears to the right of the plot in Spectrum mode or using the (Primary or Secondary) Y Range commands in the View menu. The frequency (y-axis) range of the Spectrograph can be set using one of the four user-configurable Frequency Range Presets (Zooms) assigned to the number keys 1-4 on your keyboard. When the Spectrograph is displayed together with the standard RTA display in Spectrum mode, their frequency ranges are normally slaved together so that changing one also changes the other by an equal amount. The frequency ranges of the two plots can be made entirely independent by de-selecting the check box labeled “Spectrograph Frequency follows RTA Frequency” on the Zooms tab of the Options dialog box.

The SPL History Display

SmaartLive’s SPL History display provides a convenient way of looking at changes in overall (broadband) signal level or Sound Pressure Level (when calibrated to SPL) of the Active Input signal over some period of time. SPL History can be displayed by itself or on a split screen with the RTA or Spectrograph display (see Spectrum Mode Overview on page 14 for more information).
The SPL History feature works together with the Signal Level/SPL Readout and simply plots the decibel value calculated for the numeric readout with each main display update. One important distinction is that when using the default, Full Scale (internal) calibration, the Signal Level/SPL Readout and SPL History plot use time domain data, as measured by Input Level Meters. When calibrated to SPL (or some other external reference) SPL metering and the SPL History plot are based on frequency-domain FFT data.

SPL History can be plotted as a solid histogram or as a linear “fever chart.” Like the Spectrograph, the SPL History plot tracks only one of the two analog input channels at a time. The normal trace color for this display reflects the meter color of the current Active Input channel but will change color when the magnitude of the input signal exceeds the alarm levels specified for SPL metering. The plot type and the time and magnitude ranges of the SPL History display are set from the SPL History tab of the main Options dialog box. The magnitude range for this display can also be changed using the Amplitude Range Zoom and Move keyboard or menu commands. Parameters for the Signal Level/SPL Readout, which also affect the SPL History display, are set from the SPL Options dialog box.

Note that when the mouse cursor is positioned over the SPL History, the cursor readout shows the Minimum and Maximum SPL values along with the SPL value currently plotted at the cursor’s time coordinate. Minimum/Maximum SPL values are preserved for the duration of your SmaartLive session or until they are flushed and reset using the Restart SPL History command ([Ctrl] + [R]).

Also note that in addition to the (graphical) SPL History display, SmaartLive can sample the output of SPL metering at user-specified intervals and record this data to an ASCII text file for off-line post analysis in other programs. For more information on SmaartLive’s logging capabilities, please refer to SPL (options) on page 162 and Timed Spectral / LEQ Measurements on page 23.
Chapter 2: SmaartLive Functions

Spectrum Mode Measurement Parameters

Averaging

Averaging is used in RTA, Spectrograph and Transfer Function measurements to increase the effective signal-to-noise (S/N) ratio of the measurement and reduce the influence of transient events, helping stabilize the display and make overall trends easier to see. All averaging in Spectrum mode is RMS averaging however there are three basic integration schemes available: linear “first in, first out (FIFO), exponential (Fast, Slow and variable) and Infinite. FIFO averaging is a simple “arithmetic” average of some number (2, 4, 8, 16...) of the most recent FFT frames with equal “weight” given to each. Note that when the number of averages set to 1 no averaging is performed and each display update includes only the magnitude data from the most recent FFT frame.

Infinite (Inf) averaging is similar to FIFO averaging in that every FFT measurement in the average is given equal weight but rather than looking at a fixed number of the most recent FFT frames, this option keeps a running of average of all FFTs recorded since the last time the buffer was flushed. Averaging buffers are flushed (re-seeded) each time you change averaging parameters, FFT size or sampling rate, stop the analyzer or switch between main display modes. You can also force the buffers to flush at any time by pressing the [V] key on your keyboard.

Exponential averaging gives more relative weight to the most recent data while the influence of older data “decays” exponentially. The options labeled Fast and Slow are exponential averaging routines that emulate the timing characteristics of Fast and Slow time integration circuits in ANSI/IEC standard sound level meters as closely as possible. The Exp option is similar to the Fast and Slow options however its “half-life” is user-definable and is set from the Inputs tab of the main Options dialog box.

Weighting Curves

The Weight spinner allows you to apply frequency-dependent weighting curve to RTA, Spectrograph and Transfer Function mode Magnitude displays. User defined
weighting curves are supported along with the stock options of (ANSI/IEC) A and C or None (no weighting). For additional information, see *Weighting Curves* on page 20.

**FFT Parameters and Frequency Resolution**

For both real-time spectral and frequency response (Transfer Function) measurements, one of the most important implications of the FFT parameters you select is the frequency resolution of the FFT. The frequency resolution of FFT data is a function of the FFT size and sampling rate. FFT data points, also called “bins” are spaced linearly, with one bin every \( Q \) Hertz, from 0 Hertz up to one half the sampling rate (the Nyquist frequency), where \( Q \) is equal to the sampling rate (in samples per second) divided by the FFT size (in samples).

The problem, of course, is that we human beings hear logarithmically, meaning that it is generally more useful for us to look at audio data on a logarithmic scale. SmaartLive uses a variety of techniques to transpose linear FFT data into more meaningful logarithmic displays but it is important to remember that when doing so, the lowest octaves will always have less real frequency resolution than higher octaves because the underlying FFT data is always linear.

The practical implication of all this is that getting good detail at very low frequencies may require increasing the FFT frequency resolution either by increasing the FFT size or by decreasing the sampling rate. Note that either approach increases the FFT time constant — the amount of time required to collect all the samples for a given FFT size at a given sampling rate.

The trade-off is that time resolution effectively decreases as frequency resolution increases because each FFT then represents a longer period of time and because larger FFTs take longer to process. As a result, rapid changes in the input signal(s) data may be masked as the FFT time constant is increased. SmaartLive gets around this problem to some extent by using overlapping time domain data for FFTs however your computer will still need more time to process each display update as the FFT size is increased.

As a rule of thumb for real-time measurements, when looking at the entire audio spectrum, an 8k FFT size at 44.1 or 48k sampling rates provides a reasonable level of detail for low frequencies and still allows for reasonably good RTA ballistics on most machines. You will want to increase the FFT size and/or decrease the sampling rate to get better detail at very low frequencies. When you are more concerned with transient
events and/or what’s happening at higher frequencies, use higher sampling rates and smaller FFT sizes to provide faster display updates and more detailed time resolution.

**FFT Parameters**

In Spectrum and Transfer Function Modes, there is one combined control for all FFT Input parameters. Clicking anywhere on this control pops up the FFT Parameters dialog box shown below. In Impulse mode, the parameters are a little different and there are separate controls for each parameter (see below).

The Spectrum/Transfer Function mode FFT Parameters dialog box is composed of the following elements:

**Sample Rate Selector** – Each time you start SmaartLive or change your Wave-in device selection, the program polls your computer’s sound hardware to determine what sampling rates the selected input device supports and places supported sampling rates in the Sample Rate selector menu.

**FFT Size Selector** – The FFT Size selector’s pop-up menu allows you to select an FFT frame size from 128 to 32k samples in Transfer Function, RTA and Spectrograph mode, or 128 to 512k in Impulse mode.

**Time Constant** – The time constant, or “time window” of an FFT is a function of the FFT size and sampling rate. SmaartLive automatically calculates the time constant yielded by the currently-selected FFT size and Sampling Rate and displays it in the Time Constant field. Clicking the down arrow button for this field with your mouse will display a list of time constants for every available FFT size, given the current sampling rate. Selecting a time constant directly from this list will automatically set the corresponding FFT size in the FFT field.

**Frequency Resolution** – The frequency resolution of an FFT is a also function of the FFT size and sampling rate. SmaartLive automatically calculates the frequency resolution yielded by the currently-selected FFT size and Sampling Rate and displays it in the FR field. Clicking the down arrow button for this field will displays a list of frequency resolutions for every available FFT size, given the current sampling rate. Selecting a frequency resolution from this list will automatically set the corresponding FFT size in the FFT field.
Timed Spectral / LEQ Measurements

There are many applications that require monitoring, logging and averaging of spectral and SPL data over some period of time. A couple of typical examples are Equivalent Sound Level (L_{EQ}) and Percentile Noise (e.g., L_{10}, L_{50}, L_{90},...) measurements, used for documenting environmental noise, and timed spectral averages still commonly used as a basis for certifying cinema sound systems. SmaartLive offers extremely flexible logging and averaging capabilities that allow you to monitor and log SPL, L_{EQ} and Percentile Noise, or spectral data with averaging periods ranging from one second to 24 hours and total measurement periods of up to a week.

SPL Logging

A simple SPL logging function that samples SPL values at specified intervals and logs this data to an ASCII text file is accessible through the SPL Options dialog box. This feature does not offer any sort of averaging/integration or post-processing capability but places no restrictions (other than the amount of available disk space) on the duration of the logging period and interferes the least with other analyzer operations.

Timed Averaging and Logging

More advanced timed measurement capabilities, based on power averaging of magnitudes over specified sampling periods, are available through the Timed Average / LEQ feature. These functions are configured and activated through the Timed Average / LEQ Setup dialog, accessible from the Spectrum menu.

SmaartLive offers three types of timed measurements: Timed Average, LEQ Log, and Spectrum Log.

- **Time Average** is a one shot timed spectral power average over a specified period that outputs its measurement results in narrowband resolution as a SmaartLive Reference Trace. Sampling Periods for this measurement can range from 1 second to 24 hours.

- **LEQ Log** calculates L_{EQ}, L_{10}, L_{50}, and L_{90} along with L_{MIN} and L_{MAX} (the highest and lowest SPL values encountered during the sampling period) on the fly for each specified Sampling Period, along with cumulative values for all of the above for the entire duration of the measurement. The results of this measurement are logged to a
standard, tab-delimited ASCII text file suitable for import into a spreadsheet or word processor document. Sampling Periods can range from 1 minute to 24 hours over a total measurement duration of up to 1 week (168 hours).

- Spectrum Log records power averaged octave or fractional octave spectral measurements for each specified Sampling Period and logs its results to a tab-delimited ASCII text file. Unlike the Timed Average and LEQ Log functions, Spectrum logging records only the raw, unweighted spectral data. Sampling Periods can range from 1 second to 24 hours with a maximum total measurement duration of up to 1 week (168 hours). The Create LEQ Report from Log File function can be used to post process Spectrum Log files to calculate A/C weighted and unweighted $L_{EQ}$, $L_{MIN}$, $L_{MAX}$ and Percentile Noise values from the spectral data file.

**Notes:**

1. **To obtain valid sound level measurements of any kind, including SPL, $L_{EQ}$, and Percentile Noise, SmaartLive must be calibrated to SPL before performing the measurement.**

2. Spectrum Logging offers a great deal of flexibility in terms of possible uses for the data once acquired but requires the relatively large amounts of disk space — up to 8 Mb per hour — for its log files.

3. When capturing banded spectral data with the intention of post-processing for $L_{EQ}$ and Percentile Noise the Sampling Period specified must be smaller, by a factor of 10 - 100, than the smallest integration period(s) you need to report. For example, if you need to calculate $L_{EQ}$ and Percentile Noise for one-minute intervals using spectral data, the Sampling Period should be set to no more than 6 seconds when acquiring the data and 1 second (the minimum allowed) would really be better, if you have sufficient disk space. If you only needed to report $L_{EQ}$/Percentile Noise at one-hour intervals, a sampling period of 30 seconds to one minute might provide sufficient time resolution.
4. When performing Timed Averaging and Spectral Logging, SmaartLive is locked in Spectrum mode and will not allow certain display/parameter changes for the duration of the measurement.

5. LEQ and SPL Logging do not restrict the use of SmaartLive’s other features but be aware that switching to Impulse mode or performing auto-delay measurements while logging is active will interrupt acquisition of SPL data and may result in gaps in the resulting log file. Power saving options on some computers may also interfere with data acquisition in some cases, particularly when logging over extended periods of time.
SmaartLive’s real-time Transfer Function measurement capability is an extremely useful tool for setting up sound system equalizers and crossovers, as described in Chapter 3 of the SIA SmaartLive User’s Manual. A transfer function is a mathematical comparison of complex FFT data from two signals — typically the input and output of a device or system. SmaartLive uses this calculation to find how one signal differs from the other.

By comparing what goes into a device or system with what comes out, SmaartLive can calculate both its frequency (magnitude and phase) response very precisely. A major advantage of this dual-channel approach is that it works with a wide variety of test signals, including music or other recognizable program material.

To make a transfer function measurement, a test signal is split at the source and sent to both the system under test and the Right sound card input (channel 1) on your computer. This will be the “reference” signal. The output of the system is returned to the Left sound card input (channel 0). This is the “measurement” signal.

Real-Time operation of the SmaartLive analyzer begins when you press the Smaart On button. In Transfer Function mode, SmaartLive performs FFT calculations using audio data from the two inputs then compares the two sets of FFT data and displays a single trace showing the relative magnitude difference between the two signals frequency by frequency.

The default Transfer Function mode Magnitude display plots magnitude values on the y axis with 0 dB in the center and positive and negative decibel values above and below the zero line. The x axis of the plot shows frequency and is normally displayed in logarithmic scaling with grid lines at octave intervals. On the standard magnitude
display, a value of 0 dB for a given frequency data point represents an equal amount of energy (i.e., a relative difference of zero) in both the reference (system input) and measurement (system output) signals at that frequency. A positive or negative decibel value for a given frequency indicates more or less energy in the measurement signal relative to the reference signal at that frequency.

Note that a linear frequency amplitude scaling options are also available for the transfer function Magnitude display. Linear amplitude scaling, intended primarily for use in making impedance measurements, places 0 dB at the bottom of the plot (rather than the center) and labels the vertical scale in Ohms. The Phase display in Transfer Function mode is a second plot showing the relative difference in phase between the two signals for each frequency.

The default SmaartLive Transfer Function mode trace has 24 data points for each octave. The exception is that the two lowest octaves will have a total of 24 points when using a sampling rate of 44100 or 48000. When using a sampling rate of 96000, the first 24 data points will be distributed across the lowest three octaves and there is an additional octave of data on the high end. This equal resolution per octave is achieved by combining the results of multiple FFT calculations for each display update. The fixed-point-per-octave (FPPO) transfer function display tends to be much easier to read, particularly at higher frequencies, than traces based on a single, fixed FFT size, due to the inherent, linear frequency distribution of FFT bins.

Pressing the Swap button in Transfer Function mode transposes (swaps) the inputs to the Transfer Function calculation so that SmaartLive divides the reference signal at the Right input (channel 1) by the measurement signal at the Left input (channel 0). This feature is mainly used when you want to display the inverse (upside-down) magnitude response curve of an EQ or processor channel to facilitate using the room/system response as a template for setting EQ filters. The swap feature could also be used if you happen to get the reference and measurement signals connected backwards but physically swapping the cables is usually preferable and helps to avoid confusion.

Important Notes:

- Because the Transfer Function works by comparing two input signals any delay between the two signals must be found and compensated to obtain a valid
measurement (an “apples-to-apples” comparison). This can be accomplished using SmaartLive’s delay locator and internal delay.

- Nonlinear signal processing devices such as limiters and compressors should not be used when performing impulse response and Transfer Function measurements (see Coherence Overview on page 34).

The Phase Display

Activating the Phase display in Transfer Function mode splits the plot area and brings up a second plot (above Magnitude response plot) that shows the phase shift, or time difference in the measurement signal relative to the reference signal frequency by frequency. For most applications you will probably find the standard wrapped phase display, labeled in degrees, to be most useful of the phase display options. This is the most “real” display type because it is base on the actual transfer function data (rather than extrapolated from that data) and in practice, it is also the most stable and reliable of the three.

On the default “wrapped” Phase display plot, all phase values are plotted within a 360° range of +180° to –180° with 0° in the center. This 360° range represents one complete cycle at any given frequency. Optionally, the Phase display may be set to calculate and display phase shift as deviation from minimum group delay (in milliseconds), rather than degrees. This option requires an extremely stable measurement signal to be very useful and is probably more applicable for purely electronic measurements such as measuring a crossover than for acoustic measurements (i.e., measurements made using a microphone) in its present form.

A phase value of 0° (no relative phase shift) for a given frequency data point means that both the measurement and reference are arriving at exactly the same point in a cycle at that frequency. Frequencies at which the measurement signal is arriving earlier in a cycle relative to the measurement signal will show a negative phase shift. At frequencies where the measurement signal is arriving later in the cycle you will see a positive phase shift.

You can move the 0° line on the wrapped phase display up or down on the plot in 45° increments by holding down the [Alt] key and pressing the [Page Up] or [Page Down]
keys on your keyboard. [Alt] + [End] sets the phase range to 0° - 360° (bottom to top). Pressing [Alt] + [Home] resets the phase range to the default +180° to –180°.

Unwrapped Phase Display

Since higher frequencies cycle faster than lower frequencies (that being what makes them higher frequencies), it is common to see the phase relationship between the two input signals diverge by several cycles as you go up in frequency. On the standard “wrapped” phase display, phase shifts greater or less than one half cycle (+/– 180°) are “wrapped around” so a positive phase shift of, 1.25 cycles (+450°) that would have plotted at as +90°. This leads to the familiar “zig-zag” appearance of a standard phase trace.

If you want to get a picture of the overall trend of the phase trace over a wide frequency range you can press the [U] key to “unwrap” the phase display. On the unwrapped phase display, the same +450° phase shift mentioned above would be plotted as +450° and a 360° phase shift that would show up at 0° on the wrapped display is plotted at 360°. Note however that this type of phase display is by no means appropriate for all applications and may actually be misleading in some cases. Also note that the actual phase values that come out of the transfer function calculation are always within the range of +180° to –180°. The wrapped phase display extrapolates values outside this range by looking for wrap points and this works better in some cases than in others.

Deviation from Minimum Group Delay

The Show Phase as Group Delay feature, accessible from the Phase Display Properties fly-out in the Transfer Function menu, also works by extrapolating from the relationships between neighboring points in the phase data. In calculating deviation from minimum group delay, SmaartLive compares each point in the phase display to its neighbors and calculates a value in milliseconds for each point based on the frequency and slope of the angles between the neighboring points. The group delay plot is similar to the Magnitude and unwrapped phase display plots in that it plots delay values as positive and negative numbers relative to a zero point where a value of zero milliseconds for a given data point represents parity between the reference and measurement signals for that frequency.
Please note that both the Unwrapped and Show Phase as Group Delay options could be considered something of a work in progress. Refinement of these features is ongoing however they can be useful enough in some cases in their current form to merit their inclusion in the release version of SmaartLive. If you choose to use these options, just bear in mind that both require very stable input data to work very well and both rely on some assumptions that may not always be true, particularly when the input data is not extremely stable.

**Time Windowing**

Time Windowing is another way of removing questionable or otherwise unwanted data from transfer function measurements and helping to smooth and stabilize Transfer Function mode data traces. Typical uses for this feature include isolating the response of high frequency components and “windowing out” strong reflections that may be causing comb filtering at your measurement microphone position.

Time windowing uses a combination of time and frequency domain measurement techniques to accomplish its mission. The procedure is as follows:

- Frequency-domain transfer function data is transformed into its time-domain representation using an inverse Fourier transform (IFT). The result is a time-domain impulse response — this is the same procedure SmaartLive uses to obtain an impulse response in Impulse mode and Delay Auto-Locator measurements but in this case, everything is done in the background in real time.

- A special “flat top” data window function with a time constant twice the size of the specified time window size (for mathematical reasons) is applied to the impulse response, centered on the peak of the first arrival — actually on the beginning of the impulse response time record but this will normally correspond to the peak arrival time, assuming the delay time is set properly in transfer function mode. The data window function forces unwanted samples “outside” the window to zero.

- The edited impulse response data is then transformed back into the frequency domain by an FFT and the resulting frequency magnitude and phase data is plotted on the real-time Transfer Function.
The time windowed transfer function appears as a second trace in a different color (a light blue green by default) on the Transfer Function mode Magnitude and Phase displays. This trace may be brought to the top of the z-axis stack and saved as a Reference Trace.

Note that because the time dimension of the data window function used by the time windowing routine is actually double the size of the specified window time, the maximum allowable window is equal to one half of the time constant of the FFT size/sampling rate selected in Transfer Function mode. Also note that the FPPO transfer function, which uses multiple FFT sizes with multiple time constant, is incompatible with this feature and the Time Window control is disabled when the FPPO option is selected.

The size of the time window is specified in milliseconds. This value may be set numerically, using the up/down buttons on the Time Window spinner that appears to the right of the plot area in Transfer Function and Impulse mode, or typing a number in the pop-up dialog box that appears when you click on the spinner’s readout field.

In Impulse mode, turning on the Time Window button displays a flag cursor that shows you the ending boundary of the window time currently specified, relative to the position of the standard Locked Cursor. You can then set the size of the time window interactively by dragging the flag cursor across the plot with your mouse. This is particularly handy when using time windowing to reduce or eliminate the effects of reflections on transfer function data because strong reflections are typically very easy to see on the impulse response trace.

The obvious trade-off associated with time-windowing is that the effective time constant of the windowed transfer function is reduced (relative to the un-windowed version) and with it, the effective low-frequency resolution of the windowed data. SmaartLive automatically calculates the effective frequency resolution (EFR) of the windowed transfer function trace and displays this value in the FFT Parameters dialog box when time windowing is turned on.
Averaging and Smoothing

Averaging Data Types: Vector vs. RMS

SmaartLive offers several averaging options in Transfer Function mode to help make the display more stable and easier to read and interpret. At the top level, there are two primary averaging options Root Mean Square (RMS) and Vector averaging. The terms Vector and RMS actually refer to the type of data that goes into the averaging routine. There are also three different ways of averaging this data, irrespective of the type.

RMS averaging is also used in Spectrum Mode and Impulse mode to improve the signal-to-noise ratio of measurements and help stabilize the RTA and Spectrograph displays. Vector averaging is available only in Transfer Function mode. The type of data (Vector or RMS) used for averaging in transfer function measurements is selectable from the Averaging fly-out in the Transfer Function menu or by clicking the text label on the averages (Avg) spinner to the right of the plot. The notation “(V)” or “(R)” appears on the averages spinner in Transfer Function mode to indicate which type of averaging is currently in use.

Of the two, RMS is the most forgiving of things like in wind or movement that can result in slight variances in arrival times between successive FFT frames. RMS averaging also allows more late arriving reverberant energy into the transfer function measurement so it tends to relate well to human perception of overall system tonality and how “musical” a system sounds. Vector averaging is more effective than RMS in rejecting uncorrelated noise and reverberant energy and tends to relate somewhat better to subjective perception of intelligibility and “accuracy” of signal reproduction. It is, however, much more sensitive to wind and speaker/source movement or other time-variance in the measurement signal path than RMS averaging, so it is generally better suited to measuring indoors and/or in calmer, more controlled conditions.

Averaging Schemes

The three basic averaging schemes used in SmaartLive are linear “first in, first out” (FIFO), Infinite, and exponential (Fast, Slow and variable). Note that these are the same for Transfer Function and Spectrum modes. FIFO averaging is a simple “arithmetic”
average of some number (2, 4, 8, 16...) of the most recent FFT frames with equal “weight” given to each. The settings for FIFO averaging are in multiples of two because every doubling of the number of frames going into the average increases the signal-to-noise ratio of the measurement by 3 dB. If the Avg spinner is set to 1, no averaging is performed and only the data from the most recent FFT frame is plotted.

Infinite (Inf) averaging also gives equal weight to each FFT measurement included in the average but rather than including only a fixed number FFT frames, infinite (Inf) averaging keeps a running of average of all the FFT data that comes in until the averaging buffers are flushed (re-seeded). You can force the averaging buffers to reseed at any time by pressing the [V] key on your keyboard. Averaging buffers are also flushed automatically whenever you change averaging parameters, FFT size or sampling rate, stop the analyzer or switch between main display modes.

Unlike FIFO and infinite averaging, exponential averaging gives more relative weight to the most recent data going into the average while the weight of the oldest data “decays” exponentially. The options labeled Fast and Slow are exponential averaging routines with a fixed half-life modeled on the characteristics of time integration circuits in standard sound level meters. The Exp option is similar to these two but has a user-definable “half-life.” The half-life for the Exp option is specified on the Inputs tab of the main Options dialog box.

Each doubling of the number of averages will increase the signal-to-noise ratio of the measurement by 3 dB (until the absolute noise floor of the system under test or the measurement system, whichever is higher, is reached). Note however that increasing the number of averages also causes real-time displays to respond more slowly to changes, which can be more desirable in some circumstances than others.

As a general rule, the more difficult the measurement conditions, the more averaging and smoothing is required. So called “electrical” measurements, such as comparing the input and output of an EQ or system processor, typically require very little averaging and keeping the number of averages low allows the display to respond quickly to filter changes. In acoustic measurements (i.e., measurements made using a microphone) typically require at least 16 - 32 FIFO averages or increasing the half-life for exponential averaging. When making acoustic measurements in very noisy and/or reverberant spaces or outdoors in the wind, you may want to increase the number for FIFO averaging to 64 or 128 or use the Infinite averaging option instead.
**Smoothing**

Smoothing is another type of averaging that is available only in Transfer Function mode. This feature helps to reduce “jagginess” on the transfer function trace and can make trends in the device or system response easier to see. On a smoothed transfer function trace, each data point is averaged together with some number of adjacent points on either side of it (determined by the Smooth spinner to the right of the plot). For example, if the Smooth spinner is set to 3, any given data point will represent the value of that point averaged with the next higher and next lower points on the trace. When smoothing is set to 5, each point is averaged with the next two higher and lower points and so on. In other words, you are averaging across frequencies, effectively increasing the bandwidth of each frequency data point rather than over time as in the case of RMS and Vector averaging.

**Coherence and Coherence Blanking**

**Coherence Overview**

Coherence is a measure of the linearity between two signals in a transfer function measurement. The Coherence function in SmaartLive basically asks “What are the chances that the signal that went into the system became the signal that came out as a result of any linear process?” Coherence is expressed as a value between 0 and 1 for each frequency data point where 1 represents perfect coherence and 0 equals no coherence. All coherence values in SmaartLive are given as a percentage where 100% = 1 (perfect coherence).

Values closer to 1 mean better linearity and therefore better data. It is important to note however, that low coherence values do not necessarily mean your data is untrustworthy. This is particularly true when making acoustic measurements in noisy environments where a lot of averaging is required. Coherence naturally decreases when the number of averages goes up and many of the same factors that would tend to make you want to use more averaging in the first place, such as ambient noise, also affect coherence themselves.
In real-world measurement situations, “good” coherence can be a relative term and it is often more useful to look for overall trends in the coherence of a measurement than for specific coherence values. When specific frequencies have much lower coherence values relative to the majority of other frequencies, these are typically the frequencies where you should trust the measurement data the least.

Examples of factors other than averaging that can adversely affect the coherence of transfer function data include delay between the two signals, insufficient energy in the reference signal at a given frequency to make a measurement, acoustical influences such as reflections, modes and reverberation, and ambient or electrical noise. Nonlinear processors such as compressors and limiters in the measurement signal path can also have a negative influence on coherence and should be bypassed for transfer function and impulse response measurements if possible.

### The Live Coherence Trace

SmaartLive offers two different ways of looking at the coherence of Transfer Function measurements, a live Coherence trace and Coherence Blanking (see below). The live Coherence trace is activated by the Coh button that appears to the right of the main plot in Transfer Function mode. When activated, a second trace will appear (in red by default) in the upper portion of the Transfer Function mode frequency/magnitude response plot that plots the coherence value for each frequency data point.

The live Coherence trace is normally plotted in the upper half of the Transfer Function Magnitude display using the center line of the plot as its zero line and the top of the graph as its maximum value of 100% (perfect coherence). As you move the mouse tracking cursor across the plot area, you can read the coherence value for individual data points in the cursor readout above the plot. The coherence value is shown in the cursor readout with its text color matching the coherence trace color on the Magnitude plot (red is used by default). If you find the full size coherence trace distracting, you can reduce its vertical axis to just the top 1/4 of the Magnitude display by selecting Quarter Height Coherence on the Graph tab of the Options dialog box.
Coherence Blanking

The second coherence-related display option in SmaartLive is actually a way of *not* looking at data whose coherence is too low. To activate the Coherence Blanking feature, simply set the coherence threshold spinner that appears to the right of the plot in transfer function mode to any non-zero. When active, SmaartLive will remove any frequency data point from the Transfer Function magnitude and phase traces whose coherence value falls below the specified threshold. The live coherence trace, if present, is not affected. Coherence Blanking is similar in concept to Magnitude Thresholding (see below) but works on coherence value rather than signal strength.

Magnitude Thresholding

Another way of keeping bad data out of transfer function measurements in SmaartLive is to use Magnitude Thresholding. This feature works by allowing you to set a threshold for the *reference* signal level, below which SmaartLive will reject incoming data in the *measurement* signal on a frequency-by-frequency basis. When Magnitude Thresholding is on SmaartLive looks at every frequency data point in the reference signal and if it falls below the threshold, the corresponding point in the transfer function trace will not be plotted when the transfer function display updates.

There are two real benefits to this feature, particularly when using SmaartLive during a performance or in any other noisy environment. One is that it helps keep data off the screen that could not have originated from the system being measured (the assumption being that if you didn’t put anything into the system at a given frequency, you shouldn’t be getting anything out at that frequency). The other is that since the last valid data point measured remains on the screen until replaced by new valid data, this feature
prevents the transfer function trace from “blowing up” when a song ends or the stimulus signal stops. This does also mean that it may take the transfer function trace a while to “build” when you begin measuring. If you don’t see the trace starting to build after a few seconds, you may need to drop the threshold point a little.

Magnitude Thresholding is available only in Transfer Function mode however the threshold spinner also appears in Spectrum Mode because in many cases, it is easier to identify where the signal meets the noise on the RTA display. The threshold is set as a percentage of full scale and a horizontal line will appear on the RTA plot to indicate the current threshold level when active.
Delay and Impulse Response Measurements

Impulse Mode Overview

In Impulse mode, SmaartLive measures and displays the impulse response of the system under test. The result of the impulse response measurement can be stored as a standard Windows wave file for analysis in Smaart Acoustic Tools but in SmaartLive, the impulse response is mainly used to find the time offset (delay) between the two input signals. The Impulse mode plot layout differs from the analyzer mode (RTA and Transfer Function) plots in that the plot displays energy versus \textit{time} (rather than energy vs. frequency).

How The Impulse Response Recorder Works

Like the real-time Transfer Function display, the SmaartLive impulse response calculations assume that the two sound card inputs are receiving the same signal, traveling over two different signal paths (see block diagram below). Audio data is recorded from the inputs then transformed into the frequency domain and processed using a transfer function. The result is then transformed back into the time domain by an Inverse FFT (IFT).

![Block Diagram of a Transfer Function or Impulse Response Measurement](image)

This technique requires the time constant of the measurement, sometimes called the “time window,” to be longer than the decay time of the system under test. In SmaartLive, the time constant of an impulse response measurement is equal to the FFT Time Constant yielded from the input parameters selected for a given measurement. The time constant of an FFT determined by the FFT size divided by the sampling rate. For example, a sampling rate of 48000 with an FFT size of 32768, yields an FFT
Time Constant of 683 milliseconds (0.683 seconds). This would provide a sufficient time window for most small to mid-sized rooms. Larger and/or very reverberant spaces with longer decay times require a longer time window.

You can increase the size of the FFT Time Constant (TC) by increasing the FFT size and/or decreasing the sampling rate. Keep in mind that decreasing the sampling also limits the frequency content of the resulting impulse response (this may actually be useful in some cases). If you are unsure about the decay time of the room/system under test, the rule of thumb is that it never hurts to set the time constant for the measurement too large. Although it will take a little longer to record and process the data and you end up with an unnecessarily long “noise tail” in the resulting impulse response, you also pick up 3 dB of signal to noise with every doubling of the time constant.

**Impulse Mode Measurement Parameters**

The input parameter controls for Impulse mode measurements are slightly different than those offered in Spectrum and Transfer Function modes. Generally speaking, one tends to do more tweaking of FFT Parameters for impulse response measurements than for real-time measurements, so in Impulse mode, there are separate controls for each parameter instead of one combined control. The first three FFT parameters in Impulse mode, Sampling Rate (SR), FFT Size, and Time Constant (TC) identical to the analogous options in the real-time measurement modes. The only difference is that there are additional FFT sizes (up to 512k) with longer time constants available in Impulse mode.

Note that FFT Frequency Resolution (FR) is not displayed in Impulse mode since the impulse response is a time-domain display. There is, however, the additional parameter of Overlap percentage and in Impulse mode, averaging is considered an input parameter, rather than a display parameter.
Chapter 2: SmaartLive Functions

Averages – This field sets the number of FFT frames for the impulse recorder to record. When a value greater than 1 is specified, the impulse recorder collects and processes the specified number of frames then averages all the frames together in the final measurement results. The principal reason for doing this is noise rejection — every doubling of the number of averages increases the signal-to-noise ratio for the measurement by 3 dB (down to the actual noise floor of the system under test or the measurement system, whichever is higher).

Overlap – Setting this value to a number greater than zero causes SmaartLive’s impulse recorder to use overlapping, rather than contiguous time-domain data to calculate multiple FFTs. This is particularly useful in measurements where you need to use a large FFT size and/or a high number of averages because it can drastically reduce the number of samples required and subsequently, the time required to collect the data.

Working with Impulse Response Data

To enter Impulse mode, click the Impulse button or press [I] on the keyboard. The Impulse recorder will start automatically and begin recording audio data from the sound card inputs. If you want to change input parameters or need to interrupt the measurement for some other reason, you can click the large Start/Stop button. Otherwise the impulse recording routine will collect the required number of samples from your sound card, process the data and plot the resulting impulse response trace in the main plot area.

The impulse response graph is a time-domain plot of amplitude/magnitude vs. time. The x-axis (time axis) of the impulse response trace will be equal to the time constant (TC) of the FFT size/sampling rate used in making the measurement. The y-axis of the plot will scale amplitude values as a (+/−) percentage of digital “full-scale” when Linear (Lin) amplitude scaling is selected or logarithmically, in decibels, when Log scaling or ETC view is selected.
Linear and Log amplitude scaling are simply two ways of looking at the raw, time-domain impulse response data. Of the two, Logarithmic scaling is typically the most useful in this context and is the default magnitude view option for the main impulse response plot. At first glance, the ETC option looks very much like a logarithmic view of the time-domain impulse response but it is actually calculated using both time and frequency-domain data and there are a couple of important differences.

The Energy Time Curve (ETC) view shows only the magnitude portion of the impulse response measurement on a logarithmic amplitude scale — phase/polarity information is discarded. In many cases, the arrival of energy from a single source or reflection appears as multiple peaks in a standard (Linear or Log) impulse response view. This is because energy with a phase angle of 90 or 270 degrees appears as having an amplitude of zero on a (two-dimensional) time-domain oscillogram, effectively “splitting” one peak into several. ETC view is very useful in differentiating between single and separate arrivals, and is particularly helpful in locating arrival times for the low frequency components of a system.

A smaller linear view of the time-domain impulse response data that appears above the main plot in Impulse mode is used for zooming and navigating along the time axis in the main display. If you click and drag in this smaller “thumbnail” display, a rectangular box is drawn and when you release the mouse button, the main plot will zoom in on the time range selected.

You can also zoom and navigate on the time scale of the main plot using the arrow keys on your keyboard. The up and down arrow keys increase or decrease time scale magnification and the left and right arrow keys move the displayed range horizontally. In either case a pair of vertical lines will appear in the smaller thumbnail display to indicate the time range currently shown on the main display.

Similarly, the amplitude/magnitude (y-axis) of the main impulse response can be changed using the primary Amplitude Range commands (the +/- and PageUp/PageDn
keys). Clicking in the left margin of the plot with your left mouse button will reset range the of both the $x$ and $y$ axes of the plot back to the full time and amplitude/magnitude range of the recorded waveform.

The first “spike” or large peak on the impulse response trace will normally also be the highest in magnitude and will correspond to the initial arrival time of energy in the impulse response measurement, giving you the total propagation delay time (electronic and acoustic) through the system under test. SmaartLive’s Locked Cursor automatically set to the highest peak when a measurement is completed with its location indicated in the cursor readout above the plot. When the Locked Cursor is present, pressing [Ctrl] + [Space Bar] or holding down the [Shift] key and clicking on the plot with the left mouse button opens the Delay tab of the Options dialog box. The Locked Cursor location is entered in this dialog automatically as the Delay Time for the Internal Signal Delay. If the Locked Cursor is not present, [Shift] + click on the plot opens the Delay tab with the *mouse* cursor location entered as the Delay Time.

![Data points](image.png)

Note that when the Locked Cursor is present and the mouse cursor is positioned over the plot, the Cursor Readout gives you the time and amplitude coordinates for both cursors and automatically calculates the relative difference between them. This feature provides a convenient method of finding time and amplitude differences between the Locked Cursor position and any other point on the impulse response plot.

Another way of finding the relative difference between two points on a Log/ETC plot is to click and drag the mouse cursor over the plot, drawing a “rubber band.” When you then release the mouse button, the relative time and magnitude difference between the end points of the line, along with the slope (in dB/second) and the equivalent decay time ($T$) for 60 dB of decay (also called $T_{60}$ or $RT_{60}$) are displayed in the upper right corner of the plot. Clicking once on the plot clears the line and other information.

Impulse response measurements recorded in SmaartLive are stored in a standard Windows waveform (*.wav) file. The impulse recorder always uses the same file name for its output file and overwrites this file each time you make a new measurement. If you want to preserve the results of an impulse response measurement for analysis in SIA-Smaart Acoustic Tools (or any other purpose), click the *Save As* button to the right of the plot to write the data to a new wave file.
Automatic Delay Locator

SmaartLive automatic delay locator finds the time offset (delay) between two input signals by measuring the impulse response of the device or system under test. This measurement can be performed interactively in Impulse mode or automatically in Spectrum or Transfer Function modes. The measurement setup for delay measurements is identical to the setup used for Transfer Function measurements, requiring both a reference (source) signal and a measurement (return) signal.

![Auto Sm | Auto Lg](image)

The Delay Auto-Locator is activated by clicking the **Auto Sm** (Delay Auto-Locate Small) or **Auto Lg** (Delay Auto-Locate Large) buttons below the delay readout in the lower right of the SmaartLive program window. The small and large options refer to the *time window* used in the measurement routine. The reason there are two different options is that the dual-FFT impulse response measurement technique SmaartLive uses to find delay times is very sensitive to the *decay time* of the system being measured. It is essential that the time window used in the measurement be *large* relative to the decay time of the room/system under test.

Default settings for the small and large Delay Auto-Locator options yield time windows of approximately 300 milliseconds and 3 full seconds respectively. The default small window is appropriate for measuring delays through electronic devices or acoustic (microphone) measurements in small to medium sized rooms. The default large window should be sufficient for acoustic measurements in medium to large sized rooms but may need to be increased for measurements in very large and/or reverberant spaces. The size of the small and large time windows is determined by the sampling rate and FFT sizes selected on the Impulse/Locator tab of the Options dialog box.

The automatic delay locator is mainly intended for use in finding and compensating for the time offset between the reference and measurement signals in Transfer Function measurements (although it can certainly be used for other purposes). After the Auto Small or Auto Large routines run, a dialog box pops up to allow you to set internal signal delay for the reference channel to the delay time found. This dialog box also shows you the absolute polarity of the impulse response. The polarity of the impulse response can be useful for determining the polarity of a single driver but may be misleading when measuring multi-driver boxes.
Chapter 2: SmaartLive Functions

SPL Measurements

Calibrating to SPL

It is important to remember that SIA SmaartLive operates entirely in the digital domain. Because SmaartLive uses standard Windows low-level audio calls to access data from the computer’s sound hardware, it “sees” only the digital output of the input device’s Analog-to-Digital (A/D) section. SmaartLive therefore does not know the A/D converter’s input voltage range or any other details about the gain structure of an input signal chain prior to this point.

By default, SmaartLive is internally calibrated to A/D full scale, regarding highest magnitude obtainable from your sound hardware’s Analog-to-Digital converter as 0 dB. In other words, given a sine wave with amplitude exactly equal to the maximum input voltage of your A/D converter, SmaartLive’s RTA display should display a 0 dB peak at the sine wave frequency.

Note that when using the default “Full Scale” internal display calibration all magnitude values in Spectrum Mode are given as “dB down” from the maximum input level of 0 dB, the Signal Level/SPL Readout above the input level meters always shows a negative value and the notation Full Scale appears in the field immediately below the larger numeric readout. When SmaartLive is calibrated to SPL, this notation changes to “SPL,” some additional information appears on a second line below, and the decibel levels shown will normally be positive.

To obtain accurate Sound Pressure Level (SPL) readings in SmaartLive, the RTA display must be recalibrated to an external reference. Also keep in mind that the signal level readout tracks the active input and should normally be targeted to an input channel carrying a signal from a microphone when measuring SPL.
Preferred SPL Calibration method

The most accurate way to calibrate SmaartLive to SPL requires the use of an acoustic or piston-phone sound level calibrator. The calibrator must be fitted to the capsule of your measurement microphone with an airtight seal. If your calibrator doesn’t come with an adaptor that fits your microphone snugly, check with the calibrator and/or microphone manufacturer. The calibrator manufacturer may offer additional adapter sizes that are not included with the base unit or you may be able to purchase an adapter collar from the microphone manufacturer that will allow you to fit the microphone to a standard calibrator cup size.

The SmaartLive analyzer must be running in Spectrum mode with the RTA display on to perform the recalibration procedure. The RTA display must be set to a fractional octave frequency resolution. Set the gain of the microphone preamp and sound card input controls to a useful level then insert your microphone into the calibrator and turn it on. When you see the peak on the RTA display stabilize at the calibrator frequency, double-click anywhere on the RTA plot with your mouse or click on the signal level readout to open the Signal Level/SPL Readout Options dialog box and click the Calibrate to SPL button.

SmaartLive will automatically find the magnitude of the highest peak on the RTA plot and the Amplitude Calibration dialog box will pop up showing the current magnitude value of the peak frequency. The Set this value to field in the dialog box should already be highlighted so all you have to do is type in the correct value for the calibrator’s output level, typically 94, 104, or 114 dB (consult the documentation for the calibrator if you are unsure). Click the OK button to apply the change and exit the dialog when you are done. When the dialog box closes the all Spectrum mode displays plot will automatically re-scale themselves based on the new calibration offset and the Signal Level/SPL Readout will begin displaying SPL. That’s it. SmaartLive should now provide you very accurate SPL metering in Spectrum and Transfer Function modes (Impulse mode always uses Full Scale calibration).

Note that if you change the gain of the microphone preamp or mixer channel or change the voltage swing of the A/D converter, you will need to repeat the procedure above to recalibrate. Also note that since SmaartLive uses an “engineering units” calibration scheme for SPL calibration, this same procedure can be used to calibrate the program to virtually any signal of known amplitude.
“Quick and Dirty” SPL Calibration

If you don’t have a microphone calibrator but do have a standard Sound Level Meter (SLM), you can roughly calibrate SmaartLive to provide SPL readings that are accurate enough to be useful using the SLM as a reference. The procedure for “quick and dirty” SPL calibration looks a little complicated at first glance but it’s really very simple and takes only about a minute in actual practice.

1. With SmaartLive in Spectrum Mode, remove all reference traces from the RTA display and turn the analyzer off. The plot area should be completely blank.

2. Double-click near the center of the plot area and when the Amplitude Calibration dialog box comes up, select Set this value to and type in some (positive) number of decibels such as 50. Click the OK button to close the dialog box.

3. Click the Signal Level/SPL Readout in SmaartLive and set the SPL weighting and integration time options to match the SLM. If your SLM can display a Flat (unweighted) SPL reading, this is probably best choice. Otherwise set both SmaartLive and the meter to display a Slow A- or C-weighted curve.

4. Place your measurement microphone and SLM very close together at the same distance from a loudspeaker then output a signal, preferably a “steady state” signal such as a sine wave or pink noise, through the loudspeaker.

5. Run SmaartLive and the SLM and note the SPL readings on both.

6. Subtract the smaller of the two readings from the larger to find the difference.

7. Turn off the SmaartLive analyzer and double-click on the RTA display again. If the SLM reading was higher than the SmaartLive SPL reading in step 5, add the difference found in step 6 to the number shown in the Current value is field of the Amplitude Calibration dialog box and enter the result in the Set this value to field. If the SLM gave you a lower number subtract the difference. Click the OK button to apply the change and exit the dialog box.

8. Run the SmaartLive analyzer again and compare the SLM and SmaartLive SPL readings again. They should now be tracking pretty close to each other closely. If SmaartLive is off by more than a couple of dB from the meter, just repeat steps 6 and 7 until you are satisfied with the results.
The Signal Level / SPL Readout

The decibel (dB) readout that appears in the upper right corner of the SmaartLive program window above the Input Level Meters displays a numeric amplitude value for one of the two input signal in real-time. In Spectrum and Transfer Function mode, when SmaartLive is properly calibrated to SPL, this readout emulates an ANSI/IEC standard Sound Level Meters (SLM). Please note that SPL measurements are valid only if SmaartLive is calibrated to SPL. Also, note that because this readout monitors only one input at a time, it should obviously be pointed to an input channel carrying a signal from a microphone when measuring SPL.

The signal level readout tracks the active input channel. Note that you can select either input as active by simply clicking it’s meter bar on the in any display mode. The current active input is indicated by an Active label immediately below its meter. The text color of the signal level readout is also set to match the color of the input level meter for the channel being measured. When SmaartLive is calibrated to SPL, the readout can be set to display an A-weighted, C-weighted, or flat (unweighted) SPL value based on the current FFT frame (only) or an average of the data from some number of the most recent frames.

Notations in the field immediately below the signal level readout indicate the current settings. When SmaartLive is using it’s default Full-Scale calibration scheme (based on the full scale of the current input device’s A/D converter), the top line of this field displays the notation “Full Scale.” If SmaartLive is calibrated to SPL (or some other external reference) this notation will change to “SPL:” with two additional notations. The first is the SPL integration time (Fast, Slow or Inst). The second notation is the weighting curve currently selected. SmaartLive offers a choice of standard A and C weighting or Flat, unweighted SPL.

The Fast and Slow integration time options emulate the timing characteristics of time integration circuits in standard hardware sound level meters as closely as possible.
Because all SPL measurements in SmaartLive are based on FFT data, the Instantaneous (Inst) timing option is not identical to the Impulse setting found on some hardware SLMs but should give you close to the same answer in most cases, particularly if very small FFT sizes are used.

Clicking anywhere on the Signal Level/SPL readout with your mouse will open a dialog box that allows you to adjust properties for the signal level readout and/or recalibrate SmaartLive. Properties for the SPL readout can also be set from the Signal Level/SPL Readout Options dialog box. Note that some of the options pertaining to SPL are disabled when Full Scale calibration is in use. Also note that the Peak Hold option is unavailable when calibrated to SPL (or other external reference).

**Working with Stored Measurement Data**

**Storing and Comparing Traces**

On the Spectrum mode RTA display and in Transfer Function modes, it is possible to capture, store, and display “snapshots,” or static copies, of the (active) live trace. We call these captured traces reference traces. Reference traces are stored in SmaartLive’s Reference Registers, and may also be saved to files on disk. When you capture a Reference Trace on the RTA graph in Spectrum mode the trace corresponding to the active input is the one that gets sampled.

In Transfer Function mode, when both the standard and time windowed Transfer Function mode traces are displayed, the one in front is the one that sampled. This not an issue if only one live trace is visible but when both are visible you can bring the Time Windowed trace to the front by clicking the colored rectangle below the Time Window button. Clicking the input level meter bar for the active input or turning off the time windowed trace returns the focus of the capture function to the standard transfer function trace.

SmaartLive has two sets of 20 (a total of 40) Reference Registers — one set is for RTA reference traces and the other is for Transfer Function mode reference traces. Since reference RTA traces captured in Spectrum mode cannot be displayed in Transfer Function mode and Transfer Function reference traces will not display on the RTA graph, a single set of controls is used to control both sets of registers. Reference Registers are arranged into five banks of four, designated A, B, C, D and E.
Capturing a Reference Trace

One Reference Register in each bank is always selected. You can capture a live trace into the selected register in any bank by holding down the [Ctrl] key and pressing the letter key (A, B, C, D, or E) for the bank you wish to capture into. The faces of the buttons provide a legend for the trace colors of reference traces displayed on the plot.

Holding the [Shift] key while pressing the letter key selects the next register in the corresponding bank and [Shift] + [Ctrl] + ([A], [B], [C], [D], or [E]) selects and captures into the next register in the bank, cycling from left to right. You can also capture into a register by clicking its button with your mouse to activate it then clicking the capture (Capt) button or pressing the [Space Bar] key on your keyboard.

A new reference trace is displayed immediately upon capture. It will also become the top trace (in the z-axis plot’s “stacking” order) automatically and its register will become the active reference register if it wasn’t already. The top trace is the trace the tracking cursor tracks when Track Nearest Data Point is turned on and is the focus of all Locked Cursor operations. Also note that the text color value in the dB +/- spinner to the right of the plot area changes to match the color of the top trace. The (up/down) spinner buttons to the right of the spinner’s text field allow you to adjust the vertical position of the top trace on the plot.

On the RTA display in Spectrum mode, you can return the focus of the plot display to one of the live traces by clicking either of the input level meters or by using the Active Trace commands in the Control menu. In Transfer Function mode, clicking either of the input level meters will return the focus of the display to the live transfer function trace. To bring any stored reference trace to the front, simply click on its register button with your mouse. This works even if the register button is already depressed and will make the selected register the active reference register as well.

The register number (e.g., A1) of the active reference register is shown in the left-most field on the reference information bar below the main plot area. You can attach a descriptive comment to a trace stored in the active register by clicking on the comment field and typing in text in the dialog box that pops up. The text entry field in this dialog box also stores previously used reference comments in a drop-down list. To use any listed comment for the current reference trace, just select it from the list.
Chapter 2: SmaartLive Functions

Note that the active reference register is the target of the reference Capture command
and so clicking the Capture button or pressing the [Space Bar] key will overwrite any
data already stored in the register without warning. By default, overwriting a register
will also clear the comment attached to the previous reference trace (if applicable). If
you un-check the check box labeled “Clear Ref Comment After Capture” on the Graph
tab of the options dialog box the Reference Trace Comment dialog box will appear each
time you capture a trace and if the previous contents of the selected register had a
comment attached, that comment will be preserved (unless you type a new comment
or delete the existing comment text).

To the left of the active register and reference comment fields below the plot are
five buttons labeled Capt (capture), Del (delete), Hide, Flip and Info. The Capt button
captures a new reference trace in the active reference register as described above.
Clicking the Del button or pressing [Ctrl] + [Delete] on the keyboard clears the active
register. The Hide button temporarily removes all displayed reference traces from
the plot. Reference register selections are unaffected. Clicking the Hide button again
restores all previously displayed reference traces. The Info button calls the Reference
Trace Information dialog box allowing you to save and load reference (*.ref) files and
reference group (*.rgp) files. The Flip button turns the reference trace upside down.

Displaying Reference Traces

The A, B, C, D, and E buttons are used to toggle display of reference traces stored in the
selected register in their corresponding banks on and off. One stored Reference Trace
from each of the five banks can be displayed on the plot at the same time along with
the live trace(s).

Averaging Reference Traces

The Reference Registers in bank E can operate as 4 normal registers, capturing traces
directly from the (active) live trace, or as “averaging” registers. When the “avg” button
next the E register bank is depressed, capturing into an E register does not sample from
the live trace. Instead, all displayed reference traces from banks A, B, C, and D are
averaged together and the results stored and plotted as a single trace.
Saving and Retrieving Reference Files

To save the active Reference Trace to a (*.ref) file on disk, press [Ctrl] + [S] on the keyboard or select Save Active Reference Trace from the Control > Reference menu. You can also save stored reference traces to files and retrieve trace data stored in reference files for display using the Reference Trace Information dialog box. This dialog box can be accessed by clicking the Info button below the plot or by selecting Show Reference Information from the Control > Reference menu. The Reference Trace Information dialog box has six “tabs” (tabbed “pages”); a General tab and one tab for each of the reference register banks (A, B, C, D and E).

The General Tab

On the General tab of the Reference Trace Information dialog box you can edit comments and adjust the vertical positioning for each stored Reference Trace. The Load All and Save All buttons on the General tab allow you to save and reload the contents of all 40 (RTA and Transfer Function) Reference Registers as a single reference group (*.rgp) file, in a single operation.

[Save All]

The Save All command stores the current contents of all Reference Registers in a single Reference Group (*.rgp) file. Clicking the Save All button opens a Save As file dialog box to allow you to specify a file name and enter comment for the group file if you like. The comment will be visible (in the Open file dialog box) during subsequent Load All operations.

[Load All]

Load All calls an Open file dialog box to allow you to select a previously-saved Reference Group file to be loaded.

Important Note: The Load All operation replaces the contents of all 40 Reference Registers so any existing, unsaved reference traces will be lost. SmaartLive will ask you for confirmation before loading to help prevent accidental overwrite of existing data.
Tabs A, B, C, D, and E

Dialog tabs for the individual register bank tabs allow you to review input parameters for all stored traces, save reference traces to files on disk, and retrieve previously-stored reference (*.ref) files for display.

To permanently store any Reference Trace to a (*.ref) file on disk, select the tab for the appropriate register bank, select register containing the trace you wish to save by clicking one of the four register buttons, then press the Save button. A Windows Save file dialog box will appear with the register name (e.g., a1.ref) suggested as the name for the new file. Any Windows-legal file name may be used as long as it ends with the “.ref” extension (the program will add the extension itself if you don’t).

To retrieve a previously-stored Reference (*.ref) File into a Reference Register for display, select the tab for the appropriate reference bank in the Reference Trace Information dialog box, then click register button for the register you wish to use and click the Load button. This calls an Open file dialog box.

Using the Open dialog box controls, navigate to the folder containing the file you wish to load then click on the name of a reference (*.ref) file to select it. Notice that the standard Windows Open file dialog box has been modified to show you the Comment, Sampling Rate, FFT size and (SIA-Smaart Reference File Specification) version number of the selected file.

When you have made your selection, click the Open button to load the file. This brings you back to the Reference Trace Information dialog box. You can then repeat the same procedure to load additional Reference Files or click the OK button to exit the dialog box. To display the trace you loaded, click its reference register button in the reference area below the plot.

Note: Always keep in mind that there are two separate sets of reference registers for RTA and Transfer Function reference traces and all reference register commands pertain only to the reference registers for the current operating mode. This means SmaartLive can only load files containing RTA traces in Spectrum mode or Transfer Function traces in Transfer Function mode.
Chapter 2: SmaartLive Functions

External Device Control

External Device Control Interface

SmaartLive’s External Device control interface allows direct control of supported, remotely controllable equalizers (EQs), system processors and other devices. Using this feature, it is possible to adjust EQ filters and other settings on the remote device from within SmaartLive while displaying the unit’s frequency response in real time on the Transfer Function plot(s).

Some external devices can be controlled using the computer’s serial port or possibly the parallel port, others may require MIDI communication capability. To communicate with a remote device via MIDI, your computer must have a Windows-compatible MIDI I/O hardware interface — typically a joystick-to-MIDI adapter cable or an add-on MIDI I/O box that connects to a serial or parallel port.

Support for specific devices is added through “plug-in” files so the list of supported devices is subject to change. Note that Smaart may not support every feature available for a device through front panel controls and/or proprietary OEM control software and that the number and types of features supported may vary from one device to the next.

Pressing [X] on your keyboard or selecting External Device Mode from the External Device menu will pop up a floating control panel for the external device that is currently selected. If no devices are yet configured internally, SmaartLive will ask you if you would like to add a new device definition.

When multiple devices are configured in SmaartLive, you can select the device you want to control from the External Devices menu or the pop-up menu that appears when you click the right mouse button. Clicking on the Ext. Device label above the device field with the left mouse button will pop up a mouse menu of device controls only. You can also assign devices to a button bar that appears above the plot when you click the Bar button next to the Ext. Device label for one click access.

The floating external device control panel allows you to set filters, store and recall programs, and control output gain and other parameters on the remote device. Specific controls available for the selected device will vary somewhat according to the model and type of device selected.
When you turn on external device control in Transfer Function mode a set of markers will appear on the Magnitude plot indicating the frequency and cut/boost positions (if applicable) of any EQ, High pass and Low pass filters currently assigned on the selected device/channel. High pass and low pass filters are represented by special markers that indicate the roll-off direction of the corresponding filter. All other types of filters are shown as square boxes with cross-hairs appended.

In addition to the filter markers, the estimated composite curve for all assigned filters is automatically calculated and plotted. Note that in most cases, the composite EQ curve is calculated using generic “textbook” filter descriptions but this will typically be close enough to the actual response of the device to be useful. If you need to see exactly what the actual frequency response of the device is, you can measure it.

Filters settings on the remote device can be adjusted by clicking and dragging their markers on the Transfer Function Magnitude plot with your mouse. When you select a filter marker by clicking it with your mouse, the filter’s parameters are displayed in the upper portion of the floating external device control panel. The information shown will vary depending on the type of filter selected. For example, the center frequency and bandwidth of individual filters are fixed on a graphic EQ but are user-definable on a parametric.

You can cycle filter selection through all displayed filter markers using the [Tab] key ([Shift] + [Tab] cycles in the reverse direction). When a filter is selected, its center frequency (Hz), bandwidth (Oct), and cut/boost value (dB) are shown in the top three edit fields on the external device control panel.

Filters set at 0 dB cut/boost are considered “unused.” Note that on some digital devices, unused filters are considered unassigned and flattening a filter may cause its marker to disappear completely. A shortcut for setting up filters is to hold down the shift key while clicking a point on the plot. This action will automatically select the nearest unused filter and move it to the point where you clicked or assign a new filter at the point where you clicked, depending on the device.
To adjust the cut/boost value and center frequency (parametrics only) of the selected filter, use the arrow keys on the keyboard or drag the marker from one point to another on the plot using your mouse. On a parametric EQ, you can also adjust the bandwidth of a filter by holding down the [Shift] key while pressing the right or left arrow key.

Filter parameters can also be set using the spinner buttons to the right of the parameter edit fields on the floating control panel. Some parameter fields are directly editable, meaning you can simply click in the field with your mouse then enter values directly from the keyboard. Note that most remotely controllable devices set filter parameters in preset increments SmaartLive may need to adjust values you enter directly to the nearest allowable value.

*Note:* More information about a number of specific external devices SmaartLive supports is available in PDF format on the driver downloads page of the SIA web site (www.siasoft.com).
Configuring External Devices

The External Devices command in the Options menu calls the External Device Information dialog box. This dialog box allows you to add or edit “device definitions” for supported remotely controllable equalizers, system processors and other devices.

Before you can control any supported external device from within SmaartLive, you must configure a device definition for the device. Device definitions are created and managed through the External Device Information dialog box. To access this dialog box, select Devices > Configure in the External Devices menu or the right-click pop-up mouse menu or click the (Ext. Device) label above the selected device field (shown above) and selecting Configure from the context-sensitive pop-up menu.

To add a new device definition, click the Add button in the External Device Information dialog box (shown below). You will first be prompted to select the type of device you want to add from the current list of supported devices (based on the “plug-in” files present in the Devices folder of your SmaartLive program folder). After selecting the device type, a device configuration dialog box will appear. Here you can enter a device name (or accept the pre-assigned default name) and select the I/O port (COM or LPT) or MIDI channel number you will be using to communicate with this device and the device ID (if applicable).

Multi-channel devices will present some additional options. When configuring a multi-channel device, a primary device name is assigned to the actual physical device. This is the name that will appear on the left side of the External Device Information dialog box. You will also need to assign names to individual device channels and/or operating modes (device-dependent) and select which of these names will appear in the lists of
available Devices in pop-up mouse menus, the Devices section of the External Devices menu and in the System Presets dialog box.

Once a device is configured, the device name (or Primary name for multi-channel devices) will appear on the left in the External Device Information dialog box along with the device type and I/O port assignment (Configuration). A green marker appears to the left of the device currently being controlled. When you select the name of a physical device in the list on the left, a list of all device names associated with it along with the number(s) of any System Preset(s) using it will appear on the right.

You can assign any mono device or any available input or output channel of a multi-channel device to a button on the Device Bar by selecting the device in the list and clicking the Assign to Device Bar button. The Device Bar appears above the plot when you click the Bar button above the selected device field to the right of the plot or select Device Bar from the View menu.

Configuring SmaartLive

Configuring the Screen

Pressing [Alt] + [G] on the keyboard, selecting Graph from the Options menu or clicking in the title field above the plot opens the Graph tab in the Options dialog box. On the Graph options tab you can specify display options and start-up parameters for the plot including title text, y-axis (magnitude) range for RTA or Transfer Function plot (depending on which mode you are in), and increments for the Zoom, Move, and Y +/- commands.

SmaartLive also allows you to customize the colors of virtually everything on the screen and even use your own bitmap files as a background. Color and background options are loaded as sets called Color Schemes. Several ready-to-use color schemes are included with the program and you can easily define your own. Color Scheme controls are accessed through the Colors tab of the Options dialog box.

Selecting the Quick Zoom command in the View menu or pressing [Ctrl] + [Q] maximizes the data display area by removing all on-screen controls (except the reference register controls) from the display with one mouse click. This feature is useful when running SmaartLive on a computer with a small display and/or when the input parameters have been set up and you want a larger plot area.
Saving and Restoring Program Configurations

The configuration of SmaartLive, including the state of nearly all user-definable program settings, is stored in the program’s registry in the Windows registration database. The settings in the current configuration are saved when you exit the program normally and may be saved at any time during a session by selecting Configuration > Save from the File menu.

The Configuration > Save As command in the File menu allows you to store multiple configurations for different purposes or different users. The Configuration > Load command loads a previously-stored configuration.

The Configuration > Export command extracts a copy of all SmaartLive’s stored configuration information from the Windows registry to a (*.reg) file on disk. This is useful for moving your preferences to a new machine or keeping a backup.

The Configuration > Import command loads the contents of a *.reg file into the Windows registration database, completely replacing the previous settings.

Restoring The Default Configuration

The display and scaling options for SmaartLive are extremely flexible and can sometimes be confusing, especially at first. Nearly all of these options are stored in the current Configuration which is updated each time you exit the program.

When you start SmaartLive it looks up the last Configuration used and loads these settings. Any time you wish to return the program to its “factory” default settings, select Set All Values to Default from the Configuration section of the File menu. This resets all parameters except Color Scheme and Device selections.

System Presets

Measuring and optimizing a sound system often involves a good deal of switching back and forth between various measurement points. The System Presets feature is intended to help “automate” this process by allowing you to quickly change whole groups of program parameters for different types of measurements. For example, you
can set up separate System Presets for different microphone positions, one for each system EQ, processor channel, etc., and switch between them with a single command.

SmaartLive can store up to 100 System Presets in each Configuration. Each System Preset stores a number of settings including selections for Sampling Rate, FFT size, Delay Time, Averages, operating mode and external device selection, and optionally, a MIDI program change to send when the Preset is called. System Presets can be stored and recalled using the (Presets) Store and Load buttons to the right of the plot area or by menu and keyboard commands. You can also recall System Presets remotely, via MIDI, by sending a MIDI program change corresponding to a preset number to the computer running SmaartLive (see Devices on page 142 for more information).

Clicking the Store (System Preset) button pops up a menu that allows you to store directly into any of the first nine preset registers. You can also store current settings into presets 1-9 by pressing [Ctrl] + [Shift] + ([1] - [9]) on your keyboard. Pressing [Ctrl] + [Shift] + [0] to selecting “any” from the Store button pop-up menu will open a dialog box that allows you to name and store into any System Preset slot (1-100).

Similarly, pressing [Ctrl] + ([1] - [9]) or clicking the Load (System Preset) button and selecting Preset (1-9) from the pop-up menu will immediately recall the settings stored in presets 1-9. Pressing [Ctrl] + [0] or selecting “any” from the Load button pop-up menu will open a dialog box that allows you to recall any System Preset (1-100) by name or number.

You can access the settings for all stored presets through the System Presets dialog box. This dialog box also allows you to change the preset labels (names) and browse and edit the stored settings. To access the Preset Options dialog box, click the Presets label above the Load and Store buttons to the right of the plot, select Presets from the Options menu or press [Alt] + [P] on the keyboard.

When you begin a SmaartLive session, no System Preset is selected. When you load a stored preset you will see it’s name on the title line above the plot. After loading a preset, changing any (current) program that was loaded by the preset — e.g., changing the number of averages using the Avg selector to the right of the plot — causes an asterisk appears next to the preset name on the title line. The asterisk indicates that the current settings no longer match the settings stored in the preset. Updating (overwriting) the preset with the current program settings will make the asterisk disappear.
Configuring Other Options and Properties

The *All* command in the Options menu opens the Options dialog box with the last tab used on top (any tab may be selected any time the Options dialog box is open). This dialog box gives you access to nearly all of SmaartLive’s user-configurable options and properties from one location.

The Options dialog box is organized into 10 separate “pages” for different types of settings. We also refer to these pages as “tabs” because each has an index tab at the top that is always visible in the top portion of the dialog box window. Selecting any command in the upper portion of the Options menu opens the Options dialog box with the selected page on top (Clock, External Devices, Signal Generator, SPL and System Presets have separate options dialogs and Volume Control is a Windows utility). To bring a different page to the front when the dialog box is open, simply click on its tab.

Jumping to Other Programs

SmaartLive can be configured to start and pass Wave (*.wav) or ASCII (*.txt) data files to other programs automatically using its jump function. The jump function is activated by clicking on the SmaartLive logo in the upper right corner of the main SmaartLive program window then selecting a pre-configured option from the pop-up menu. Options in this menu are determined by a text file stored in the System subdirectory of the main SmaartLive program folder.

To enable the jump function, you need to create a text file named rtjumps.txt in your SmaartLive System folder and create one or more jump sections in the file to define the jumps. The default location of this folder is:

c:\Program Files\SIA SmaartLive 5\System

The rtjumps.txt file can be created and edited using any ASCII text editor such as the Windows Notepad. SmaartLive reads rtjumps.txt on start-up so your jumps should be available the next time you start the program after creating or editing the file.
The following example of an rtjumps.txt jump definition would add the entry “Excel” to
the jump menu and when selected, will open Microsoft® Excel and load the last ASCII
text data file saved by SmaartLive into a worksheet:

[Excel]
PATH=c:\program Files\office\excel\excel.exe
ARGS=
EXIT=N
SMAART=N
WAVE=N
TEXT=Y

Each section must begin with a section name enclosed in brackets that also provides
the text label for its entry in SmaartLive’s pop-up jump menu. The PATH line must
provide the complete path and file name of the target program. The ARGS line can be
used to pass additional command line arguments to the target application if necessary.

The remaining lines are yes or no questions that should have either a “Y” or “N” after
the equals sign ( = ) as follows:

• If EXIT=Y, SmaartLive will shut down as it starts the target program.

• The SMAART line is mainly intended for use with Smaart Acoustic Tools 4.0 or
higher and should normally be set to “N” for other applications.

• If WAVE=Y, SmaartLive will pass the last impulse response wave file recorded in
Impulse mode to the target application. This line should be set to “N” if the TEXT line
is set to “Y.”

• If TEXT=Y, SmaartLive will pass the last text file save using SmaartLive’s ASCII Save
function to the target program. This line should always be set to “N” if WAVE=Y.
Measurement Setup

Typical “Real-World” Transfer Function Measurement Setup

The example below illustrates one possible measurement system setup for measuring and optimizing a simple sound system. The measurement setup for a more complex system might also include measurement points at the output of each crossover/processor channel, additional microphones, etc.

Note that the signal need not be generated by the computer. An external CD player, is used in this example. Whatever the source, the computer receives two signals:

- A reference signal, also being used to stimulate the system under test, on the Right input (channel 1)
- A measurement signal, the output of the system under test, on the Left input (channel 0)

The configuration shown below splits the reference signal inside the measurement mixer. The reference signal is sent to the computer on one of the measurement system mixer’s main outputs and out to the sound system on an auxiliary bus. This allows control of both the reference and measurement signal levels directly from the measurement system mixer.

![Measurement Setup Diagram]

- **Signal Source**
- **Equalizer Amplifier**
- **Loudspeaker**
- **Measurement Microphone**
- **Computer**

**Diagram Notes**:
- **A** (Source Signal)
- **B or C** (System EQ or Measurement Mic.)
- **Aux Output** (to Sound System Mixer)
This configuration splits the reference signal inside the measurement mixer. The reference signal is sent to the computer on one of the mixer’s main outputs and out to the sound system on an auxiliary bus. Using this arrangement, both the reference and measurement signal levels can be controlled directly from the measurement system mixer.

Another approach might be to bring the output of the sound system’s mixing console back to the measurement system mixer as a reference signal. This would also allow you to use the board mix as a reference signal for making measurements during a performance.

Note: It is often possible to utilize unused input channels and auxiliary busses on the house mixer itself as the measurement system’s input signal switcher — eliminating the need for a separate measurement mixer.

The Internal Signal Delay

SmaartLive can provide up to 750 milliseconds of signal delay internally (in 1/100-millisecond increments) for one of the two input signals. This feature is mainly used to provide signal alignment between the reference and measurement signals in transfer function measurements. Delay properties are set from the Delay tab of the Options dialog box, accessible from the Options menu or by clicking the label above the Delay readout in the lower right corner of the SmaartLive program window. Input channel assignment for the internal delay is normally handled by SmaartLive and can be changed only from the Delay tab of the Options dialog box.

The spinner buttons to the right of the Delay readout (shown above) or [F3] and [F4] keys on your keyboard can be used to decrease and increase the current Delay Time setting in 0.01 millisecond increments. You can also change the working delay time by typing a value in the Delay Time field on the Delay tab of the Options dialog box. The [F] key resets the internal Delay Time to 0 ms.
Chapter 2: SmaartLive Functions

The internal delay in SmaartLive is designed to work seamlessly with the Delay Auto-Locator and Impulse mode operations. Each time you run the Delay Auto-Locator, you have the option of assigning the delay time found to the internal delay upon completion. In Impulse mode, clicking the Set Delay To Peak button below the Delay readout, pressing [Ctrl] + [Space Bar] or holding down the [Shift] key while clicking on the plot with the left mouse button brings up the Delay tab of the Options dialog box with the Locked Cursor location entered as the current Delay Time value. If no Locked Cursor is present, [Shift] + mouse click on the impulse response plot calls Delay Options with the mouse cursor location entered as the Delay Time for the internal delay.

SmaartLive has five user-definable delay preset registers you can use to store and recall delay times for the internal delay. The delay preset registers are also accessible though the Delay tab of the Options dialog box. Each delay preset register is assigned to a Function key ([F6] - [F10]) on your keyboard. To recall a delay time stored in one of the delay presets as the current working delay time in RTA, Transfer Function, or Spectrograph mode, simply press the associated function key. Delay presets should not be confused with System Presets which can store a number of program parameters (including a delay time).

In Impulse mode, the delay presets have another function. Notice that on-screen buttons for the five delay preset registers appear below the plot when you switch to Impulse mode. Clicking on the readout field below the button for any delay preset with your mouse in produces a pop-up menu that lets you assign the current Locked Cursor location to that preset (and display its marker on the plot) or bring up Delay Options. Clicking the [F6] - [F10] buttons with your mouse or pressing the corresponding Function key on your keyboard in Impulse mode will plot a vertical line on the impulse response plot to mark the time position of the associated stored delay value.
When one or more of the Delay Preset buttons are selected in Impulse mode, clicking the Compare button to the right of the preset buttons pops up a dialog box that compares the preset times to each other and to the current Locked Cursor position and calculates the relative differences. This feature is mainly intended for use in aligning drivers in multi-driver boxes or in array alignment. Any entry in the list (normally the one with the longest absolute delay time) can be selected as “Time 0.” All relative delay times are then recalculated relative to this reference point.

**Internal Signal Generator**

If your computer sound hardware is capable of full-duplex operation (i.e., it can play and record simultaneously) you can use SmaartLive’s built-in signal generator to generate a stimulus (test) signals for measurements directly from the computer. Clicking anywhere on the Generator control (shown above) of the SmaartLive window with your mouse will open a dialog box that allows you to adjust properties for the signal generator. The internal signal generator can create several types of internally generated stimulus signals or loop a user-specified file indefinitely.

Options for internally generated signals include:

- Pink noise, pseudorandom noise with equal energy per octave
- Sine wave with variable frequency and amplitude
- Dual Sine wave with independently variable frequency and amplitude
- “Sync Pink” — synchronous noise with pink spectrum
- “Sync Red” — synchronous noise with “red” spectrum
- “Pink Sweep” — synchronous logarithmic sinusoidal sweep with pink spectrum
- “Red Sweep” — synchronous logarithmic sinusoidal sweep with “red” spectrum

Note that all internally generated stimulus in SmaartLive are monaural and send the same signal to both the left and right outputs of your audio output device, Even so, it is
still a good idea to use only one channel and to physically split the signal outside the computer to get the reference and measurement signal branches for transfer function and impulse response measurements. The main reason for this is that there is often a small but measurable time offset between the Left and Right output signals that could cause problems in phase and delay measurements. Also, when you split the signal inside the computer, you can never be absolutely sure the reference signal was exactly identical to the signal being sent through the device or system under test.

**Synchronous Stimulus Signals**

The synchronous noise and sweep options in the SmaartLive signal generator construct repeating sequences of pseudorandom noise or logarithmically swept sinusoidal signals that are precisely the same length, in samples, as the FFT size currently in use. These stimulus types are intended mainly for use with Transfer Function and Impulse response measurements but are also available in Spectrum mode. The use of synchronous stimulus enables you to make deterministic, FFT-based frequency/impulse response measurements with noise rejection characteristics similar to those of MLS and TDS measurement techniques — without the requirements of data windowing and/or relatively larger amounts of averaging associated with the use of random stimulus signals in FFT-based measurements.

There are basic synchronous stimulus types (pseudorandom or log sweep) and two spectral weighting options for each, pink or red. The “pink” spectral weighting options output a signal with equal energy per octave — rolling off at 3 dB per octave in comparison to a purely random “white” spectrum. A signal with a pink spectral weighting will appear to have a flat spectrum when viewed on a fractional octave RTA display. “Red” spectral weighting is similar to pink but has a roll-off rate that increases with frequency, making it much easier on your ears to listen to for any length of time while still providing plenty of high frequency energy for transfer function and impulse response measurements.
User Defined Stimulus Signals

The File Loop option in the SmaartLive signal generator allows you to continuously loop virtually any audio signal, stored in a standard Windows wave file, for use as a measurement stimulus. A stereo wave file can be used to generate a stereo test signal, in all other cases the signal generator will send the same signal to both the left and right output channels.

When using your own wave files to create test signals, the wave file’s sampling rate and resolution (bits per sample) must match the sampling rate and bits per sample currently selected for the audio input device in SmaartLive. The bits per sample parameter for the selected input device is set from the Devices tab of the main Options dialog box.

File looping is done in RAM to avoid gaps at the beginning and end of the file when looped. You may, however, still hear a pop at the beginning of each loop if the first and last samples in the file are not very close in amplitude. And because the entire file is buffered in memory, it’s also a good idea to keep the size of the files you use with this feature fairly small.

The Locked Cursor

SmaartLive’s Locked Cursor feature creates a fixed marker at a selected point on the plot, allowing you to find the difference between that point and any other point with a high degree of precision. When the Locked Cursor is present, you will see three sets of cursor values above the plot. On the left is the locked cursor position, in the center, the standard mouse cursor position, and on the right, the difference between the locked and movable (mouse) cursor positions.

In RTA and Transfer Function modes, the Locked Cursor can be configured to show harmonic and sub-harmonic frequencies for a selected (fundamental) frequency. In Impulse mode, the Locked Cursor is set automatically to the highest point on the impulse response plot after each measurement to show you the propagation delay.

You can create a Locked Cursor at the mouse cursor position on any SmaartLive display except the Spectrograph by holding down the [Ctrl] key while clicking on the plot with the left mouse button. This sets a locked cursor at the closest frequency data point on the top trace or, if no traces are displayed, at the mouse cursor location. You can also
create a Locked Cursor at the highest or lowest point on the top trace automatically using the Find Peak and Find Low commands. To clear the Locked cursor, hold down the [Ctrl] key while clicking off the plot in the margins of the plot area or press [Ctrl] + [X] on the keyboard.

**Weighting Curves**

Many pro audio measurement and system set-up applications require the use of some kind of frequency-dependent weighting curve. Some common examples include the ANSI/IEC “A” and “C” weighting curves used in sound level measurements and system response target curves of various types used for applications ranging from cinema sound to office noise masking systems.

SmaartLive has built-in support for standard A and C weighting curves in its Signal Level/SPL Readout (and by extension, the SPL History graph) and RTA display and also provides architecture for adding user-defined weighting curves that can be used in both Spectrum and Transfer Function mode measurements. Frequency-dependent weighting curves are, in most cases, very similar to Transfer Function curves in that they typically define relative differences in frequencies (i.e., +/– some number of dB, frequency by frequency) so SmaartLive allows you to use any 1/24-octave FPPO Reference Trace as a weighting curve.

That means anything that can be measured using SmaartLive’s real-time Transfer Function analyzer can be used as a weighting curve. All you have to do is capture it as an FPPO reference trace, save the stored trace as a Reference File, and place this file in the Weighting subdirectory of your SIA SmaartLive 5 Program Files folder. SmaartLive scans this folder on start-up so the next time you run the program, your new curve should appear in the list of available weighting curves. Be sure to add a short (~1 - 5 character) text comment to the trace before saving as this will become the curve’s name in SmaartLive’s list of available curves.

A curve editor tool is also provided, accessible from the Reference Trace Information dialog box for use with this feature. This tool can be used to touch up measured curves for use as weighting curves or create an idealized weighting curve from a flat-line trace in any fractional octave resolution up to 1/24 octave.
Chapter 2: SmaartLive Functions

Making a Screen Capture

Microsoft Windows has a feature built in that allows you to capture the active window as a bitmap. While this is not a function of SmaartLive as such, “screen shots” do provide an easy way to include SmaartLive data displays as illustrations in reports and other documents.

To make a screen shot, click on the window you want to capture with your mouse to make sure it is the “active window” and press [Alt] + [PrtScrn] (also be labeled as F13 on some keyboards). This copies an image of the active window to the Windows clipboard. The image on the clipboard can be pasted directly into some word processor and spreadsheet applications, others may require you to save the image as a bitmap file first and then import the file into the document.

To save the captured image as a bitmap using the Paint program included with Windows, open the program by clicking the Start button on the Windows Taskbar and selecting Programs > Accessories > Paint. In the Paint program select Paste from the Edit menu or press [Ctrl] + [V] to bring in the image from the clipboard. If you see a message saying that the image is too large and asking if you want to enlarge the bitmap, click Yes. Then, while the pasted image is still selected, open the Edit menu and select Copy To. In the Copy To dialog box navigate to the folder where you want to put the file, type a file name, and click the Save button.

Note: All SIA-Smaart software products let you set up your own Color Schemes for their plots and other display elements. This feature can be very useful when working with screen shots. For example, you can set up a Color Scheme with white as the background color and dark traces to optimize the captured image for printing to a black and white printer. You can also set the width of line traces in a Color Scheme to something heavier than the default width of 1 pixel, which may prove to be too fine to reproduce well in some cases.

Color Schemes are accessible through the Colors tab of the Options dialog box. You may also want to use the Quick Zoom command in the View menu to remove the control areas from the program window and maximize the plot area before capturing.
Chapter 3: SmaartLive Applications

In Chapter 2 we mainly discussed what SmaartLive can do. The next question, of course, is what can you do with it? This chapter is intended to help you use SIA SmaartLive to make useful measurements of audio systems and components.

Beginning on the next page are a series of example applications that illustrate ways to build test setups using your computer and SmaartLive. The examples are arranged in order of increasing complexity. Later examples build on information presented in the earlier ones, so we recommend that you at least read through the earlier examples before proceeding the more advanced exercises.

The second part of this chapter, entitled A Structured Approach to Measuring and Optimizing a Sound System (beginning on page 81), outlines a process of evaluating and optimizing sound system performance using SmaartLive. The focus will be on improving the spectral balance and stability of sound systems. SmaartLive is also a very effective system alignment tool this is not topic that we can adequately address here. System alignment is covered extensively in Smaart School training classes.

Before proceeding to the example applications, make sure your computer’s sound hardware is installed and operating. Refer to Chapter 6 of this manual and your computer or sound card documentation for troubleshooting help if necessary. All of the following examples assume that your computer has two independent audio input channels. If your card has only a mono line level input (or no line level input) you may be able to use SmaartLive as a single-channel spectrum analyzer but Transfer Function and Delay Locator features will be effectively disabled.

Practical Note: To obtain the best performance from SmaartLive, input levels must be set high enough provide a good signal-to-noise ratio but should not cause the clip indicators above the meters to stay on for any extended period of time. We recommend keeping input levels at about -12 dB on the SmaartLive input meters.

SIA Software Company, Inc. is not responsible for damage to your equipment resulting from improper use of this product. Be sure that you understand and observe the proper input and output levels, impedances and wiring conventions of all system components before attempting the measurements described in this chapter.
Example Application 1

SmaartLive as a Real-Time Spectrum Analyzer (RTA)

A primary function of SmaartLive is that of a two-channel, real-time, audio spectrum analyzer (RTA). The RTA display is very useful for identifying the frequency content of a audio signals. The default RTA display in Spectrum mode plot displays one set of octave or fractional octave bars, showing frequency vs. magnitude band by band, for each of two sound card input channels.

To use SmaartLive as a spectrum analyzer, connect any line-level audio signal source(s) to the computer’s line-level audio input(s). For example, Figure #1 shows one output channel of a CD player connected to the Right sound card input (channel 0), and a microphone and preamp on the Left input (channel 1).

Start SmaartLive by clicking the Start button on the Windows Taskbar and then selecting Programs > SmaartLive > SmaartLive. Click the Smaart On button to the right of the plot title in the SmaartLive window to begin processing and plotting data from the sound card inputs. With all input devices turned off you will probably still see a very low-level signal representing self-noise from the computer’s sound hardware.

With the computer’s internal microphone or the signal from an external microphone selected as your input source (see Configuring Audio Input/Output Controls in Chapter 6 for more information), notice how you the RTA display responds to any noise within range of the microphone. Whistling a tone makes an easily identifiable signal that should drive the data bar(s) up noticeably at the frequency you whistled.

The RTA display can be very useful for identifying feedback frequencies in a sound system and there are any number of other possible applications. One very common RTA application that we do not recommend is measuring the frequency response of a system. SmaartLive’s Transfer Function feature is a much better tool for this task.

Figure #1
Example Application 2

Measuring an Analog Equalizer

In this example, we use SmaartLive’s Transfer Function feature to measure the frequency response of an equalizer (EQ). In addition to your computer and SmaartLive, the following components are required to make this measurement:

1. An external signal source, such as a CD player or noise generator
2. An analog equalizer (If an analog EQ is not available, the EQs on an analog mixer channel or any other analog device that can affect the frequency content of a signal without adding delay may be substituted.)
3. Cables and adapters to make the required connections, including one Y-cable

Connect all the components as shown in Figure #2 below.

Measurement Setup

Split one output channel of your CD player (either the right or the left channel) using a Y-cable. One side of the Y-cable should be connected to drive the input to the equalizer. The output of the equalizer is connected to the computer’s Left sound card input (channel 0), as indicated in Figure #2. This will be considered the measurement, or test channel. The other side of the Y-cable goes to the Right computer input (channel 1). This is called the reference signal because it provides a “before” view of the signal.

![Figure #2](image-url)

Measurement Procedure

Start SmaartLive and play a CD with pink noise or music (or turn on your noise generator). Click the Smaart On button to start the Real-Time Analyzer. At this point you should see two sets of frequency data bars corresponding to the two sound card inputs. Adjust whatever external level controls are available on the EQ and CD player so that
both signals are at approximately the same amplitude level. Check SmaartLive’s *Input Level Meters* to ensure that input levels are not overloading the sound card inputs.

*Practical Note*: You may find it easier to match the levels of the two signals on the RTA display if you use a narrowband RTA display rather than the default bar graph. To enable the narrowband RTA display, select *Graph* from the *Options* menu, check the box labeled *Allow Narrowband RTA* on the *Graph* tab of the *Options* dialog box, then close the dialog and select “Lin” or “Log” on the *Scale* spinner to the right of the plot.

When you have the two input signals matched in level, click the *Transfer* button. The Smart Live display will change to a single trace that shows the *difference* between the two signals, i.e., the frequency magnitude response of the equalizer, in real time.

By default, the transfer function calculation divides the signal from *Left* input (channel 0) by the signal from the *Right* input (channel 1). If you change the equalizer setting to add a cut (attenuation) filter, and the transfer function trace shows a gain (an upward deflection on the trace) at the filter frequency, the inputs are swapped. You can correct this one of two ways:

1. Swap the cables to change the input channels to the sound card, *or*
2. Click the button labeled *Swap* that appears to the right of the plot in Transfer Function mode.

Because all connections in this setup are electrical, the frequency response of the equalizer should be easy to see on the *Transfer Function* display. If all of the equalizer’s filters are bypassed (or set to zero) the *Transfer Function* trace should be a flat line at 0 dB. If the line is flat but is offset from zero, there are two possible corrections:

- Return to Spectrum mode (click the Spectrum button to the right of the plot), and readjust the level of each input signal so the traces appear to be about equal in amplitude on the RTA display *or*
- Use the *dB +/−* control (to the right of the plot) to move the transfer function trace up or down on the plot so that the line is at 0 dB.

You can experiment with different EQ settings, sampling rates, FFT sizes, and types of music or other test signals. Notice that the measurement diverges, i.e., becomes very erratic, if you switch off the signal source (the CD player or noise generator) and/or at frequencies where the source signal has no energy. This is because SmaartLive is still measuring the “self-noise” of the computer sound card and/or external components.
Note: In example two, it was not necessary to compensate for delay. The delay through almost any analog equalizer will be insignificant compared to the length of the FFTs used in the transfer function calculation. When measuring loudspeakers (using a microphone) or digital devices, SmaartLive’s Delay Locator and internal delay feature must be used to align the two signals (in time) before making a transfer function measurement (see Example Application 3).

Example Application 3
Measuring A Loudspeaker

In this example, we use SmaartLive’s Transfer Function and Delay Locator to perform two measurements of the frequency response of a loudspeaker, and introduce the Reference Trace feature.

These measurements require the following components:

1. An external noise source, such as a CD player or noise generator
2. An amplifier and loudspeaker
3. A measurement microphone with very flat frequency response (and a preamp/phantom power supply if necessary)
4. Cables and adapters to make the required connections, including one Y-cable

Connect all the components as shown in Figure #3 below.
Measurement Setup

As shown in Figure #3, one output channel of the CD player (or other noise source) is split so that one branch of a Y-cable is driving the Right computer sound input (channel 1). The other branch drives an amplifier and loudspeaker. The output of the microphone (or mic. preamp) is connected to the Left sound card input (channel 0). This setup creates two signal paths. The signal path starting at the CD player and connected directly to the computer is called the reference signal. The signal returning from the microphone is the measurement signal.

Measurement One

For the first measurement, place the microphone very close to the loudspeaker — less than one foot (30 cm) away. Open SmaartLive and play a compact disc with pink noise or music (or turn on your noise generator).

Click the Smaart On button or press the letter [O] key on your keyboard to start the SmaartLive analyzer in Spectrum mode. Adjust the output levels of the signal source, amplifier and mic. preamp to get the overall amplitude levels of both traces approximately the same on the RTA display. It is important to match the levels of the two traces as closely as possible. Make sure that the signal levels do not overload the sound card inputs — if you are using pink noise or music as a test signal do not exceed about –12 dB on the meters (because of the high crest factor of the signal).

After matching the input levels, click the Transfer button to switch the analyzer to Transfer Function mode. The frequency response of the loudspeaker will be displayed in real time as a single frequency vs. magnitude trace on the plot.

Note that we have not made any compensation for propagation delay between the loudspeaker and microphone. The microphone must be very close to the loudspeaker to obtain an accurate measurement!

Saving a Reference Trace

SmaartLive’s Reference Registers are used to capture and store “snapshots” of the active live trace. The Reference Registers are represented by five groups of small solid-color buttons, labeled A, B, C, D and E, located below the plot area.

![Reference Register Buttons](image)

Click the button for register A1 (the first register button in group A). This “activates” the register even if the button was already depressed.
Click the Capt (capture) button below the plot area to sample and display the current trace as an overlay on the plot. Click the \( A \) button to remove the captured trace from the display. The sampled trace data, called a Reference Trace will remain stored in the register until you erase it or capture another trace to the same register.

To permanently save a Reference Trace to a file on disk, called a Reference File, click the reference Info button to the right of the capture button. This opens the Reference Trace Information dialog box. This dialog box has six tabbed “pages.” Click on the tab labeled \( A \) in the upper portion of the dialog box to bring that page to the front.

Select the register containing the Reference Trace you just captured (by clicking the first of the four solid-color register buttons on the left) and click the Save button. This opens a Windows Save file dialog box prompting you to select a file name ending with the \*.ref extension. Reference Files may be recalled later and displayed as traces by selecting a register in this same dialog box and pressing the Load button. You can also save and reload the contents of all 40 reference registers as reference group (*.rgp) files using the Save All and Load All buttons on the General tab of this dialog box. After saving the reference trace to a file, click the OK button to Exit the Reference Trace Information dialog box.

Note that when you capture a reference trace, the stored trace is initially displayed “in front” of the live trace on the plot. The text color in the \( dB+/– \) spinner field to the right of the plot changes to match the reference trace color and when cursor tracking is enabled, the mouse tracking cursor follows the stored trace instead of the live trace. You can return the focus of the display to the live transfer function trace by clicking anywhere on either input level meter with your mouse. Now click the \( A \) button below the plot to remove the stored traced from the display while you make the next measurement.

**Measurement Two**

Move the microphone and position it several feet (two or more meters) from the loudspeaker. Notice that the transfer function trace begins to diverge (becoming increasingly erratic) as the distance between the microphone and the loudspeaker is increased. This is a result of the delay time between the two input signals becoming greater. **Transfer function measurements require the two input signals to be precisely aligned (in time).**
Signal alignment for transfer function measurements is accomplished by applying an audio signal delay to the reference signal — the signal directly from the signal source connected to the Right input. You will need to perform the following two steps:

- Find the delay time required to align the reference signal with the measurement signal (from the microphone), using SmaartLive’s Delay Locator.

- Set the internal delay on the reference input channel to match.

Click the Auto Sm button below the input level meters to start SmaartLive’s automatic delay locator using the small time window option. After the locator routine runs, click the Insert Delay button in the Delay Found dialog box to set SmaartLive’s internal delay to match the delay time found. The dialog box then closes automatically and the specified delay time should appear in the on the delay readout below the input level meters.

If the delay time found seems impossibly long, chances are that the inputs to the sound card are swapped. To correct this, swap the connections to the computer’s audio inputs then click the Auto Sm button again to repeat the Locator routine.

To assign the current Delay Time to one of the five user-configurable delay presets, click on the (Delay) label above the delay readout field then click on one of the five buttons labeled [F6] - [F10] on the Delay tab of the Options dialog box. You will then be able to recall this delay time later by pressing the corresponding to the Function key on your keyboard. After storing the delay time, click the OK button to exit the Options dialog box.

With the SmaartLive Analyzer running in Transfer Function mode, set the number of averages to 16 or higher using the Avg spinner to the right of the plot to help stabilize the transfer function trace. Once the average buffers fill, the trace should stabilize and the frequency magnitude response shown should agree with what you hear.

Now click the A button in the reference register area below the plot to display the reference trace you made earlier and compare the stored trace with the new live trace. You will probably see a difference between the two traces resulting from the loudspeaker interacting more with its environment (the room) in the second measurement. The Reference Trace feature in SmaartLive is extremely useful for comparing different microphone positions.
Example Application 4
Measuring a Loudspeaker and Setting an Equalizer

In this example, we combine the techniques used in the two previous examples. We will use the *Transfer Function* to measure the frequency response of a loudspeaker then set an equalizer to optimize the loudspeaker’s performance. This procedure requires the following components:

1. An external signal source, such as a CD player or pink noise generator
2. An amplifier and loudspeaker
3. A measurement microphone (and mic. preamp if necessary)
4. An parametric (preferred) or graphic equalizer (digital or analog is OK)
5. Cables and adapters to make the required connections, including one Y-cable
6. A stereo mixer (optional but highly recommended)

Connect the components as shown in Figure #4 below.

**Figure #4**
This is essentially the same setup as Example Application 3 with the addition of a mixer and EQ. The mixer will allow you to switch quickly between measurement of the loudspeaker and measurement of the equalizer. The mixer channel used for the reference signal (A) should be panned all the way to the right. The channels for the two measurement signal points (B and C) should be panned all the way to the left.

Follow the same procedure outlined in Example Application 3 to measure the frequency response of the loudspeaker and store the delay time and measured results.

You will need to perform the following steps:

- Set the mixer controls so that the signals from inputs A and C in Figure #4 are being sent to the computer’s sound card input channels 1 and 0 (Right and Left). Make sure that no signal from the output of the equalizer (mixer input B in Figure #4) is being sent to either of the computer’s audio sound card inputs. Only the signals from mixer inputs A and C should be reaching the computer.
- Use the automatic delay locator to find the delay time between the loudspeaker and microphone then set the internal delay to align the two input signals.
- Store the measured Delay Time value to one of the delay preset registers ([F6] - [F10]) for easy recall.
- Make a transfer function measurement of the loudspeaker’s frequency response.
- Ensure that the input levels and dB+/- setting are such that the Transfer Function frequency response trace is positioned near the zero dB point on the vertical (amplitude) scale of the plot.
- Capture a Reference Trace from the live Transfer Function trace

Now change mixer settings so that the inputs to the computer are the output of the CD player or noise generator (mixer input A) and the output of the equalizer (mixer input B). Make sure that no signal from the microphone is now reaching the computer’s audio inputs.

**Important Note:** SmaartLive’s Delay Locator requires the FFT Time Constant (time window) to be large relative to the decay time of the device or system under test. For an electronic device or small to medium sized room, a time window between 0.3 to 1.0 seconds is usually sufficient. A larger room may require a longer window.
If you are using an analog EQ press the [F5] key on your keyboard to reset the internal delay to 0.0 ms. Since an analog equalizer has no significant throughput delay (latency) and both inputs are electrical, there should be no significant delay in either signal. If you are using a digital EQ (and/or digital mixer) run the auto delay locator to find and compensate for the delay through the device(s).

Click the Swap button to set the transfer function calculation to display the inverse (upside down) EQ response curve overlaid on the previously measured Reference Trace of the loudspeaker response. This will make it easier to use the stored loudspeaker/room response as a “template” for roughing in an EQ curve.

On the inverted EQ response trace, a cut (attenuation) filter will be displayed as a “hump” rather than a “dip.” By matching cut filters on the inverse EQ response trace with high spots on the stored system response trace, you can quickly find and dampen resonant frequencies to help flatten out the loudspeaker/room response. In actual practice, it might be desirable to do this in stages, making additional measurements of the loudspeaker/room response along the way to check your progress.

**Practical Note:** Boost filters are best used very sparingly when equalizing the frequency response of a sound system. Excessive use of boost filters can introduce excessive phase shift and distortion and could have a destabilizing influence on the system. As an alternative, consider changing amplifier and/or crossover settings, if possible, to bring up the “valleys” then use cut (attenuation) filters to flatten out “humps” in the overall system response. Additionally, we strongly recommend the use of parametric equalizers for this type of application, to allow selection of the proper bandwidth for each filter.
A Structured Approach to Measuring and Optimizing a Sound System

Before making measurements of a sound system it is critical to ask yourself, “What am I trying to measure and why?” Sound system performance is determined a number of ways, both qualitative and quantitative. Below is a list of some of the most important questions to ask when evaluating system performance.

- **Frequency response**: Does the system have the ability to deliver sound over the intended frequency range, within the expected deviations?

- **Power handling**: Can the system handle the desired amount of power without massive distortion or failure?

- **Coverage**: Does the system provide sufficient coverage of required areas at all frequencies?

- **Subjective Quality**: This is always the most important criteria. Does the system meet the audience/owners/performers/operators expectations for perceived sound quality?

- **Stability**: Does the system feed back with microphone(s) open and the gain set to a useful level?

- **Noise**: Is the system noisy? Are hums, buzzes and other unwanted noise present in the system?

- **Configuration**: Do you understand the system configuration? Some sound systems have groups of speakers driven form a single source. Others are divided into several sections, each controlled by different set of control circuitry (such as equalizers, delays, crossovers etc.).

- **Are all components of the system working?**

No piece of hardware or software can accurately answer all these questions by itself. Tuning a sound system requires an understanding of the hardware, a discerning ear, accurate measurements, and a disciplined and systematic approach.

We doubt that any two system tuners approach the problem exactly the same way. Also, the process necessarily differs, depending on the complexity of the system and whether it is an existing installation, a touring system, or a newly installed system being brought on-line.
There are, however, several steps we feel are necessary to any successful exercise in sound system measurement and optimization. The order in which they would be followed might differ according to the tuner’s personal preference and the task at hand. The procedure outlined here is based on our own experience and assumes a system that is already in place.

**Step 1: Evaluation Listening**

Before you begin measuring a sound system, we strongly recommend listening to it! You should attempt to qualitatively answer all the questions listed on page 81. This will require you to move around and listen to each section or subsection of the system. Explore the edges of the coverage pattern to see where the various elements are covering and where they are not. It may also be helpful to turn off parts of the system to make a more detailed evaluation of subsystems and components.

**Practical Note:** Unless you designed the system, take some time to try and understand what the system designer had in mind and how the various elements relate to each other.

**Step 2: Identify Potential Problems**

Going back to the list of questions on page 81, are there any obvious problems that need to be addressed? For example, unwanted noise, such as hums and buzzes associated with ground loops and “dirty” power, can degrade system performance and should be addressed before SmaartLive testing begins. Loose and intermittent connections should be fixed. A gain structure that leaves the system hissing should be investigated and corrected.

**Practical Note:** The system must be operating properly before trying to make measurements. Systems that seem to be changing gain or have noises that come and go are not good candidates for optimization. Spend some time sorting things out first.

**Step 3: Select Measurement Points and Positions**

This is one of the most important steps in the process. You need to select measurement points that will show you what you need to see. There are two kinds of measurement points, *electrical* and *acoustic*.

*Electrical* measurement points are used to measure the input and/or output of a single piece of equipment or series of devices. If you want to measure a piece of equipment, or the result of a string of series-connected pieces of equipment, make the connections at the input of the first device in the signal chain and the output of the last.
Acoustic measurements are made with a microphone. When making transfer function measurements using a microphone, a reference signal is also required. The connection for the reference signal should be made at the input of the amplifier for the speaker system, the input of the processor if it is a processed system, or at the input of the system’s equalizer.

Microphone selection and placement are very critical. The microphone itself must be a known quantity. For most applications we recommend the highest quality omnidirectional condenser microphone with the flattest frequency response characteristics that you can reasonably afford.

When selecting the microphone position, ask yourself two questions: “Is this a useful place to make a measurement?” and “What other things will the microphone pick up in this location that might affect the measurement?” Reflections into the side or back of a measurement microphone can seriously reduce the accuracy of a measurement. Think “mirror,” and look around for surfaces that might catch you unaware such as hard walls or floors. Placing a microphone too near to a reflective surface (or not near enough) will result in short reflections that induce comb filtering.

Note: If you can’t avoid a bad floor bounce, try putting the microphone on the floor. This will make the reflection time so short that the resulting comb filter will be above the audible spectrum.

Step 4: Compare Positions

In making acoustic measurements of any system, it is important to make a number of measurements from different microphone positions to make sure that you are not being fooled by something affecting the measurement at any one location (such as a reflection). Move the microphone around and look at what happens to the measured frequency response as you change positions.
Step 5: Set Equalizers and Delays

Setting equalizers and delays can be very time-consuming. There are typically two distinct stages to the process; coarse adjustment and fine tuning. In the first stage, large adjustments to EQ and delay settings are used to make a system roughly correct. Sometimes, the sheer size of these adjustments may seem a little daunting, but if things are sounding right, you are probably doing the right things.

The next stage begins when the system is getting close to right. At this point, changes of a few dB can make the difference between a good-sounding system and a great-sounding system. Learn to recognize this transition.

After making a number of changes to equalizer settings, it is important to go out and listen to what is happening to the system to make sure it is moving in the right direction. Just because it looks good on an analyzer screen doesn’t mean that it is right. Remember, you are working for the ears, not your measurement instruments.

**Important Notes:**

- Always make delay adjustments before trying to make fine adjustments in equalizer settings. A combination of small delay and equalization changes can completely change the character of a delay system.
- Setting delays and equalizers can help make some poorly designed sound systems sound better. However, only in extreme and very rare cases is it possible to correct poor loudspeaker coverage with these types of devices.

Step 6: Critical listening

This is what it is all about so take off your measurement hat and put on the listening hat. Put on a CD (or other program source) and “walk the system.” Listen in the front rows and back in the cheap seats. Try it at low levels. Try it at high levels. Run it though its paces. Turn the source off and listen to everything in silence. Make sure that the noise floor is low enough not to affect the dynamic range of the system.

Use material that is familiar to you. Don’t be afraid to listen to things others may not like. For the purposes of evaluating a system, the best choice of material might very well be something you have heard so many times that you don’t even like it anymore. Only when you are very familiar with (several) program selections will you be able to use them as a basis to quickly and accurately evaluate a system by listening.
Step 7: Stability Testing

It is vitally important to explore the stability of any sound system that includes one or more microphones before it goes into service. Otherwise, someone may find themselves in the uncomfortable position of trying to find and equalize feedback frequencies during a performance or other event.

Unstable sound systems are systems that have an overall gain, including the acoustic path, of more than one — in other words, feedback — at one or more frequencies.

It follows that a stable system is one that has a comfortable margin of gain before feedback (GBF) at its intended operating level while delivering the intelligibility and frequency response characteristics required for its purpose.

Typical Causes of Instability

Instability, or feedback, is often the result of an interaction between off-axis response of a speaker system and off-axis response of microphones. The biggest problems usually arise when narrow peaks in the off-axis responses of both loudspeaker and microphone coincide. These types of interactions can be very troublesome, as they are not as easy to control as the on-axis responses.

Other possible causes or contributors to stability problems include acoustical characteristics of the room and signal processing equipment — particularly reverberation units used in music reinforcement systems.

Detecting Instability

The simplest way to expose a stability problem in a sound system is to turn up the gain, slowly and carefully, until the system feeds back. Not a particularly elegant approach, but it almost always works. If feedback does not occur in the system until the gain is increased well beyond the intended operating level, and the system is free of any noticeable “ringing” at normal levels, it’s pretty stable. If not, you will need to find ways to improve its stability. Depending on the situation, the best solution could be electronic, mechanical, acoustic, educational, or some combination of the four.

Important Note: Feedback can damage audio components. Exercise caution when testing system stability. Feedback is particularly dangerous when it builds up very quickly and overdrives the system, causing overloads or clipping. It might be a prudent safety precaution to use a limiter or compressor during stability testing to help protect system components. Remember, however, that nonlinear devices such as limiters should not be used during transfer function measurements.
Some Approaches to Stabilizing a Sound System

Stabilizing an unstable system, or giving a system more “margin” (GBF) primarily involves reducing the gain of the system at the problem frequencies. Given the nature of the problem, the most obvious solution is equalization. Although equalization is not a panacea or a substitute for good system design, it is one of the most powerful tools you can bring to the task of stabilizing an existing sound system.

SmaartLive can help you to identify problem frequencies and apply equalization with great precision. But before you start turning knobs, consider that equalization affects the overall frequency response of the system. There are other strategies that might be equally effective — or more effective — and could afford you greater freedom to make the system sound better.

Mechanical Solutions and Acoustical Solutions

The position of microphones in relation to loudspeakers can drastically affect the feedback frequency (or frequencies). Reducing the gain at a problem frequency can sometimes be as simple as using a different microphone, or reorienting one already in use (a strategy best employed with microphones that are intended to remain stationary). Moving or reorienting loudspeakers may also be a possibility.

Stability problems often arise when loudspeakers are placed close to (or behind) microphones. In such cases it may be possible to add some sound absorbing material or a baffle that reduces the speaker’s field at the microphone’s position or simply reduce the operating level(s) of the loudspeaker(s) in question. These kinds of solutions are obviously most attractive when they can be applied without giving up any of the sound system’s design goals.

Educational Solutions

An otherwise stable system may lose stability when a number of microphones are open at one time. In this case, the best solution might be to train the operator to keep microphones open only when they are actually in use.

Educating users of the system in microphone technique can also be beneficial. Many people tend to grab microphones or lean very close when they speak. Both of these
actions can cause problems. Grabbing a cardioid microphone can increase its physical gain at certain frequencies when the user’s hand closes off the rear ports to the microphone element, making a stable system suddenly unstable. Also, when people lean too close to a microphone, they can reflect some energy at problem frequencies back into the microphone themselves, possibly causing feedback.

**Electronic Solutions**

Some electronic reverberation units can cause an otherwise stable system to become unstable. If this seems to be the case, try experimenting with other settings and/or reducing the overall level of electronic reverberation. Keep in mind that reverberation generators do what they do (very simply put) by *feeding back* some of the output of the system, through some system of delays, to the input.

With a simple enough system, polarity or phase changes could solve a feedback problem immediately. When the polarity is inverted, instead of positive feedback (something we don’t like) we should get negative feedback (something that may be beneficial). However, in large, complex systems with multiple return paths many wavelengths long, phase or polarity changes will more likely just tend to shift the feedback frequency, without increasing stability.

Probably the most common solution to the problem of feedback is to use equalization to take out offending peaks. By peaks, we mean places in the spectrum where there is significantly more gain (or energy buildup) than others. The procedure involves **carefully** running the system into feedback, identifying problem frequencies, and setting up filters (i.e., EQ stages) to reduce gain at those frequencies. We strongly recommend the use of *parametric* equalizers for this type of application.

Setting up equalizers is a task in which SmaartLive excels. To begin the procedure, you need to get a signal to the computer’s sound card inputs. You could use a microphone or simply connect to any point in the signal path of the sound system. Connecting across the system’s equalizer, as shown in Figure #5, works well and also allows you to measure the EQ without switching the input signals to the computer.
When you have made your connections, start up SmaartLive in Spectrum mode, set a low number of averages and excite the sound system at a low level with pink noise. Now *slowly and carefully* bring up the gain of an open microphone until you see the peaks growing on the RTA display. At this point, the system will usually start to sound rather “hollow” as the pink noise tries to excite feedback at a number of frequencies at once.

Click on the button for one of SmaartLive’s *Reference Registers* to activate it then **CAREFULLY, and very slowly**, bring up the gain of the microphone’s input channel until the system *just* starts to feed back. Look at the plot on the RTA plot on the computer screen and you should see a tall spike on the trace showing the feedback frequency. Press the [Space Bar] to store a copy of the trace in the *Reference Register* you selected. After storing the Reference Trace, reduce the sound system gain to a comfortable level (at which there is no feedback), but don’t turn it off altogether. Place the mouse cursor on the feedback spike on the SmaartLive plot and note the frequency in the cursor readout above the plot.

The next step is to switch SmaartLive to *Transfer Function* mode to measure the response of the equalizer. The object is to set an attenuation (cut) filter centered on the feedback frequency to help dampen the resonances causing feedback. Set a narrow bandwidth with 6 to 10 dB of cut to make the shape of the filter easy to see.

Adjust the center frequency of the filter so that it falls exactly on the feedback frequency noted earlier. When you have the center frequency set, back out the filter’s bandwidth to about one-third octave, and reduce the cut to about –3 dB. Again, using wide, shallow filters helps to keep phase distortions under control and allows for drift in the feedback frequency. When you set the filter to a very narrow bandwidth, the feedback frequency might “walk out from under it” as conditions change in the room.

To determine the effectiveness of the filter, click the RTA button or press [R] on the keyboard to return SmaartLive to Spectrum mode. Bring the system gain up with the same microphone open until it feeds back again. Check the feedback frequency. If it is the same or very close, make a little more cut in the filter you just set. If feedback occurs at a new frequency, go after it with another filter as you did the first one. As you can see, the procedure is simple and much more accurate than playing it by ear. And identifying each problem frequency precisely will make it easier to adjust the filters later if necessary.
**How Much Equalization Is Enough?**

As you equalize a system to increase stability, keep in mind you are reducing gain — even though you are reducing it only at specific frequencies. In many cases, the frequencies in question have proportionately too much gain anyway so you may actually improve the system’s frequency response at operating levels while increasing stability. There is, however, very definitely such a thing as too much equalization.

As a general rule, equalization tends to most effective in improving system stability when the feedback frequencies are fairly close together. When there are a number of feedback frequencies distributed over a wide frequency range, it may be necessary to explore other solutions. When you apply a number of cut filters at widely spaced frequencies, all you really accomplish in many cases is an overall reduction in the gain of the system with no significant improvement in its stability or GBF. In some extreme cases it may be necessary to alter the system design to correct instability.

**Step 8: More Critical Listening**

Once the system is stabilized at operating levels, if the timing and spectral balance is to your liking and you (and everyone else concerned) are satisfied with the its performance, you’re done. More likely, you will need to repeat some combination of Steps 2 through 7 to obtain the best possible performance. Optimizing a sound system is usually a gradual, cut-and-try, give-and-take process (that often takes more time than one would like or expect). We hope that SmaartLive will help to make this process much easier for you.
Chapter 4: SmaartLive Commands

File Menu

Configuration Commands

Load

File Menu > Configuration > Load

The Load command calls the Load Configuration dialog box, allowing you to retrieve a previously saved program configuration. In this dialog box, select the name of the Configuration you wish to recall and click the OK button. The configuration you selected becomes current and its name is displayed on SmaartLive window title bar.

Save

File Menu > Configuration > Save

The Save command replaces the current stored configuration settings with the program settings currently in use. SmaartLive also saves current program settings into the current configuration each time you exit the program normally.

Save As

File Menu > Configuration > Save As

The Save As command calls the Save Configuration As dialog box, allowing you to create a new named configuration for SmaartLive. In this dialog box, all you need to do is enter a name for the new configuration then click OK. The new configuration you created becomes current and its name is displayed on the title bar of the main SmaartLive program window.

Note: You should set up all the program parameters you want to store such as input options, zoom ranges, etc., before selecting the Save As command.
Delete

File Menu > Configuration > Delete

The Delete command calls the Delete Configuration dialog box, allowing you to delete a previously saved program configuration. In the dialog box, select the name of the configuration you want to delete then click the Delete button. When you are finished, click the Close button to exit the dialog box.

Export

File Menu > Configuration > Export

The Configuration > Export command in the File menu is used to extract a copy of the entire SmaartLive registry, from the Windows registration database to a (*.reg) file on disk. Selecting Export opens a standard Windows file Open dialog box prompting you to specify a file name and destination folder for the new file. The *.reg file you create will include a copy of all stored Configuration settings. This feature is useful for backup purposes or moving your preferences to a new computer.

Import

File Menu > Configuration > Import

The Configuration > Import command in the File menu opens a standard Windows file Open dialog box, allowing you to import a previously-saved registry (*.reg) file for SmaartLive into the Windows registration database. Importing a registry file replaces the entire SmaartLive registry, including all stored configuration settings.

Set All Values to Default

File Menu > Configuration > Set All Values to Default

The Set All Values to Default command returns nearly all settings in the current configuration to SmaartLive’s “factory” defaults. The only exceptions are that the current Color Scheme selection and Wave-In/Wave-Out and MIDI-In/MIDI-Out device selections are left undisturbed and must be reset individually from the Colors and Devices tabs of the Options dialog box if necessary.
Open Impulse

File Menu > Open Impulse

Open Impulse is available in Impulse mode and allows you to open a previously recorded impulse response measurement that has been stored in a standard Windows wave (*.wav) file. SmaartLive can also open wave files from other sources provided they are recorded at a sampling rate the program supports and the length of the file conforms to a supported FFT size, which is to say that the total length of the file must be a power of 2 \(2^n\) samples in length between 128 and 512k (e.g., 128, 256, 512, 1k...). Any impulse response wave file written by SmaartLive will already conform to this specification and files from other sources can easily be edited to a compatible length using the SIA Smaart Acoustic Tools or virtually any wave file editor.

Note that files loaded from disk in Impulse mode are treated the same as an impulse response plot that was actively recorded by SmaartLive. The Impulse mode display is cleared automatically when you change the sampling rate or FFT size, record a new impulse response, or exit Impulse mode so you don’t have to worry about closing the file.

Save Impulse

File Menu > Save Impulse

Impulse response measurements recorded in SmaartLive are stored temporarily in a standard Windows waveform (*.wav) file. The impulse recorder always uses the same file name for its output file and overwrites this file each time you make a new measurement. If you want to preserve the results of an impulse response measurement for analysis in SIA Smaart Acoustic Tools (or any other purpose), click the Save As button that appears to the right to the right of the plot area in Impulse mode or select Save Impulse from the File menu. This will open a standard Windows Save As file dialog box to enable you to write the data to a new wave file that will not be overwritten by the next measurement.
ASCII Save

File Menu > ASCII Save

The ASCII Save function is available only for the RTA display in Spectrum mode or in Transfer Function Mode. This command temporarily pauses the analyzer if it is running and displays a special Save As file dialog box. The dialog box includes check boxes for each live trace and reference register bank, allowing you to select some combination of displayed traces to be included in the ASCII output file. A text field has also been added that allows you to enter a comment to be included in the header of the output file.

One limitation when saving multiple traces is that when saving from Transfer Function mode or a narrowband (Linear or Log) RTA display in Spectrum mode, all traces to be included in the file must have the same sampling rate and FFT size as either the Active Input trace (if the analyzer is running) or the active reference trace (if the analyzer is not running). There is no limitation on which traces can go into the file when running the RTA display with octave or fractional octave frequency resolution in Spectrum mode.

ASCII output files from SmaartLive arranged in a tabular format suitable for import into a spreadsheet. The format of the file differs somewhat between RTA and Transfer Function modes due to differences in the data.

- **RTA ASCII files** are formatted as a single table. On the left is one column of frequency values for each FFT data point, octave/fractional octave band (depending on the display type selected when the file is created) followed by a single column of magnitude values by frequency for each selected trace.

- **Transfer Function ASCII files** have a separate table for each selected trace, stacked one above the other. Each trace’s table will have three columns for frequency, magnitude, and phase information.

*Notes:*

The ASCII Save function command is not available for the Spectrograph or SPL History displays in Impulse mode, SmaartLive does have extensive capabilities for logging of spectral and sound level data over time. For more information on these features, please refer to *Timed Spectral/LEQ Measurements* on page 23.

Impulse response data stored in wave files can be converted to ASCII using the Smaart Analysis module (included in SIA-Smaart Acoustic Tools) or any WAV to ASCII conversion utility.
Chapter 4: SmaartLive Commands

Print

File Menu > Print

The Print command first takes you to the Custom Print Information dialog box to allow you to set title text and other options for the printout before printing. The Custom Print Information dialog box can be used to set all the same printing options as the Printing tab of the Options dialog box. After setting title and page options, click the OK button in the Custom Print Information dialog. A standard Windows Print dialog box will then open to allow you to select a printer and set up your printer options before sending the document to print.

Note: If you un-check either the “Show custom print dialog before print and print preview” check box on the Printing tab of the Options dialog box or the check box labeled “Show this dialog before print and print preview” in the Custom Print Information dialog box, the Print command will bypass the Custom Print Information dialog box and take you directly to the Print dialog box.

Print Preview

File Menu > Print Preview

The Print Preview command first takes you to the Custom Print Information dialog box to allow you to set title text and other options for the printout before proceeding. The Custom Print Information dialog box can be used to set all the same printing options as the Printing tab of the Options dialog box. When you click the OK button in the Custom Print Information dialog box, SmaartLive goes to Print Preview mode.

In Print Preview mode, you will see a “what-you-see-is-what-you-get” (WYSIWYG) preview of how all the text on the printed page should look when printed. The area where the graph will appear is indicated by an empty box. You can then use the Print button to send the document to the currently selected printer immediately and exit Print Preview mode or select Close to return to the normal SmaartLive program window without printing the document.

Note: If you un-check either the “Show custom print dialog before print and print preview” check box on the Printing tab of the Options dialog box or the check box labeled “Show this dialog before print and print preview” in the Custom Print Information dialog box, the Print Preview command will bypass the Custom Print Information dialog box and take you directly to the Print Preview mode.
Print Setup

File Menu > Print Setup

The Print Setup command opens a standard Windows Print Setup dialog box where you can select a printer and set up the page size, orientation, and paper source for hard copy output. Depending on the type of printer selected, there may be additional options you can access by clicking the Properties button in the Print Setup dialog.

Control Menu

Smaart On

Control Menu > Smaart On

In Spectrum or Transfer Function mode, this command starts the SmaartLive analyzer and begins plotting data from your sound card’s inputs in real time. Smaart On is a toggle command. Click the button again, press [O], or select the command again from the menu to stop the analyzer. In Impulse mode this group of controls is replaced by a single Start/Stop button, used to start the impulse recorder and/or abort a measurement in progress.

Pause

Control Menu > Pause

This command pauses the analyzer while running in Spectrum or Transfer Function modes. All traces remain visible in the plot area. Live traces remain “frozen” on the screen. When Pause is selected, the indicator light above the ON (Smaart On) and pause buttons turns yellow to indicate that the analyzer is paused. Pause is a toggle command. To resume processing data in real time when paused, click the Pause button, press [P], or select the command again from the Control Menu.
Instantaneous

Control Menu > Instantaneous

In both Transfer Function and Spectrum modes you can use averaging to help stabilize the live trace(s). Averaging helps to make trends in the data easier see but slows down the response of display to changes and can mask transient events. The Instantaneous command simply sets the number of averages to one (i.e., no averaging) temporarily while remembering the number of averages you were using previously. Repeating this command will reset the number of averages to the number you were using before, allowing you to “A/B” between averaged and un-averaged data without requiring you to reset the number of averages each time.

Generate Signal

Control Menu > Generate Signal

The Generate Signal command turns on SmaartLive’s internal signal generator and begins sending signal to the selected Wave-out device at the level specified on the Generator spinner (shown above). Note that additional options for the signal generator are available from the dialog box that appears when you click the Generator label above the output level field. Generate Signal is a toggle command. Repeat the command or click the button again to turn the signal generator off.

Reseed Averages

Control Menu > Reseed Averages

Reseed Averages clears the averaging buffers (used to increase the stability of the live traces). This forces SmaartLive to “reseed” the averaging buffers with fresh data. The plot will require a short period of time to re-stabilize while the buffers are filled. Note: Changing the number of averages, FFT size or sampling rate or switching between main display modes also re-seeds the averaging buffers.
MIDI Program Change

Control Menu > MIDI Program Change

This command calls a simple MIDI Program Change dialog box, allowing you to send out a program change (by program number) to a MIDI controlled device on a specified MIDI channel.

Active Input

Control Menu > Active Input

Although SmaartLive analyzes data from both the left and right audio input channels simultaneously, there are several program functions that look at only one of the two inputs at any given time. When the SmaartLive analyzer is running in Spectrum Mode, for example, the Spectrograph and SPL History displays analyze only the data from the active input channel and on the RTA display, the trace corresponding to the active input is the one that gets sampled when you capture a Reference Trace. The Signal Level/SPL Readout above the input level meters tracks the active input in all display modes.

The Active Input commands in the Control menu can be used to select whether the Left input (channel 0) or the Right input (channel 1) is active. The active input can also be selected by clicking the Input Meter bar for the channel you want to make active. The current active input selection is marked by a bullet (•) in the Active Input section of the Control menu and by the Active label below the input level meters.

When multiple (live and/or reference) traces are displayed on the plot, selecting the active input brings the corresponding trace to the top of the (z-axis) “stack” whether or not the input was previously designated active. This also works in Transfer Function mode where clicking either meter brings the standard live transfer function trace to the top (in addition to selecting the active input).

The trace at the top of the z-axis stack is the focus of all Locked Cursor operations and is the trace the mouse tracking cursor tracks when Track Nearest Data Point is turned on. The top trace is also the focus of the dB +/- spinner to the right of the plot area, used to adjust the vertical position RTA and transfer function of the traces. Note that the text color in the dB +/- spinner field changes to match the front trace color when the z-order changes.
Reference Commands

Show

Control Menu > Reference > Show

The Show (A, B, C, D, or E) commands are used to “activate” the selected Reference Register in the corresponding Reference Bank — making it the target for the Capture and Erase Reference Trace commands. If the selected register already contains a Reference Trace, this command also “toggles” display of the trace on and off.

Select and Capture

Control Menu > Reference > Select and Capture

The Select and Capture commands capture a new reference trace into the selected Reference Register in the corresponding Reference Bank in one step — in effect, combining the Show and Capture commands.

Select Next and Capture

Control Menu > Reference > Select Next and Capture

The Select Next and Capture commands capture a new reference trace into the register next to the currently selected Reference Register (cycling from left to right) in the corresponding Reference Bank in one step — in effect, combining the Move to Next Register and Capture commands.

Move to Next Register

Control Menu > Reference > Move to Next Register

The Move to Next Register commands select the register next to the currently selected Reference Register (cycling from left to right) in the corresponding Reference Bank.

Capture

Control Menu > Reference > Capture

The Capture command in the Reference section of the Control menu stores a “snapshot” of the (active) live trace in the currently selected Reference Register. Reference
traces stored in registers can be saved to reference (*.ref) files and recalled at any time using the using the reference Show commands. This command is disabled if no Reference Register is selected.

**Flip Reference Trace**

**Control Menu > Reference > Flip Reference Trace**

![Flip](image)

The Flip Reference Trace command is active only in Transfer Function mode and is analogous to the Swap Transfer Function Inputs command for the live trace. It “flips” the active reference trace upside down on the plot, transposing negative values to positive and positive to negative.

Flip Reference Trace is a toggle command. Select this command again from the menu to return the selected Reference Trace to it’s normal state.

**Erase Reference Trace**

**Control Menu > Reference > Erase Reference Trace**

![Del](image)

The Erase Reference Trace command clears the active Reference Register. **This command cannot be undone. A Reference trace not saved to a file before using the Erase Reference Trace command will be irretrievably lost.**

**Use E as an Averaging Register**

**Control Menu > Reference > Use E as an Averaging Register**

![E avg](image)

The Use E as an Averaging Register command switches Reference Registers in the group E to “averaging mode.” **When this feature is selected, capturing to an E register does not sample from the live trace.** Instead, all displayed reference traces from banks A, B, C, and D are averaged together and the results stored and plotted as a single reference trace.
Chapter 4: SmaartLive Commands

Hide All Reference Traces

Control Menu > Reference > Hide All Reference Traces

The Hide All Reference Traces command temporarily removes all displayed reference traces from the plot without disturbing your reference register selections. Hide All Reference Traces is a toggle command. Repeat the command or click the button again to restore display of the hidden Reference Traces.

Erase All Reference Traces

Control Menu > Reference > Erase All Reference Traces

The Erase All Reference Traces command clears the contents of all SmaartLive’s Reference Registers — for both the RTA and Transfer Function modes. This command cannot be undone. Reference traces not saved to files before using the Erase All Reference Traces command will be irretrievably lost.

Show Reference Information

Control Menu > Reference > Show Reference Information

The Show Reference Information command calls the Reference Information dialog box. This dialog box has six “tabs,” (tabbed “pages”); a General tab and one tab for each of the five Reference Register banks (A, B, C, D and E).

General Tab

On the General tab you can edit comments and adjust the vertical (Y +/-) positioning for all stored reference traces. Click on the solid color buttons in the left margin to see the comments and vertical offset for different registers within each group.

Reference Group Save Feature

The Load All and Save All buttons on the General tab allow you to save and reload the contents of all 40 (RTA and Transfer Function) Reference Registers as a single file, in a single operation.
The Save All command stores the current contents of all Reference Registers in a single Reference Group (*.rgp) file. If you like, you can attach a text comment to the group file that will be visible during subsequent Load All operations.

Load All calls an Open file dialog box to allow you to select a previously-saved Reference Group file to be loaded.

**Important Note:** The Load All operation replaces the contents of all 40 Reference Registers so any existing, unsaved reference traces will be lost. SmaartLive will ask you for confirmation before loading to help prevent accidental overwrite of existing data.

**Individual Register Bank Tabs (A, B, C, D and E)**

The individual register bank tabs (A, B, C, D and E) allow you to view (but not edit) the Comment text and vertical (Y+/–) offset for each stored trace along with all input parameters in use when the Reference Trace was captured including:

- Whether the trace was averaged from two or more reference traces (Averaged Trace?) or captured directly from a live trace
- The Sampling Rate (SR) in use when the trace was captured
- FFT frame size used (FFT)
- The internal Delay Time (Delay) in use when the trace was captured
- The channel to which the delay was assigned (Delay Ch)
- The number of Averages used (Averages)
- The Data Window used (Window Type)
- If the Reference Trace has been saved to a file, the (file) Name, (creation) Date, and the (SIA-Smaart Reference File Specification) Version number of the file are also displayed. Again, the solid color buttons on the left are used to browse through the individual Reference Registers in the selected bank.
In Transfer Function mode, when the a reference register containing a 24 point per octave (FPPO) reference trace is selected, an Edit button appears just above the reference register buttons. Clicking the Edit button will open SmaartLive’s reference trace editor, to allow you to make adjustments to the selected trace point by point, invert the trace, or throw out the entire curve and create a new one in octave, or fractional octave resolution. This feature is intended primarily for use in creating custom weighting curves.

Weighting functions apply only to the magnitude display in Transfer Function mode so clicking the Flat or Flip buttons in the trace editor dialog box will flatten the phase response curve. If you want to flatten the phase response of a curve without also throwing out the magnitude portion, just click the Flip button twice. Saving an FPPO reference trace as a reference file (see below) in the Weighting folder in your SmaartLive Program Files folder will add it to the list of available weighting curves the next time you run SmaartLive.

To permanently store any Reference Trace to a (*.ref) file on disk, click the solid-color button for the register containing the trace you want to save then click the Save button. A standard Windows Save file dialog box will appear with the selected register name suggested as the name for the new file, e.g., a1.ref. Any legal file name ending with the extension “.ref” may be substituted.

To retrieve a previously-stored Reference (*.ref) File into a Reference Register for display, select the destination register by clicking one of the four solid-color buttons, then click the Load button. An Open file dialog box will appear, allowing you to select a reference file you want to open. Note that you can only load conventional RTA traces when SmaartLive is in Spectrum mode or Transfer Function traces in Transfer Function mode.
Save Active Reference Trace

Control Menu > Reference > Save Active Reference Trace

The Save Active Reference Traces command opens a Windows Save file dialog box allowing you to save just the current active reference trace to a (*.ref) file on disk. Note that you can also save reference traces to (and retrieve from) Reference Files in the Reference Information dialog box.

Delay Time

Control Menu > Delay Time

The Delay Time commands in the Control menu can be used to increase and decrease or recall stored settings for SmaartLive’s internal signal delay. You can also change the current Delay Time by clicking the label above the delay readout (shown below) to open the Delay tab of the Options dialog box then typing in a new value (up to 750 ms) in the Delay Time field.

The Increase and Decrease delay commands change the current delay time value by 0.01 milliseconds and have the same affect as clicking the spinner (up/down) buttons to the left of the delay readout (shown above). The Clear delay command ([F]) resets the current delay time to 0 ms.

In all operating modes except Impulse mode, the Delay Preset commands ([F6] - [F10]) change the current delay time to the value stored in the corresponding delay preset register. In Impulse mode, these commands activate markers on the impulse response plot that mark the time locations of the stored delay times. Preset delay values for the internal signal delay are user-configurable and can be accessed through the Delay tab of the Options dialog box.
Locked Cursor Commands

Move Commands

Control Menu > Locked Cursor > Move (Left, Right, Left 1 Data Point, Right 1 Data Point, )

The Move commands in the Locked Cursor section of the Control menu are used to move an existing Locked Cursor as follows:

**Move Left**

*Keyboard Command = [Ctrl] + [Left Arrow]*

Moves the Locked Cursor one pixel to the left.

**Move Right**

*Keyboard Command = [Ctrl] + Right Arrow*

Moves the Locked Cursor one pixel to the right.

**Move Left 1 Data Point**

*Keyboard Command = [Ctrl] + [Shift] + [Left Arrow]*

Moves the Locked Cursor to the next data point on the left.

**Move Right 1 Data Point**

*Keyboard Command = [Ctrl] + [Shift] + [Right Arrow]*

Moves the Locked Cursor to the next data point on the right.

Find Peak

Control Menu > Locked Cursor > Find Peak

The Find Peak command creates (or repositions) the Locked Cursor at the highest point (in amplitude) found on the trace currently displayed on top. In Impulse mode, SmaartLive performs this operation automatically to locate the propagation delay time, or “first arrival” in the impulse response plot. The Find Peak command has the same
effect as clicking the Peak button that appears below the plot in Impulse mode. This button appears only in Impulse mode however the menu and keyboard commands for this function are also available in Spectrum and Transfer Functions modes.

Please note that if the Locked Cursor is already positioned at the highest peak on the trace (e.g., by the impulse recorder’s auto-locate option), the Find Peak command does nothing.

**Find Next Higher**

*Control Menu > Locked Cursor > Find Next Higher*

Moves the Locked Cursor to the location of the data point on the top trace that is closest in amplitude and higher than the current location. The Find Next Higher command has the same effect as clicking the up button on the Peak spinner that appears below the plot in Impulse mode. This spinner is available only in Impulse mode however the menu and keyboard commands for this function are also available in Spectrum and Transfer Functions modes.

*Note:* If the Locked Cursor is already positioned at the highest point on the trace, this command does nothing.

**Find Next Lower**

*Control Menu > Locked Cursor > Find Next Lower*

Moves the Locked Cursor to the location of the data point on the top trace that is closest in amplitude and lower than the current location. The Find Next Lower command has the same effect as clicking the down button on the Peak spinner that appears below the plot in Impulse mode. This spinner is available only in Impulse mode however the menu and keyboard commands for this function are also available in Spectrum and Transfer Functions modes.

*Note:* If the Locked Cursor is already positioned at the lowest point on the trace, this command does nothing.
Find Low

Control Menu > Locked Cursor > Find Low

Creates (or repositions) the Locked Cursor at the lowest point (in amplitude) found on the trace currently displayed on top. (If the Locked Cursor is already positioned at the lowest point on the trace, this command does nothing.)

Track Peak

Control Menu > Locked Cursor > Track Peak

Track Peak sets a dynamic locked cursor that tracks the highest magnitude value in the Spectrum mode RTA display or Transfer Function Magnitude plot in real time. Track Peak is a toggle command. Selecting the Track Peak menu command again or pressing [Ctrl] + [Shift] + [T] on your keyboard while the function is active turns it off.

Show Harmonics

Control Menu > Locked Cursor > Show Harmonics

Show Harmonics overlays a set of vertical rules on the plot showing up to 16 harmonic and two sub-harmonic frequencies for the Locked Cursor location. The Show Harmonics command cycles through four different states when repeated. You will initially see the even harmonic frequencies when this command is used. Repeating he command will show odd harmonics then even and odd harmonics. Repeating the command a fourth time turns the harmonic display off.

When a harmonic display is present, you can step the locked cursor between harmonic frequencies without disturbing the fundamental frequency selection using the Next and Previous Harmonic commands. The Locked Cursor readout (above the plot on the left) displays the notation F when the Locked Cursor is positioned on the fundamental, H(number) when moved to a harmonic frequency and S(number) on a sub-harmonic.

Next/Previous Harmonic

Control Menu > Locked Cursor > Next/Previous Harmonic

The Next Harmonic and Previous Harmonic commands move the Locked Cursor one harmonic frequency to the right when Show Harmonics is turned on. The Locked Cursor readout (above the plot on the left) displays the notation F when the Locked Cursor is positioned on the fundamental, H(number) when you move to a harmonic frequency and S(number) on a sub-harmonic.
Remove

Control Menu > Locked Cursor > Remove

This command removes an existing Locked Cursor from any SmaartLive module plot.

System Presets

Control Menu > System Presets

System Presets are “macros” that store a number of settings for SmaartLive program parameters. All the setting stored in a preset can then be recalled as a group with a single command. Parameters that can be recalled by a preset include selections for Sampling Rate, FFT size, delay, averages, Transfer Function mode and external device selections. You can also configure a preset with a MIDI program change to send when the preset is recalled. The System Preset commands in the Control menu are used to store/recall System Preset parameters from/to your current SmaartLive session. Note that you can also store and recall presets and browse and edit the stored settings directly using the System Preset Options dialog box.

Save Values To > (Preset 1-9)

Keyboard Command = [Ctrl] + [Shift] + ([1] - [9])

Replaces the parameters stored in the selected System Preset (1-10) with your current program settings.

Save Values To > (Any Preset)

Keyboard Command = [Ctrl] + [Shift] + [0]

Opens a dialog box that allows you to name and store the current program settings into any System Preset (1-100).

Load Values From > (Preset 1-9)

Keyboard Command = [Ctrl] + ([1] - [9])

This command replaces the applicable program settings currently in use with the parameters stored in the selected System Preset (1-9).
Chapter 4: SmaartLive Commands

Save Values To > (Any Preset)

*Keyboard Command* = [Ctrl] + [Shift] + [0]

Opens a dialog box that allows you to recall the program settings stored in any System Preset (1-100) by name or preset number.

*Notes:*

When you begin a SmaartLive session, no System Preset is loaded. After a loading a preset, its name appears on the title line above the plot. If you change any of the program parameters the preset stores (e.g., if you change the number of averages using the Avg spinner), an asterisk (*) will appear next to the preset name on the title line to indicate that the current and stored parameters no longer match. Saving or reloading the preset clears the asterisk.

Spectrum Menu

Spectrum Mode

*Spectrum Menu > Spectrum Mode*

!!! Spectrum !!!

This command switches SmaartLive to Spectrum mode. Note that in Spectrum and Transfer Function modes, the SmaartLive analyzer does not begin plotting data from your sound card’s inputs until Smaart On is selected.

RTA Display

*Spectrum Menu > RTA Display*

!!! RTA !!!

This command brings up the RTA display in Spectrum mode. Note that in both Spectrum and Transfer Function modes, the SmaartLive analyzer does not begin plotting data from your sound card’s inputs until Smaart On is selected.
Chapter 4: SmaartLive Commands

Spectrograph

Spectrum Menu > Spectrograph

![Spectro]

This command brings up the live Spectrograph display in Spectrum mode. Note that in both Spectrum and Transfer Function modes, the SmaartLive analyzer does not begin plotting data from your sound card’s inputs until Smaart On is selected.

SPL History

Spectrum Menu > SPL History

![SPL]

This command brings up the live SPL History display in Spectrum mode. Note that in both Spectrum and Transfer Function modes, the SmaartLive analyzer does not begin plotting data from your sound card’s inputs until Smaart On is selected.

Note: For information on Spectrum mode main display types and display control logic, see Spectrum Mode Overview on page 14.

Show Inputs

Spectrum Menu > Show Inputs

![Meas Sig Ref Sig]

The Show Inputs menu commands toggle (remove/restore) display of the two live spectrum plots on the RTA display in Spectrum mode. The Show Inputs commands toggle. For example, selecting the Left (0) command hides the spectrum plot for the Left input if it was visible, or restores it to the display if it was hidden. Note that in the case of the RTA display, hiding the spectrum plot for the Active Input causes the other (unhidden) input to become active. Also note that SmaartLive continues to process data for both inputs, even if both traces are hidden, until the analyzer is paused or stopped.
Timed Average / LEQ

Timed Average/LEQ Setup

Spectrum Menu > Timed Average / LEQ Setup

This command opens the Timed Average / LEQ Setup dialog box to allow you to set up a timed spectral average or logging operation in Spectrum mode. The Timed Average/LEQ Setup dialog is divided into three sections with controls for setting the start time, measurement type and output destination.

Start Time

In this section, you will find controls for specifying the start time of the measurement. The options are to count down from the time you click the start button (at the bottom of the dialog box) or to begin the measurement at a specified day and time. To begin the measurement immediately select the Count Down option and set the count down timer to zero.

Time Measurement

In this section, you need to select the type of timed measurement you want to make. All timed averages are a linearly integrated power average of FFT data collected over some period of time so all three measurement types require you to specify the Sample Period (integration period). For the (one-shot) Timed Average, this is the only parameter you need to specify in this section. For the LEQ Log and Spectrum Log options, you also need to set the Duration time for the measurement. LEQ (Equivalent Sound Level) and Spectrum log files will have one log entry for each Sample Period over the specified Duration of the measurement.

Output Destination

The options in the lower section of the Timed Average / LEQ Setup dialog box vary according to the type of measurement selected above. For the one-shot timed average, you only need to select a reference register to receive the averaged FFT data and optionally, a weighting curve to be applied to the measurement and comment text for the resulting reference trace. For an LEQ Log you will need to specify an output file name and weighting curve (typically A weighting) for the measurement. Spectrum Log measurements require you to select the measurement resolution (octave or fractional...
Chapter 4: SmaartLive Commands

octave) and output file name. Note that Spectrum Log files can be post-processed to derive weighted L_EQ and Percentile Noise data from the unweighted spectral data stored in the files (see LEQ Report from File, below).

**LEQ Report from File**

*Spectrum Menu > Timed Average / LEQ Report from File*

SmaartLive spectrum and L_EQ log files are stored in tab-delimited ASCII text files suitable for import directly into a spreadsheet or other application to be used for post-processing. SmaartLive also has a built-in post processing function for Spectrum log files that extracts a report of L_EQ, Minimum/Maximum sound levels (L_MIN and L_MAX) and optionally, Percentile Noise for up to six percentile thresholds (L_{10}, L_{50}, and L_{90} plus three user-definable) from the spectral data. A and C weighted plus flat (unweighted) versions of all of the above are included in the report file automatically. The report file generator will calculate cumulative values for the entire file or a specified portion of the file with or without optional interim averages at specified intervals throughout the reporting period.

**Power Comparator Mode**

*Spectrum Menu > Power Comparator Mode*

The Power Comparator function sums the power in two groups (designated A and B) of selected 1/24th octave bands and displays the relative percentage or decibel difference between the two. Both percentage and decibel values are also logged to a text file at user-specified intervals while the Power Comparator is running. The Power Comparator feature was actually custom built for a somewhat exotic application and quite frankly, we are at something of a loss for suggestions as to how else it might be used. We elected to include it in the release version because the uses people find for SmaartLive never cease to astound us and the fact that we can’t think of a more generalized application for this feature ourselves certainly does not mean someone else won’t.
**Enabled**

When Power Comparator mode is enabled, SmaartLive is locked into Spectrum mode with 1/24th octave frequency resolution. The notation in the Signal Level/SPL Readout changes to “Power Comparator” and the number displayed in the readout will represent either the (user-selectable) decibel or percentage difference in power between groups A and B (see below). Enabled is a “toggle” command so a check mark appears next to in the menu when it is selected and selecting the same command from the menu again turns off the Power Comparator.

**Configure**

Options for the Power Comparator are set from the Power Comparator Configuration dialog box, accessible by selecting Configure from the Power Comparator fly-out in the Spectrum menu. The Select Octave section has a group of radio buttons used to select which octave band appears in the Assign Bands to Groups section to the left. The Assign Bands to Groups section has two columns of check boxes that enable you to assign any combination of 1/24th octave bands in the selected octave to group A and/or B.

The unit type to be displayed in the Signal Level/SPL Readout when Power Comparator mode is enabled is selected in the Display Mode section of the dialog box. The Printout Interval value sets the logging interval (in seconds) for the ASCII output file specified in the Printout File section (please pardon the UNIX-style terminology). If no printout file is specified, the logging function is disabled.

**Noise Criterion Mode**

*Spectrum Menu > Noise Criterion Mode*

This command puts SmaartLive into an operating mode designed specially for making Noise Criterion (NC) measurements. NC Mode is a type of RTA display with octave band resolution plotted as a line trace or “fever chart,” rather of the familiar bar graph with standard Noise Criterion (NC) curves superimposed on the plot. When running in NC Mode, the Noise Criterion Ratings for each displayed trace, both live and reference traces, are shown in the upper right corner of the plot and updated in real time.

Noise Criterion Mode is a toggle command. Repeat the command to return to the standard RTA display. This command is available only in Spectrum mode.
Notes:

**NC measurements are valid only when SmaartLive is calibrated to SPL.** Also note that the NC curves themselves are all in the range of +8 to +80 dB and so are normally only *visible* when the analyzer is calibrated to SPL.

You can also overlay NC curves on the standard RTA display plot (without invoking the full Noise Criterion Mode feature) by selecting Show Noise Criterion Curves on the Graph tab of the Options dialog box.

**NC Rating Table**

*Spectrum Menu > NC Rating Table*

In Spectrum mode with octave band (Oct) resolution selected for the RTA display, SmaartLive will calculate and display the standard Noise Criterion (NC) Rating for each of the two live traces when you select this command. This table may then be saved to a text file by clicking the Save button in the NC Rating dialog box.

Notes:

**NC measurements are valid only when SmaartLive is calibrated to SPL.**

To plot a standard NC graph, use the *Noise Criterion Mode* command.

**Trace Difference**

*Spectrum Menu > Trace Difference*

In On the RTA display in Spectrum mode, with octave, or fractional-octave band resolution only, the Trace Difference feature will calculate and display the magnitude difference for each band between any two displayed traces. If 1/3-octave resolution is selected, the Sound Transmission Class (STC) rating is also calculated. Selecting the Trace Difference command from the Spectrum Menu or pressing [Ctrl] + [F] on the keyboard calls the Specify Trace Difference dialog box.

In the Specify Trace Difference dialog box, select the trace you wish to compare in the “Show How Trace” section and the trace to use as the reference in the “Is Different From Trace” section. When you click the OK button, calculations are performed and the results displayed in a table. In 1/3-octave resolution, the STC rating is displayed below the table. The table may be saved (with a comment) as an ASCII file, suitable for import into a spreadsheet or word processor, by clicking the Save button.
Chapter 4: SmaartLive Commands

Note that the trace difference is not calculated for low bands containing less than two FFT data points because the data may not be reliable. To obtain reliable data in the lower bands, use a larger FFT size and/or a lower sampling rate to increase the frequency resolution of the FFT.

**Reset SPL History Min/Max**

Spectrum Menu > Restart SPL History

Note that when the mouse cursor is positioned over the SPL History display, the cursor readout shows Minimum and Maximum SPL values along with the SPL value currently plotted at the cursor’s time coordinate. The lowest and highest (Min/Max) SPL values encountered in a SmaartLive session are remembered for the duration of the session or until they are flushed and reset using the Reset SPL History command or by pressing ([Ctrl] + [R]) on your keyboard.

**Transfer Function Menu**

**Transfer Function Mode**

Transfer Function Menu > Transfer Function Mode

The Transfer Function Mode command switched SmaartLive to Transfer Function mode. In Transfer Function mode the SmaartLive analyzer to compares the signals from the computer’s Left and Right audio inputs in the frequency domain, and plots differences between the two signals in both magnitude and phase, giving you a total picture of the frequency response of the device or system under test. Normally, the transfer function calculation in SmaartLive divides the signal at the Left input (channel 0) by the signal at the Right input (channel 1). This means that unless the Swap Transfer Function Inputs command is selected, SmaartLive expects to find measurement signal on the Left input channel and reference signal on the Right channel.

Note that in both Spectrum and Transfer Function modes, SmaartLive begins plotting data from your sound card’s inputs when Smaart On is selected.
Phase

Transfer Function Menu > Phase

The Phase command divides the plot area into two sections in Transfer Function mode, reducing the size of the Magnitude display and inserting a second graph showing relative phase shift by frequency (between the reference and measurement signals) above it.

Phase is a toggle command. Repeat the command or click the button again to return to the full-size frequency/magnitude display.

Coherence

Transfer Function Menu > Coherence

The Coherence command toggles display of the live coherence trace in Transfer Function mode. This command has the same affect as the “Coh” button that appears to the right of the plot in Transfer Function mode. Coherence is a toggle command. Repeat the command or click the “Coh” button again to turn off the coherence trace.

Swap Transfer Function Inputs

Transfer Function Menu > Swap Transfer Function Inputs

This command transposes (swaps) the inputs in the Transfer Function calculation so that SmaartLive will divide the signal at the Right input (channel 1) by the signal at the Left input (channel 0). This means that when the Swap Transfer Function Inputs command is activated, SmaartLive expects to find measurement signal on the Right input channel and reference signal on the Left channel.

The Swap Transfer Function Inputs feature is mainly used when you want to display the inverse (upside-down) response curve of an EQ or system processor channel to facilitate using a stored room/system response measurement as a guide for setting
filters. The swap feature could also be used if you happen to get the reference and measurement signals connected backwards but physically swapping the cables is usually preferable and helps to avoid confusion.

The notation “[Swap]” will appear in the upper right corner of the Magnitude plot when this feature is turned on, as an additional indicator that the inputs are swapped. Swap Transfer Function Inputs is a toggle command. Repeat the command or click the button again to resume normal Transfer Function mode operation.

**Averaging**

Transfer Function Menu > Averaging

These commands set the type of Averaging (Vector or RMS) SmaartLive uses for Transfer Function measurements (only). The Transfer Function mode averaging technique can also be selected by clicking the text label on the averages (Avg) spinner to the right of the plot. The notation “(V)” or “(R)” appears next to the averages spinner in Transfer Function mode to indicate which type of averaging is currently in use.

**Smoothing**

Transfer Function Menu > Smoothing

Smoothing is a type of averaging for live and reference traces that is available only in Transfer Function mode. This feature helps to reduce “jagginess” on transfer function traces and can make trends in the device or system response easier to see. On a smoothed transfer function trace, each data point is averaged together with some number of adjacent points on either side of it (determined by the Smooth spinner to the right of the plot).

For example, if the Smooth spinner is set to 3, any given data point will represent the value of that point averaged with the next higher and next lower points (in frequency) on the trace. The available smoothing options are 3-point, 5-point, 7-point, 9-point or None. Note that you can also select the number of points to be averaged in the smoothing routine by clicking in the Smooth spinner field and making your selection from the pop-up menu.
Phase Display Properties

**Set Range to -180 -> 180**

Transfer Function Menu > Phase Display Properties > Set Range to -180 -> 180

*Keyboard Command = [Alt] + [Home]*

Resets the standard *wrapped* phase display (only) to the default range of +180° to –180°.

**Set Range to 0 -> 360**

Transfer Function Menu > Phase Display Properties > Set Range to 0 -> 360

*Keyboard Command = [Alt] + [End]*

Sets the standard *wrapped* phase display (only) to a range of 0° - 360° (bottom to top).

**Unwrap**

Transfer Function Menu > Phase Display Properties > Unwrap

*Keyboard Command = [U]*

This command “unwraps” the phase display, by looking for “wrap” points where the phase trace crosses the +/- 180° boundary and “wraps” back around. The trace is then “spliced” at the wrap points to give you a more linear of phase response across the entire displayed frequency range. So, for example, a 360° phase shift that would show up at 0° on the wrapped display is plotted at 360° on the unwrapped display. Keep in mind though, that the actual phase data coming from the transfer function calculations is always in the range +/- 180°, meaning the wrapped display is relying on some assumptions that may not always be true. Also note that from a practical usage standpoint, this type of display may not work very well if the incoming measurement data is not very stable.

**Show Phase as Group Delay**

Transfer Function Menu > Phase Display Properties > Show Phase as Group Delay

The Show Phase as Group Delay option converts phase angles between adjacent frequencies in the phase display to milliseconds. The results are plotted as positive or negative millisecond values where a value of zero milliseconds for a given frequency means the reference and measurement signals are arriving at exactly the same time.
at that frequency. Note that as in the case of the unwrapped phase display, the deviation from minimum group delay works by extrapolating values from the actual phase data based on some assumptions that might not always be true and works best when the incoming measurement data is very well behaved.

Setting the Range of the Phase Display Graph

The same (secondary) Frequency and Amplitude Range controls used for secondary displays in Spectrum mode also work for the Phase display in Transfer Function mode. In this case the y-axis of the plot is showing you time relationships rather than magnitude but otherwise, the controls for zooming in and out and moving the displayed range up and down work as you would expect for the unwrapped and group delay displays.

The standard wrapped phase display is a special case because the total y-range of this type of plot is always equal to 360°. On the wrapped phase display the secondary Move Up/Down commands “roll” the zero° line up or down on the plot in 45° increments. The zoom in and zoom out commands are not applicable to this display type.

Note that by default, frequency ranges of the Magnitude and Phase displays in Transfer Function mode are linked together so that both the primary and secondary Frequency Range commands affect both plots identically. If you need to adjust the displayed frequency ranges of the Magnitude and Phase displays independently, you can do so if you uncheck the check box labeled “Transfer Function Phase Tracks Magnitude Display” on the Zoom tab of the main Options dialog box.

Show (Traces)

The Show (Traces) menu commands toggle (remove/restore) display of the two live trace types on both the Magnitude and Phase displays in Transfer Function mode. These commands “toggle,” so selecting the either command hides the associated trace if it was visible, or restores it to the display if it was hidden and have the same function as the on-screen buttons shown here.
Note that the on-screen Time Window button and menu command are disabled when FPPO is selected for the FFT size. See *Time Windowing* on page 30 for more information.

**Amplitude Scale**

**Log**

*Transfer Function Menu > Amplitude Scale*

The Logarithmic (Log) amplitude scaling option for the Transfer Function mode Magnitude plot (only) displays amplitude values on the (vertical) $y$-axis logarithmically, labeled in decibels. This is the default $y$-axis scaling option and it should not need to be changed for most types of frequency response measurements.

**Lin**

*Transfer Function Menu > Amplitude Scale*

The Linear (Lin) amplitude scale command in Transfer Function mode sets the vertical amplitude axis of the Magnitude display to linear scaling, labeled in Ohms. There may be any number of uses for this display type but as the choice on units suggests, it is primarily intended for use in making frequency-dependent impedance measurements. Selecting this option also activates the Z-Calibrate function (see below).

**Z Calibrate**

*Transfer Function Menu > Amplitude Scale*

When linear (Lin) scaling is selected for the Transfer Function mode Magnitude display, selecting the Z Calibration command or double-clicking on the main plot with your mouse opens the Z Calibrate dialog box, to calibrate the transfer function display for impedance measurements. This dialog also sets the range of the linear transfer function magnitude plot and has a button to reset the display to standard log scaling.

For impedance measurements, you need to calibrate the display using a resistor of known value. To calibrate the impedance graph, insert the calibration resistor in your measurement jig in place of the device to be tested (see diagrams on next page), run the analyzer and double-click the display to open the Z Calibrate dialog box.
Block diagrams of two possible circuit topologies for impedance measurement. The diagram on the left shows a passive “single-ended” circuit. The diagram on the right has active differential input circuits, requiring no correction curve. In both diagrams, $V_{\text{generator}}$ is the stimulus source, typically a small amplifier with broadband noise as the input signal. $R_{\text{shunt}}$ is a shunt resistor and $Z_{\text{load}}$ is the device under test.

In the Z Calibrate dialog, uncheck the Lock Value box then enter the value (in Ohms) of the calibration resistor in the “Calibrated Impedance is” field. Note that in addition to the calibration value, you must also select the basic circuit topology used in your outboard measurement jig in the Circuit Topology section.

There are two choices for circuit topology labeled “Single-Ended” and “Differential.” Although there are exceptions to the rule, generally speaking, the Differential option requires a measurement jig with (active) differential inputs whereas the Single-Ended option will be used with most passive jigs that use only resistors (see diagrams above). When the Single-Ended option is selected, a correction curve is applied to the measurement to reverse a known impedance magnitude non-linearity inherent in single-ended circuits. The Differential option assumes no non-linearities in the input circuitry.

**Subtract Reference Trace**

Transfer Function Menu > Subtract Reference Trace

Subtracts a the active Reference Trace from the live Transfer Function trace and plots a single trace showing you the difference. For example, if you were measuring an EQ and saved the EQ response as a Reference Trace, then flipped Reference Trace and subtracted the reference trace from live trace, you should see a flat line. When this function is active, a notation appears in the upper right of the Transfer Function frequency/magnitude plot to indicate the register number of the stored trace being subtracted. Subtract Reference Trace is a toggle command. Repeat the command to return to the normal Transfer Function display.
Impulse Menu

Impulse Mode

**Impulse Menu > Impulse**

Switches SmaartLive to Impulse mode. In Impulse mode, SmaartLive measures and displays the impulse response of the system under test. This display allows you to find the difference between the arrival times of two input signals, compare delay times and look at acoustical information contained in the impulse response of the device or system under test such as reflections and reverberant decay.

Record Impulse

**Impulse Menu > Record Impulse**

The impulse recorder starts automatically when you switch SmaartLive to Impulse mode. If you need to run the impulse recorder again or abort an impulse recorder measurement in progress, click the large Start/Stop button or press [R] on your keyboard. *Record Impulse* is a “modal” command. Notice that the *Start* button changes to a *Stop* button while the locator routine is in progress. Clicking the *Stop* button, pressing [R], or selecting the command again from the menu aborts the recording routine.

Amplitude View

**Impulse Menu > Amplitude View**

The Amplitude View commands in the Impulse menu select the vertical (y-axis) amplitude scaling mode for the main impulse response plot in Impulse mode. These options are also available on the amplitude Scale spinner in Impulse mode. SmaartLive can display the (time-domain) impulse response data using a Linear or Logarithmic vertical amplitude scale. A third option, the Energy Time Curve is actually a logarithmic
representation of the envelope of the impulse response calculated using a combination of time- and frequency-domain data. This option is particularly useful in finding delay times for low-frequency devices.

**Note:** Trying different amplitude scales can often be helpful for finding the initial peak or delay location when working in noisy and/or reverberant environments.

### Continuous Mode

**Impulse Menu > Continuous Mode**

This command causes SmaartLive to run continuously in Impulse mode — starting over each time it finishes a measurement. This allows you to watch as changes occur over a period of time. Continuous Mode is a toggle command. Repeat the command or click the Continuous button again to stop continuous mode operation and return to normal “one-shot” Impulse mode operation.

### Flip Inputs

**Impulse Menu > Flip Inputs**

This command transposes (flips) the two input signal for the purposes of Impulse mode measurements (only). This function is precisely analogous to the Swap Transfer Function Inputs command in Transfer Function mode but was given a different name to try and avoid confusion.

If you run the SmaartLive in Impulse mode and get a plot with the largest peak near the right side of the trace — appearing to indicate an impossibly long delay time — selecting this command and running the impulse recorder again may correct the problem. The notation “[Flip]” will appear in the upper right corner of the Impulse mode plot when this feature is turned on to indicate that the inputs are flipped.

Flip Inputs is a toggle command. Press the button again or re-select the command in the Impulse menu to resume normal operation.
Set Delay To Peak

Impulse Menu > Set Delay To Peak

Set Delay To Peak

In Impulse mode, when the Locked Cursor is present on the plot, this command automatically assigns the Locked Cursor’s time location as the current Delay Time value.

Note: If the Locked cursor is not present, [Shift] + mouse click on Impulse mode plot assigns the mouse cursor position as the current Delay Time.

Assign Locked Cursor To (Delay Preset)

Impulse Menu > Assign Locked Cursor To > Delay Preset (F6 - F10)

SmaartLive’s internal delay feature stores five “preset” delay time values. Delay Presets are user-definable and may be configured from the Delay tab of the Options dialog box or set automatically in Impulse mode.

In Impulse mode, when the Locked Cursor is present on the plot, selecting one of the Assign Locked Cursor To (Delay Preset) commands from the Impulse menu will automatically:

- Assign the Locked Cursor’s time location as the current Delay Time value
- Store the Locked Cursor’s time location in the specified Delay Preset register
- Exit Impulse mode

The Delay Preset are assigned to Function keys [F6] -[F10] on your keyboard (the [F5] key resets the Delay Time to 0). In all operating modes except Impulse mode, you can recall a stored Delay Preset value as the working delay time, by simply pressing the corresponding Function key. In impulse mode, the [F6] -[F10] keys toggle display of markers corresponding to each Delay Preset on the main impulse response plot.
The Compare Delay Presets feature is intended to simplify the process of comparing multiple delay measurements to find the differences. This feature is useful for driver and array alignment, setting up delays in distributed sound systems, or any other application where you need to compare two or more delay times. The Compare Delay Presets tool works with the Locked Cursor and Delay Presets features to create a table that shows you the differences between up to six different delay times automatically.

Clicking the Compare button that appears below the main plot area in Impulse mode, opens the Compare Delays dialog box (shown below). This dialog box is “modeless,” meaning that you can leave it open while you work in the main Impulse mode window. When a Locked Cursor is present, its time coordinate will be entered in the table automatically along with the delay time(s) stored in any displayed Delay Preset (F6 - F10). Please note that stored (preset) delay times will appear in this list only when their markers are visible on the impulse response plot.

Each entry in the Compare Delays table has five parts:

- The name. In the case of the stored Delay Preset times, this will consist of the preset number (F6 - F10) and optionally, a text label you specify. The name of the Locked Cursor entry is fixed as <Locked Cursor>.
- The absolute (total) delay time in milliseconds (Abs. ms)
- The absolute distance (from the source to the microphone) in feet or meters (Abs. ft or Abs. m) depending on which distance unit type is currently selected.
- The relative delay time in milliseconds (Rel. ms)
- The relative distance in feet or meters (Rel. ft or Rel. m)
The list is sorted by absolute delay time, from the shortest to the longest. By default, the first entry in the list is considered “time zero.” All relative values time and distance values for the other entries are computed relative to the time zero values. The entry being used as time zero is marked in the list with a purple triangle. To designate another entry as the baseline for relative time and distance values, simply click on its name with your mouse to highlight the entry and click the Set As Time 0 button.

To add or change a text label for a store Delay Preset time, simply highlight the entry by clicking its name, click the Label Button to pop up the Label dialog, then type your label text in the text entry field and click the OK button. Note that you can also set labels for the Delay Presets by clicking any of the preset time fields in the main Impulse mode window and selecting Label This Delay from the pop-up menu.

**Auto-Locate Delay Large**

*Impulse Menu > Auto-Locate Delay Large*

The Auto-Locate Delay Large command runs the SmaartLive automatic delay locator using the Large time window settings specified on the Locator tab of the Options dialog box. There are two options for the Delay Auto-Locator because the impulse response measurement technique SmaartLive uses to find delays is very sensitive to the decay time of the system being measured. It is essential that the time window used in the measurement be large relative to the decay time of the room/system under test.

The default settings for the large Delay Auto-Locator time window yield a window size of approximately 3 full seconds. This time window should be sufficient for acoustic measurements in medium sized rooms but may need to be increased for measurements in very large and/or reverberant spaces.

After the Delay Auto-Locator routine runs, a dialog box pops up to allow you to set internal signal delay for the reference channel to the delay time found. This dialog box also shows you the absolute polarity of the impulse response.
Auto-Locate Delay Small

Impulse Menu > Auto-Locate Delay Small

The Auto-Locate Delay Small command runs the SmaartLive automatic delay locator using the Small time window settings specified on the Locator tab of the Options dialog box. There are two options for the Delay Auto-Locator because the impulse response measurement technique SmaartLive uses to find delays is very sensitive to the decay time of the system being measured. It is essential that the time window used in the measurement be large relative to the decay time of the room/system under test.

The default settings for the small Delay Auto-Locator time window yield a window size of approximately 300 milliseconds. This time window is appropriate for measuring delays through electronic devices or acoustic (microphone) measurements in very small rooms.

After the Delay Auto-Locator routine runs, a dialog box pops up to allow you to set internal signal delay for the reference channel to the delay time found. This dialog box also shows you the absolute polarity of the impulse response.

View Menu

Frequency Range

View Menu > Frequency Range

The Frequency Range commands change the scale and range of the horizontal (x) axis of the primary and secondary plots Spectrum and Transfer Function modes. In Spectrum mode, a plot that is displayed full-screen or the one in the lower portion of the plot area on a split screen display is considered to be the primary display while the one on top is regarded as a secondary. Similarly, in Transfer Function mode, the Magnitude display is considered the primary and the Phase display is the secondary.

The primary and secondary Frequency Range commands listed below can be used to adjust the frequency ranges of each plot independently (when applicable). In Impulse mode, the primary Frequency Range commands also double as time range zoom and move commands.
Primary Frequency Range Controls

**Move Primary Right**

*Keyboard Command* = [Right Arrow]

“Moves” the displayed range of the primary display to the right to show higher frequencies.

**Move Primary Left**

*Keyboard Command* = [Left Arrow]

“Moves” the displayed range of the primary display to the left to show lower frequencies.

**Zoom Primary In**

*Keyboard Command* = [Up Arrow]

Increases horizontal “magnification” of the primary display by decreasing the size of the range displayed.

**Zoom Primary Out**

*Keyboard Command* = [Down Arrow]

Decreases horizontal “magnification” of the primary display by increasing the size of the range displayed.

Secondary Frequency Range Controls

**Move Secondary Right**

*Keyboard Command* = [Alt] + [Right Arrow]

“Moves” the displayed range of the secondary display to the right to show higher frequencies.

**Move Secondary Left**

*Keyboard Command* = [Alt] + [Left Arrow]

“Moves” the displayed range of the secondary display to the left to show lower frequencies.
**Zoom Secondary In**

*Keyboard Command* = [Alt] + [Up Arrow]

Increases horizontal “magnification” of the secondary display by decreasing the size of the range displayed.

**Zoom Secondary Out**

*Keyboard Command* = [Alt] + [Down Arrow]

Decreases horizontal “magnification” of the secondary display by increasing the size of the range displayed.

**Notes:**

1. Frequency ranges of Spectrum and Transfer Function mode displays can also be set using the Frequency Range Presets (Zooms).

2. By default, the Frequency ranges of the Spectrum mode RTA and Spectrograph plots are tied together as are the Magnitude and Phase plots in Transfer Function mode. Both can be unlinked, allowing their ranges to be set independently by un-checking the check boxes in the Link Frequency Range Controls section of the Zoom tab in the main Options dialog box.

3. In Impulse mode, you can also zoom in on the time scale by clicking and dragging in the small “thumbnail” display above the main plot with your left mouse button. Clicking in the left margin of the main plot in Impulse mode returns the plot to the full time scale (the FFT Time Constant).
**Frequency Scale**

*View Menu > Frequency Scale*

The Frequency Scale section of the View menu lists the available display options for the horizontal (x-axis) scaling of the RTA plot and the y-axis scaling of the Spectrograph display. Frequency scale display options can also be selected using the Scale spinner (shown above), which appears to the right of the plot in Spectrum mode or by using the following keyboard commands:

- **Narrowband Log** – *Keyboard Command = [5]*
- **1/24-Octave** – *Keyboard Command = [6]*
- **1/12-Octave** – *Keyboard Command = [7]*
- **1/6-Octave** – *Keyboard Command = [8]*
- **1/3-Octave** – *Keyboard Command = [9]*
- **Octave** – *Keyboard Command = [0]*

*Note:* The Narrowband Log (logarithmic scaling) and Narrowband Lin (linear scaling) options are also available in Transfer Function mode but are available in Spectrum mode only when the Allow Narrowband RTA option is selected on the Graph tab of the Options dialog box.

**Frequency Range Presets (Zooms)**

*View Menu > Frequency Range > Frequency Zooms (1-4)*

The numbered Frequency Zooms (1 - 4) store ranges for the frequency (X) axis of the analyzer mode plots that can be recalled with a single keystroke or mouse click. The frequency ranges of all four Frequency Zooms are user-configurable. Frequency Zoom parameters are set from the Zoom tab of the Options dialog box.
Amplitude Range

View Menu > Amplitude Range

The Amplitude Range commands are analogous to the Frequency Range controls and operate in almost exactly the same way. These commands set the of the amplitude range on almost every SmaartLive display type. The secondary amplitude range commands also double as y-axis controls for the Phase display in Transfer Function mode.

Again, there are separate sets of controls for primary and secondary graphs, allowing you to set the range of each graph independently on split screen displays. When two graphs are displayed together, the one on the bottom is considered the primary and the one above is the secondary. When only one graph is displayed, the secondary range controls are not used.

Primary Amplitude Range Controls

**Move Primary Up**

*Keyboard Command* = [Page Up]

“Moves” the displayed range of the primary display upward to show higher magnitudes.

**Move Primary Down**

*Keyboard Command* = [Page Down]

“Moves” the displayed range of the primary display downward to show lower magnitudes.

**Zoom Primary In**

*Keyboard Command* = [+/=]

“Magnifies” the displayed vertical range of the primary display for most plot types or narrows the magnitude range of the Spectrograph display.

**Zoom Primary Out**

*Keyboard Command* = [--]

Decreases magnification of the vertical range of the primary display for most plot types or widens the magnitude range of the Spectrograph display.
Secondary Amplitude Range Controls

**Move Secondary Up**

*Keyboard Command = Alt] + [Page Up]*

“Moves” the displayed range of the secondary display upward to show higher magnitudes.

**Move Secondary Down**

*Keyboard Command = Alt] + [Page Down]*

“Moves” the displayed range of the secondary display downward to show lower magnitudes.

**Zoom Secondary In**

*Keyboard Command = Alt] + [ +/–]*

“Magnifies” the displayed vertical range of the secondary display for most plot types or narrows the magnitude range of the Spectrograph display.

**Zoom Secondary Out**

*Keyboard Command = Alt] + [–]*

Decreases magnification of the vertical range of the secondary display for most plot types or widens the magnitude range of the Spectrograph display.

Note that on the when the unwrapped or group delay options are selected for the Phase Display in Transfer Function mode, the secondary amplitude range commands operate very much as you would expect on the y-axis of the Phase plot. The default “wrapped” Phase display is a special case because its range is fixed at 360°. On the unwrapped Phase display, the secondary move up and move down commands “roll” the zero line of the plot up or down in 45° increments and the Zoom commands are not used (see Phase Display Properties on page 117 for more information).
Shift Active Trace

View Menu > Shift Active Trace

The Shift Active Trace commands literally move the (active) live RTA or Transfer Function Magnitude trace up or down on the display by one increment (as specified on the Graph tab of the Options dialog box). Vertical positioning of traces can also be set using the dB +/- spinner (shown above) that appears to the right of the plot in Spectrum and Transfer Function modes.

Shift Reference Trace

View Menu > Shift Reference Trace

The Shift Reference Trace commands move the active reference trace up or down on the plot by one increment (as specified on the Graph tab of the Options dialog box). When a reference trace is the top trace you can also adjust it vertical position using the dB +/--spiner that appears to the right of the plot in Spectrum and Transfer Function modes. The vertical position of any reference trace can also be set on the General tab of the Reference Information dialog box.

Cursor

Track Nearest Data Point

View Menu > Cursor > Track Nearest Data Point

With this command selected, the tracking cursor “snaps” to the top trace on the plot (on applicable display types), moving from data point to data point along the trace as you move the mouse cursor from left to right. To bring a live trace (or bar graph spectrum plot) to the top of the (z-axis) stack on the RTA display in Spectrum mode, click anywhere on the corresponding input meter bar or in the Active label field below the input level meter for the channel you want to make active.
In Transfer function mode, clicking anywhere on either input level meter the meter brings the standard live transfer function trace to the top and clicking the trace-colored rectangle below the Time Window button brings the time widowed trace to the top if it is present. To bring a stored reference trace to the top, click the corresponding Reference Register button. This works even if the button for the trace is already depressed.

**Show THD**

*View Menu > Cursor > Show THD*

This command is available only in Spectrum mode when 1/24-octave frequency scaling is selected. When Show THD is selected SmaartLive compares the power of the 1/24th octave band at the cursor frequency to the sum of the power in the first 9 harmonics for that frequency and calculates a Total Harmonic Distortion value for the cursor frequency. This value is displayed along with the frequency and decibel values for the cursor position in the Cursor Readout field above the main plot area. Show THD is a toggle command. When active, selecting the same command again from the View > Cursor menu turns the Show THD function off.

**Move Cursor**

*View Menu > Cursor > Move Cursor*

When the Track Nearest Data Point option is enabled, the *Move Left* and *Move Right* commands can be used to move the precision tracking cursor one data point to the right or left (on the top trace).

**Quick Zoom**

*View Menu > Quick Zoom*

Selecting the Quick Zoom command in the View menu or pressing [Ctrl] + [Q] removes all on-screen controls (except the Device Bar, if present) from the display, expanding the plot area to fill the entire SmaartLive program window. This feature can be particularly useful when running SmaartLive on a computer with a small display because it maximizes the area available for data displays with a single command. Quick Zoom is a toggle command. Selecting this command again from the View or pressing [Ctrl] + [Q] again returns SmaartLive to the standard screen layout when Quick Zoom is on.
Chapter 4: SmaartLive Commands

Device Bar

View Menu > Device Bar

The Device Bar in SmaartLive gives you one-click access to external devices assigned to buttons on the bar. The device bar is visible above the title label for the plot area when you select Device Bar from the view menu or click the Bar button above the selected device field to the right of the plot. Note that the number of buttons available on the bar depends on the your screen resolution and the size of the SmaartLive program window. For example, at 800 x 600 resolution with SmaartLive running full-screen, the device bar will consist of five buttons. Larger window sizes will allow the use of more device buttons.

You can assign a configured external device to a button on the device bar by clicking the Assign to Device Bar button in the External Device Information dialog box. When the bar is visible, you can also assign a device by clicking any unused button with your mouse and selecting Assign Device to Button from the pop-up menu. If you want to change the device assigned to a device button by clicking on it with your right mouse button and select Assign Device to Button from the pop-up menu. Any of these actions will open the Edit Device Buttons dialog box shown below.

In the Edit Device Buttons dialog box, select the number of the button want to use (counting from left to right) in the Button field and the Device you want to assign to it. If you select a multi-channel device, you will also need to select the input or output channel the button will call in the Channel field. The Label field will automatically pick up the name assigned to the selected device/channel in the device configuration but you can use a different name for the button if you like. Changing the button label text will not affect the name assigned in the device configuration.
To remove a device from a device button, right-click the button and select Remove Device From Button in the pop-up menu. To remove all devices from all device buttons, right-click any button on the Device Bar and select Clear All Device Buttons from the pop-up menu.

**Input Bar**

View Menu > Input Bar

At 800 x 600 screen resolution (the minimum resolution supported) SmaartLive automatically loads a more compact control layout that differs slightly from the control layout used at 1024 x 768 or higher resolutions. One of the more noticeable differences between the two is that on the 800 x 600 control layout, the FFT Parameters control that appears to the left of the plot in Spectrum and Transfer Function modes at higher screen resolutions is moved to a horizontal parameter bar below the main plot.

The same is true in Impulse mode although the FFT parameter controls are somewhat different — in Impulse mode there are separate controls for each parameter rather than one combined control. There are, however, there are horizontal and vertical versions of the control groups for the low and high resolutions, just as there are in Spectrum and Transfer Function modes.

In both cases the FFT Parameter Bars in the compact layout that can be hidden when not in use, to make more room for the main data display(s). The FFT Parameter Bar command in the View menu toggles this control area on or off, hiding the bar if it is visible or displaying the bar if it is hidden.

With the exception of the location and layout, both versions of the FFT Parameter controls behave identically. Both display the same information and clicking on either with your mouse gives you access to associated the FFT Parameter(s), through a pop-up menu or dialog box, to enable you to make parameter changes.
External Devices Menu

Devices

The Devices fly-out menu in the External Devices menu allows you to select any configured external device/channel as your current device for remote control. The Configure command in the Devices fly-out menu opens the External Device Information dialog box to allow you to add/modify SmaartLive external device definitions.

The Devices fly-out menu is essentially identical to the pop-up menu that appears when you click on the Ext. Device field (shown above) which appears to the right of the plot in all SmaartLive display modes (unless Quick Zoom is selected). The only difference is that if no devices are configured, clicking the on-screen Ext. Devices field opens the External Device Information dialog box immediately without displaying a pop-up menu. Clicking the Bar button to the right of the Ext. Device label field turns the Device Bar on and off.

External Device Mode

This command puts SmaartLive in “External Device mode.” The floating control panel for the selected external device will pop up and in Transfer Function mode, a set of filter markers will appear on the plot. The layout of the floating control panel will vary to some extent according to the model and type of device selected. Some controls are specific to the device and will be accessible only from the control panel. The following commands deal just with the filter markers displayed on the plot.

- In External Device mode, holding down the [Shift] key while clicking on the Transfer Function plot with the left mouse button creates a marker and sets a new filter at the mouse cursor location or moves the closest unused (flat) filter to the cursor position (depending on the device type).
- To select an existing filter in External Device mode, click it’s marker with the left mouse button. When a filter is selected, the center of the marker becomes solid and
the filter’s center frequency (Hz), bandwidth (Oct), and cut/boost value (dB) are shown in the top three edit fields on the floating control panel. A negative value in the dB field indicates a cut filter.

- To adjust the center frequency and boost/cut value for a filter, click on it’s marker and hold down the left mouse button while “dragging” the marker to a new location.

You can also change these settings as well as the bandwidth of the filter using the arrow keys, the corresponding spinners on the external device control panel fields, or by typing a new value into one of the three edit fields. If the external device sets center frequency, bandwidth, and/or cut/boost values in preset increments, values you specify may be adjusted slightly as SmaartLive updates the filter settings.

**Select Next/Previous Filter**

*External Devices Menu > Select Next / Previous Filter*

The Select Next Filter and Select Previous Filter commands cycle filter selection through all available filters on the remote device in ascending (next) or descending (previous) order. Note that the cycling order follows filter number, not necessarily frequency order.

The center frequency (Hz), bandwidth (Oct), and cut/boost value (dB) of the selected filter, along with the filter and channel number, are shown in the upper portion of the floating external device control panel.

**Mouse Shortcut:** To select a specific filter, simply click its marker on the Transfer Function plot with your left mouse button. Unselected filters appear as a hollow box with cross hairs (as shown at the left). The marker for the selected filter will have a solid-color center.

**Flatten Selected Filter**

*External Devices Menu > Flatten Selected Filter*

The Flatten Selected Filter command resets the selected filter on the external EQ unit to 0 dB cut/boost. Note that on some devices, a filter set to flat is considered unassigned and may disappear from the Transfer Function mode plot completely.

**Note:** This command is enabled only when SmaartLive is operating in Transfer Function mode with External Device mode selected.
Chapter 4: SmaartLive Commands

Increase/Decrease Frequency

External Devices Menu > Increase / Decrease Frequency

The Increase Frequency and Decrease Frequency commands in the External Devices menu increase or decrease the center frequency of the currently selected filter on the remote device.

Mouse Shortcut: You can also change the center frequency and boost/cut value of a filter by clicking on the filter’s marker with your mouse and holding down the left mouse button while “dragging” the marker to a new location.

Note: This command is enabled only when SmaartLive is operating in Transfer Function mode with External Device mode selected.

Increase/Decrease Boost

External Devices Menu > Increase / Decrease Boost

The Increase Boost and Decrease Boost commands in the External Devices menu increase or decrease the boost/cut value of the currently selected filter on the remote device.

Mouse Shortcut: You can also change the center frequency and boost/cut value of a filter by clicking on the filter’s marker with your mouse and holding down the left mouse button while “dragging” the marker to a new location.

Note: This command is enabled only when SmaartLive is operating in Transfer Function mode with External Device mode selected.

Increase/Decrease Width

External Devices Menu > Increase / Decrease Width

The Increase Width and Decrease Width commands in the External Devices menu increase or decrease the bandwidth value of the currently selected filter on the remote device.

Note: This command is enabled only when SmaartLive is operating in Transfer Function mode with External Device mode selected.
Options Menu

All

Options Menu > All

The All command in the Options menu opens the Options dialog box with the last tab used on top (any tab may be selected any time the Options dialog box is open). This dialog box gives you access to nearly all of SmaartLive’s user-configurable options and properties from one location.

The Options dialog box is organized into 10 separate “pages” for different types of settings. We also refer to these pages as “tabs” because each has an index tab at the top that is always visible in the top portion of the dialog box window. Selecting any command in the upper portion of the Options menu opens the Options dialog box with the selected page on top (Clock, External Devices, Signal Generator, SPL and System Presets have separate options dialogs and Volume Control is a Windows utility). To bring a different page to the front when the dialog box is open, simply click on its tab.

Color

Options Menu > Colors

SmaartLive allows you to customize the colors of virtually everything on the screen and even use your own bitmap files as a background. Color and background options are loaded as sets called Color Schemes. Several ready-to-use color schemes are included with the program and you can easily define your own as well. The Colors tab of the Options dialog box allows you to create, edit and manage Color Schemes for the SmaartLive display. Note that separate Color Schemes may be selected for display and printing purposes.

Color Schemes

The Color Schemes section of the Colors tab has a list of all available Color Schemes along with buttons for creating, editing, and deleting user-defined schemes and list boxes for selecting the display and printing Color Schemes for SmaartLive.

New...

Clicking the New button calls the Edit Color Scheme dialog box, allowing you to create a new color scheme. In this dialog box, you can change colors for various display
elements and optionally, specify a Windows bitmap (*.bmp) file to use as a background for the main program Window. You can also set the thickness (in pixels) of line traces in SmaartLive, a useful feature for printing, making screen captures or when working outdoors or other situations where screen contrast and visibility may be a problem.

The initial color selections for each element in the Edit Color Schemes dialog box are based on the existing Color Scheme that was selected in the list when you click the New or Edit button. Clicking any of the solid-colored squares in the Edit Color Schemes dialog opens a standard Windows Color dialog allowing you to choose a pre-defined color or specify a custom color to be used for the selected element.

The Edit button calls the Edit Color Scheme dialog box to allow you to edit an existing (user-defined) Color Scheme selected in the Color Schemes list.

Clicking this button deletes the user-defined Color Scheme selected in the Color Schemes list.

Selecting Display and Printing Colors

Immediately below the Color Schemes section are two drop-down list fields:

• **Display Color Scheme** – Selects an existing Color Scheme to be used for display purposes (the colors shown on your computer screen).

• **Printing Color Scheme** – Selects an existing Color Scheme for use when printing from SmaartLive.

Delay

Options Menu > Delay

The Delay tab of the Options dialog box is used to configure SmaartLive’s internal signal delay and delay preset registers.

**Delay Time**

Specifies the amount of delay (up to 750 milliseconds in 1/100 millisecond increments) to be applied to the signal on the selected input channel. This “working” Delay Time is independent of the Delay Presets ([F6] -[F10]). Keep in mind that a Delay Time value not
stored in a preset will be lost if one of the presets is selected later (as the preset’s value becomes the current working Delay Time value). The Clear (F) button to the left of the Delay Time input field resets the current Delay Time value to 0 (milliseconds).

**Channel**

- **Left (0)** – Applies the specified Delay Time to Left input (channel 0)
- **Right (1)** – Applies the specified Delay Time to Right input (channel 1)

**Assign Time to Preset**

The internal delay feature stores five “preset” values. These Delay Presets (not to be confused with System Presets) are user-definable. Preset values are assigned to Function keys [F6] -[F10] (the [F] key resets the Delay Time to 0). To assign the current Delay Time to a Preset key, simply click one of the five buttons labeled F6 - F10. The value shown in the Delay Time field will then replace the contents of the selected Preset register in the Presets area below.

**Presets**

The five Preset registers display the delay time values currently stores as Presets. These Preset fields are directly editable or can be assigned the current Delay Time value by clicking the corresponding Assign Time to Preset button.

**Delay Spinner Increment**

The Delay Spinner Increment field sets the “nudge” increment by which the delay spinner (see below) changes the current delay time. Allowable values are 0.01 to 100 milliseconds in 0.01 millisecond increments.

![Delay Control](image)

When you exit the Options dialog box after changing delay settings, the specified Delay Time value are displayed in the Delay control that appears below the input level meters. The spinner (up/down) buttons to the left of the delay readout can also be used to change the current delay time value by the increment specified in the Delay Spinner Increment field (see above).
Devices

Options Menu > Devices

If your computer has more than one sound card and/or MIDI I/O device (or driver set) installed, the Device tab of the Options menu allows you to select which of these SmaartLive should use.

Wave and MIDI Device Selection

- **Wave In** — Selects the device to be used for audio input.
- **Wave Out** — Selects the device to be used for audio output from SmaartLive’s internal signal generator.
- **MIDI In** — Selects the device to be used for receiving MIDI data
- **MIDI Out** — Selects the device to use when sending MIDI data

Additional options appear below the device selection fields that affect how SmaartLive addresses the selected Wave-In device and allow System Presets to be selected remotely via MIDI.

Sampling Resolution (Wave-In/Wave-Out Bits per Sample)

Due to a limitation in Windows, SmaartLive is unable to automatically detect the sampling resolution of analog-to-digital (A/D) and digital-to-analog (D/A) converters with greater-than-16-bit resolution. If you are using a the internal sound chip in a notebook computer or comparable 16-bit device as your input stage for SmaartLive, you won’t have to worry much about this setting. But if your sound hardware is capable of sampling resolution(s) greater than 16 bits per sample, you will need to tell SmaartLive the sampling resolution of the selected Wave-In and Wave-Out devices by selecting the appropriate number of bits per sample from the drop-down list.

Advanced Settings

Clicking the Advanced button on the Devices tab opens a second dialog box that allows you to select the sampling rates and resolutions SmaartLive polls for when opening a wave device. If the driver for your input device supports sampling rate conversion as almost all do, the device will usually report back that all of these rates and resolutions are supported every time.

So if, for example, you are using a 16-bit device, you might want uncheck the all boxes for 18 - 24 in the Input Bits and Output Bits sections to prevent these options from
appearing in the Wave In and Wave Out Bit per Sample lists. You may also want to remove some of the sampling rate options to shorten the lists of available sampling rates elsewhere in SmaartLive or add 96k as an option if your input device supports it. You can also specify a custom sampling rate of your own in the Other field. Note that sampling rate conversion actually works quite well in many cases, provided you have the sampling rate conversion control for your input device set to highest quality setting in the Windows MultiMedia or Sounds and Multimedia control panel.

**Additional Device Options**

- **Slow Computer** — Selecting this option forces SmaartLive to check the user interface more often and may improve overall interface responsiveness on slower machines. The trade-off is that it may also reduce the update speed of the display to some extent.

- **Close Wave-In On Reset** — This option is intended as a work-around for a fairly rare problem encountered in a small number of sound card drivers. You should check this box only if you experience problems receiving audio data after changing display modes or input parameters. SmaartLive normally does not close the sound card driver when resetting Wave-In parameters during a session. In most cases, this will not present a problem and it does prevent “pops” and gaps in internally generated output signals that occur when the device driver is closed and reopened. We have, however, encountered a few drivers that will reset properly only if the driver is actually closed and reopened and in general, we have found this to be the most “bullet-proof” way of accessing sound hardware.

- **Use Old Wave Format** — This option is included to provide compatibility for audio device drivers that do not properly support the updated Windows audio API calls introduced in Windows 98SE and should normally be left unchecked unless you experience a problem with your input device. When running under Windows 98SE, ME, 2000 or XP SmaartLive normally uses the most current Windows API calls for accessing audio input and output devices. In some cases use of the newer API calls can cause the input device to behave erratically, particularly older hardware and some newer 16-bit devices. Checking the Use Old Wave Format box should correct the problem when this is the case. Note that this will also limit available sampling resolutions to 16 bits per sample under Windows 98SE, ME, 2000 and XP.
**Chapter 4: SmaartLive Commands**

- **Receive MIDI Program Changes on Channel** — This option allows you to recall SmaartLive System Presets remotely using another computer or other device that can send MIDI program changes. When this box is selected, SmaartLive will “listen” for MIDI program changes on the MIDI channel specified in the field immediately to the right. When a program change is received, the System Preset corresponding to the MIDI program number will be loaded automatically.

**Graph**

*Options Menu > Graph*

**Title**

This field sets the graph title displayed above the plot in all SmaartLive display modes.

**Y-Range**

The two text fields in the Y-Range section set the range of either the RTA or Transfer Function mode plot, depending on which mode you are in when you open the dialog box.

- **(RTA or Transfer) Min.** — Sets the low end (in decibels) of the displayed amplitude (y-axis) range of the (RTA or Transfer Function mode) plot.

- **(RTA or Transfer) Max.** — Sets the high end (in decibels) of the displayed amplitude (y-axis) range of the (RTA or Transfer Function mode) plot.

Note: the y-axis range of both the RTA and Transfer Function mode plots can also be changed using the Amplitude Range keyboard shortcuts or menu commands in the View menu.

**Phase Y-Range**

The two text fields in the Phase Y-Range section may be used to set the vertical (y-axis) range of the “unwrapped” phase display (only) if the Unwrap check box is checked. Note that checking the Unwrap box has the same affect as selecting the Unwrap command in the Phase Display Properties section of the Transfer Function menu.

**Move Increment**

- **Y+/-** — specifies the amount by which the Shift Active Trace and Shift Reference Trace commands (and the dB +/— spinner that appears to the right of the plot in RTA and Transfer Function modes) change the vertical offset of the traces.
• **RTA Zoom** — specifies the amount by which the Amplitude Range keyboard and menu commands (available from the View menu) change the scale and range of vertical (y) axis in Spectrum mode displays.

• **Transfer Zoom** — specifies the amount by which the Amplitude Range keyboard and menu commands (available from the View menu) change the scale and range of vertical (y) axis in of the plot in Transfer Function mode.

**Octave Bars**

The following options control how data bars on the octave- and fractional octave-band bar graphs are displayed on the RTA display in Spectrum mode.

• **Outline** — This option plots RTA data bars as outlines only. Outline data bars are not as easy to see as solid or 3-D bars but do allow you to see the magnitude values both channels at the same time.

• **Solid** — RTA data bars are displayed as solid (filled) rectangles when this box is checked.

• **3D** — Selecting this option adds highlights and shadows to the edges of solid data bars to give the bars a three-dimensional appearance.

**Additional Options**

• **Show Piano in Note ID mode** — If this box is checked, SmaartLive will display the image of a piano keyboard at the bottom of the plot area when Note ID is turned on in Transfer Function mode and also in Spectrum mode when the RTA graph is the primary display. The piano keyboard is sized and positioned so that the Note ID cursor will point to the corresponding key on the keyboard when the mouse cursor is anywhere in the frequency range of approximately 16 Hz to 5 kHz.

• **Show Noise Criterion Curves** — Checking this box displays standard Noise Criterion (NC) curves on the RTA display in Spectrum mode but does not invoke the special Noise Criterion Mode trace type that you get when you select the Noise Criterion Mode command in the Spectrum menu. Please note that NC measurements are valid only when SmaartLive is calibrated to SPL and that since the NC curves themselves all fall within the range of +8 to +80 dB, they are normally only visible when the display is calibrated to SPL.
Chapter 4: SmaartLive Commands

- **Clear Reference Comment After Capturing** — When capturing a new reference trace into a register containing an existing trace, any existing comment text will be cleared if this option is enabled. When this box is un-checked, capturing a new reference trace over an old one leaves the existing comment in place but highlights the entire comment so that it will be immediately deleted if you start typing.

- **Show Phase as Group Delay** — This option has the same effect as the Show Phase as Group Delay command in the Phase Display Properties section of the Transfer Function menu. When selected, the Phase display in Transfer Function mode plots phase as deviation from minimum group delay (in milliseconds) for each frequency, rather than phase shift by frequency (in degrees). Note that this option tends to work best when the incoming data is extremely well behaved and so may be more appropriate for electronic measurements than acoustic measurements.

- **Allow Narrowband RTA** — When this box is checked, two additional option (Log and Lin) will appear in the Scale spinner in Spectrum mode. Selecting the either of these options will plot the FFT data from each trace point by point as a “fever chart” (with logarithmic or linear frequency scaling respectively) rather than as an octave or fractional octave bar graph.

- **Have Cursor Track Trace** — When this option is selected, the tracking cursor “snaps” to the top trace on the plot (in all display modes except Spectrograph), moving from data point to data point along the trace as you move the mouse cursor from left to right. Note that checking this box has the same affect as selecting the Track Nearest Data Point command in the Cursor section of the View menu.

- **Quarter Height Coherence** — This option reduced the height of the Live Coherence Trace in Transfer Function mode to use only the top 1/4 of the Magnitude graph rather than the entire top half of the Graph.
Impulse/Locator

Options Menu > Locator

The Locator tab of the Options dialog box controls parameters associated with Impulse mode and the automatic delay locator feature.

FFT Options

The controls in the FFT Options section set input parameters for both the Small and Large preset time windows used in both Delay Auto-Locator and Impulse mode (impulse response) measurements. The Auto Small, Auto Large, and Impulse Mode radio buttons set the focus of all the other controls in this section so that one set of controls may be used to set parameters for all three functions.

- **Auto Small** — Selecting the Small radio button sets the focus of the rest of the controls in the FFT Options section to apply to the Small time window preset.

- **Auto Large** — Selecting this radio button sets the focus of the rest of the controls in the FFT Options section to apply to the Large time window preset.

- **Impulse Mode** — Selecting this radio button sets the focus of the rest of the controls in the FFT Options section to apply only to Impulse mode measurements. Note that in Impulse mode, these parameters may also be set using on-screen controls (see *Impulse Mode Measurement Parameters* on page 39 for details).

- **Averages** — The number of FFT frames to record for the selected measurement type (as selected above). When a value of more than 1 is specified, the impulse recorder collects and processes the specified number of frames then averages the results together. The principal reason for doing this is noise rejection — every doubling of the number of averages increases the signal-to-noise ratio for the measurement by 3 dB (down to the actual noise floor of the system under test or the measurement system, whichever is higher).

- **FFT (size)** — The number of samples to collect from the sound card inputs for use in the Fast Fourier Transform (FFT) calculations for the selected measurement type.
• **Overlap** — Setting this value to a number greater than zero causes SmaartLive’s impulse recorder to use overlapping, rather than contiguous time domain data to calculate multiple FFTs. This is particularly useful in measurements where you need to use a large FFT size and/or a high number of averages because it can drastically reduce the amount of data required, and therefore, the time required to collect the data without increasing the noise component of the measurement.

• **Sampling rate** — This value (given in samples per second) determines the frequency content of the impulse response measurement. For full-range measurements you should use the 44.1k or greater sampling rate because the highest frequency attainable in the measurement will be equal to one half of the sampling rate used (the Nyquist frequency).

• **FFT Time Constant** — The FFT time constant is the time window of the measurement. This is value, given in milliseconds, is not directly editable as it is a function of the selected FFT size and sampling rate. To obtain a solid impulse response measurement, the value shown should be large compared to the decay time of the system under test.

**Delay**

The single most common operator error associated with impulse response measurements in early versions of SIA-Smaart was forgetting to reset the internal signal delay to zero before making a new measurement. This problem could trip up even the most experienced user and so SmaartLive offers the following options to help prevent it.

• **Warn if Delay Not 0** — When this option is selected you will receive a warning message when you attempt to run the impulse recorder with the delay set to any value other than 0.00 ms. You will have the option of continuing anyway, setting the delay to zero and continuing, or canceling the measurement.

• **Always Set Delay To 0** — With this option selected, the program will automatically set the current delay to 0.00 ms (without asking) each time you run the impulse recorder routine to make a new measurement.

• **Don’t Warn, Don’t Set To 0** — When this option is selected the program does not check the delay time before running the impulse recorder routine. Whether the delay time is set to zero or not, you will receive no warning message and the current delay setting will not be changed.
Additional Options

- **Shift 0 to show negative time** — When repeating the impulse recorder calculations after setting the delay time, the first half of the selected peak is normally “wrapped around” and displayed at the end of the trace. Enabling this option “moves” a small segment of data back to the beginning of the trace so that the entire peak structure may be viewed in one piece. There is a slight decrease in the signal-to-noise ratio associated with this procedure but not enough to affect most applications.

- **Flip Inputs** — Selecting this option transposes (flips) the two input signals for the purposes of Impulse mode measurements. The notation “[Flip]” will appear in the upper right corner of the Impulse mode plot when this feature is turned on to indicate that the inputs are flipped. If you run SmaartLive in Impulse mode and get a plot with the largest peak near the right side of the trace — appearing to indicate an impossibly long delay time — selecting this option and running the impulse recorder again may correct the problem.

- **Locate Peak Automatically** — When this option is selected, SmaartLive automatically sets its Locked Cursor to the highest peak found in an impulse response immediately upon completing a measurement. The highest peak in the impulse will normally correspond to the total propagation delay through the system under test so this function is useful in locating delay times. The option is enabled by default.

- **Use Data Window for Asynchronous Stimuli** — When this option is selected SmaartLive applies a flat top window to incoming data for impulse response data in the time domain, before performing the FFT and Transfer Function calculations. Data Window functions are used to mitigate truncation errors associated with the use of random stimuli in FFT analysis. Note that this step is theoretically unnecessary when synchronous stimulus signals are used so SmaartLive automatically suspends data windowing in both Transfer Function and Impulse modes when using the Internal Signal Generator with one of the four synchronous stimulus options.

**Distance Units**

SmaartLive displays delay time values in both time and distance units. The Cursor Units selection determines whether the distance equivalent for time values is given in units of feet or meters.
**Temperature Units**

Since temperature is the single biggest factor that affects the speed of sound, SmaartLive allows you to set it’s internal Speed of Sound, used in calculating distance equivalents for delay times, using either temperature or feet/meters per second. This section simply sets the unit type for temperature to Fahrenheit or Celsius.

**Speed Of Sound**

This section sets the value SmaartLive uses to compute the distance equivalents for time values that appear on the cursor readout in Impulse mode, the delay auto-locator, and the readout for the internal signal delay. This value may be set directly, in feet or meters per second (depending on which is selected in the Distance Units section (see above), or by temperature. The temperature and speed fields are linked together so that when you change the temperature the value in the speed field is automatically recalculated to match and vice versa. The default value SmaartLive uses is 1127.4 feet per second (343.6 meters per second), the speed of sound at 68° Fahrenheit or 20° Celsius.

**Input**

Options Menu > Input

The Input tab of the Options dialog box allows you to set several options that affect SmaartLive’s input parameters for the three real-time measurement modes (RTA, Transfer Function, and Spectrograph). Note that many of the parameters on this tab are mode-specific, affecting only the measurement mode currently selected and that most are also available through the FFT Parameters control and other on-screen controls. Also note that input parameters for Impulse mode and the automatic delay locator are set separately on the Impulse/Locator tab of the Options dialog box.

The controls in the upper section of the Input options tab set the primary input parameters for the current display mode (only) as follows:

- **SR** — This field sets the sampling rate for the current display mode. SmaartLive will attempt to list all available sampling rates supported by both the program and your computer’s sound hardware.

- **FFT** — This list field selects the FFT frame size used to create the real-time analyzer’s frequency domain displays. In Transfer Function mode (only) an additional option labeled “FPPO” is available for the fixed resolution per octave display.
• **(Data) Window** — This field sets the type of Data Window function used in Spectrum mode measurements. The Data Window used for the Transfer Function mode calculations is fixed and cannot be changed.

• **FR (Frequency Resolution)** — SmaartLive automatically calculates the frequency resolution for the selected FFT size at the selected sampling rate. The FR value is not directly editable.

**Inputs**

The controls in this section affect the appearance and behavior of live traces. There are two sets of identical controls that allow you to specify options for each trace individually in RTA and Spectrograph modes. When this dialog page is opened in Transfer Function mode only one set of controls is enabled and with the exception of the Y+/- value, all settings selected will apply to both the standard and time windowed transfer function traces in Transfer Function mode.

• **Label** — The two Label fields appear in only in RTA and Spectrograph modes set the text labels on the Show/Hide buttons for the two analog inputs. These buttons appear below the input level meters in the main program window and are replaced by a single button that combines the two analog input labels in Transfer Function mode.

• **Y+/-** — This value controls the trace’s vertical offset, literally moving it up and down on the plot.

• **Average** — These fields set the number of (FIFO) averages or type of Averaging used for the incoming data in the current main display mode (Spectrum or Transfer Function). Please refer to Spectrum Mode Overview on page 14 and (Transfer Function) Averaging and Smoothing on page 32.

• **Half Life** — This value, specified in seconds, sets the half life for the user-configurable exponential averaging routine. Note that two additional exponential averaging options with fixed half-lives are also available to provide correlation in RTA measurements with the Fast and Slow time integration options in standard sound level meters. Also not that this field is enabled only when the Exp option is selected in the Average field above.
• **Avg Type** — This parameter appears only in Transfer Function mode and selects whether RMS or Vector averaging is used for Transfer Function measurements. This setting affects the type of data going into the averaging routines, rather than how averages are calculated so it is completely independent of the other averaging parameters discussed above.

**Printing**

*Options Menu > Printing*

The Printing tab of the Options dialog box controls the appearance and content of pages printed directly from SmaartLive. Allows you to add text to print-outs of SmaartLive plots and graphs. Up to three lines of title text can be included in the Header section of the printed page above the graph. Two lines of user-specified footer text can be added at the bottom of the page along with the date and user name. Note that the text comments attached to any reference traces displayed on the SmaartLive at the time of printing (or print preview) will also appear immediately below the plot on the printed page.

**Header**

• **Title (1, 2, and 3)** — You can specify up to three lines of title text to appear in the header section at the top SmaartLive print-outs. If any of the three Title fields is left blank, that line is omitted on the printed page.

**Footer**

• **Note (1 and 2)** — You can specify up to two lines of footer text to appear at the bottom SmaartLive print-outs. If either of the Note fields is left blank, that line is omitted on the printed page.

• **Print Today’s Date** — If this box is checked, the current date (as set on your computer) will be inserted in the title area at the top of the printout. If you want to use a date other than the current system date of your computer on the printout, un-check this box and type the desired date as one of the Title lines.

*Note:* In addition to the note and date lines as specified in the Footer section above, SmaartLive print-outs will also include a final footer line with the notation “Created by (User Name) using SIA Smaart.” The User Name will be the name of the user to whom this copy of SmaartLive is registered. This line cannot be edited or omitted.
• **Show custom print dialog before print and print preview** — When this box is checked, selecting either the Print or Print Preview commands will open the Custom Print Information dialog box to allow you to set title text and other options for the printout before proceeding with the selected operation. The Custom Print Information dialog box includes all of the same options as the Printing tab of the Options dialog box. If you un-check this check box, SmaartLive will bypass the Custom Print Information dialog box in Print and Print Preview operations and execute the selected command immediately.

**Spectrograph**

*Options Menu > Spectrograph*

The following options control the appearance and behavior of the SmaartLive real-time Spectrograph display in Spectrum mode.

**Y Range**

• **Min and Max Frequency** — Sets the overall Y-axis range of the Spectrograph plot. You can also set the frequency range of the Spectrograph using the Frequency Zoom presets however the +/- keys have a different function in Spectrograph mode (see note above) and the PageUp/PageDown keys do not affect on the Spectrograph plot.

**Narrowband Display Mode**

The following options apply only to how data is rendered on the Spectrograph when narrowband (Linear or Logarithmic) Frequency Scaling is selected in Spectrum mode. These two options basically represent two different ways of dealing with the fact that at typical FFT sizes, there are usually many more data points (also called bins) in the FFT than there are pixels on your screen.

• **Power Averaged** — When this option is selected, the power in all the FFT bins represented by each row of pixels in the Spectrograph at higher frequencies is averaged together. This is similar to how octave and fractional octave banding is done in SmaartLive and effectively gives you a very high resolution banded display that correlates well to human hearing.

• **Maximum Value** — This option simply pick the highest magnitude found in the range of FFT bins represented by a single pixel row of in the Spectrograph at high frequencies and renders this value on the display. This is the more conventional way
of dealing with the mismatch between screen resolution and FFT frequency resolution so this option provides better correlation between the Spectrograph and RTA displays when narrowband resolution is selected.

**Colors**

- **Min/Max (Dynamic Range)** — The Min and Max values set the magnitude range for the live Spectrograph in decibels. These settings are sensitive to display calibration so that when the internal Full Scale calibration is in use, magnitude values are specified as “dB down” from zero. When SmaartLive is calibrated to SPL (or other external reference) these values are automatically adjusted to reflect the calibration offset used however the range between the range between the Min and Max values will still be the same. Note that the dynamic range of the Spectrograph display may also be changed using the Amplitude Range commands in the View menu.

- **Number** — Selects the number of colors to use in the Spectrograph plot (from 8 to 236 depending on your display hardware and drivers). This setting, along with the Dynamic Range also determines the number of decibels represented by each color.

- **Gray** — Plots the Spectrograph using shades of gray rather than colors. This option is useful for monochrome displays or for printing purposes.

- **Min** — Selects the color used to represent the minimum magnitude value(s) shown on the Spectrograph plot. Clicking the colored square opens a standard Windows Color dialog box enabling you to choose a different color for lowest the value(s).

- **Max** — Selects the color used to represent the maximum magnitude values shown on the Spectrograph plot. Clicking on the colored square opens a standard Windows Color dialog box enabling you to choose a different color for the highest value(s).

- **Default** — The Default button resets the Min and Max color selections to the program defaults.

**Frames to show in Spectrograph** — This field sets the number of FFT frames (vertical color bars) to be included in the live Spectrograph display. Together with the FFT frame size and the sampling rate selected, this setting also determines the effective time range of the live Spectrograph plot.
SPL History

Options Menu > SPL History

The following options control the appearance and behavior of the SmaartLive real-time SPL History display in Spectrum mode.

Y Range

- **Min/Max (Dynamic Range)** — The Min and Max values set the magnitude range for the SPL History display in decibels. These settings are sensitive to display calibration so that when the internal Full Scale calibration is in use, magnitude values are specified as “dB down” from zero. When SmaartLive is calibrated to SPL (or other external reference) these values are automatically adjusted to reflect the calibration offset used however the range between the range between the Min and Max values will still be the same. Not that the dynamic range of the SPL History display may also be changed using the Amplitude Range commands in the View menu.

Display Type

- **Solid** — When this option is selected, the SPL History display is plotted as a solid histogram.

- **Line Plot** — This option sets the SPL History display to a fever chart style line trace, rather than a solid, filled histogram display

Frames to show in Spectrograph — This field sets the number of FFT frames (vertical color bars) to be included in the live Spectrograph display. Together with the FFT frame size and the sampling rate selected, this setting also determines the effective time range of the live Spectrograph plot.
Zooms

Options Menu > Zooms

The Zoom tab of the Options dialog box allows you to specify a frequency range for each of the four preset Frequency Range Presets (also called Frequency Zooms in earlier versions of Smaart). Note that where applicable, when two graphs are displayed in Spectrum or Transfer Function mode, Frequency Range Presets are applied to both graphs when recalled.

Zoom 1, 2, 3 and 4

- **MIN** — Sets the lowest frequency displayed when the corresponding Frequency Range Preset is selected.

- **MAX** — Sets the highest frequency to display. Entering the word “Nyquist” in this field automatically sets the MAX frequency to the highest frequency obtainable, given the sampling rate selected at any given time (Nyquist Frequency (Hz.) = Sampling Rate ÷ 2).

Link Frequency Range Controls

- **Spectrograph Tracks RTA Display** — When this option is selected (as it is, by default) the frequency ranges of the Spectrum mode RTA and Spectrograph displays are tied together so that changing one also changes the other whether they are displayed together or separately. Un-checking this option allows the frequency ranges of the two graphs to be set independently of each other.

- **Transfer Function Phase Track Magnitude** — This option is analogous to the one above but links the frequency ranges of the Transfer Function mode Magnitude and Phase displays. This option is also enabled by default. Un-checking this box allows the frequency ranges of the Magnitude and Phase graphs to be set independently of each other in Transfer Function mode.
Clock

Options Menu > Clock

This command opens the Clock Options dialog box to allow you to set options for the clock display that appears in the upper left corner of the SmaartLive program window. The following options for SmaartLive’s clock display are user-definable:

- **Show Current Time** — With this option selected, the clock display functions as a normal clock, showing the current time according to your computer’s system clock.

- **Count Down To** — When this option is selected, the clock will function as a countdown timer showing the time remaining before the time set in the field immediately to the right.

- **Count Up From** — With this option selected, the clock shows elapsed time since the time set in the field immediately to the right.

**Show**

- **Seconds** — When this box is checked, the clock will show seconds as well as hours and minutes. Note that this will reduce the text size in the clock display.

- **24 Hour** — Changes the clock display to a 24-hour clock (instead of 12).

- **AM/PM** — When this box is selected, the default 12-hour clock will include an AM or PM notation after the hour. Note that this will also reduce the clock’s text size.

**Time Average/LEQ Setup**

The Time Average/LEQ Setup button at the bottom of the Clock Options dialog box is just a shortcut to the Time Average/LEQ Setup dialog box where you can access features for measuring spectral and sound level data over time.
External Devices

Options Menu > External Devices

This command calls the External Device Information dialog box. This dialog allows you to add, configure and edit “external device definitions” for supported, remotely controllable equalizers, system processors and other devices.

Configured Device List

The upper section of the External Device Information dialog lists any devices you may already have configured by the Name you assigned to the device, the device type (manufacturer and model number), the I/O port (e.g., COM or MIDI) assigned to communicate with the device and the current device configuration (e.g., mono, stereo or 3-way) if applicable. To the left of the device list is a window that shows you the internal names assigned in SmaartLive for individual input and output channels on a device the selected in the list on the left, along with the names of any SmaartLive System Presets that may be configured to recall this device channel.

Adding, Removing and Configuring Device Definitions

- **Add** — Clicking the Add button in the lower portion of the External Device Information dialog pops up a dialog box listing all the available external device drivers present in the Devices folder in your main SmaartLive program folder. SmaartLive scans this folder every time it starts up so when you add new driver files to this folder, they will be present in this list the next time you run the program.

- **Edit** — Opens the Configuration dialog box for a device selected in the list above to allow you to make changes to Device and Channel names, I/O port assignment, and other device properties.

- **Remove** — Removes a configured external device definition selected in the list above.

- **Remove All** — Removes all currently configured external device definitions.

- **Close** — Closes the External Device Information dialog box.

- **Add to Device Bar** — Opens a dialog box that allows you to assign input or output channels on the selected device to buttons on the SmaartLive Device Bar (see Device Bar on page 134 for more information).
Signal Generator
Options Menu > Signal Generator

This command opens Generate Options dialog box to allow you to set up parameters for SmaartLive’s internal signal generator. The signal generator controls are fairly simple but the available options will differ depending on the selected signal type.

- **Generator On** — The Generator On check box immediately to the right of the Signal list box in the Generate Options dialog box simply turns the generator on or off. Note that this control does the same thing as the Gen button on the on-screen Generator control (shown above).

- **Signal** — The signal type for the internal signal generator is selected from the drop down Signal list in the Generate Options dialog box. The available signal types fall into two basic categories and are discussed below.

### Random and Asynchronous Signals

The first four signal type options in the Signal list can be considered random and/or asynchronous because no attempt is made to synchronize these stimulus types to other SmaartLive measurement parameters.

- **Pink Noise** — If this option is selected, SmaartLive outputs asynchronous pseudo-random noise, spectrally shaped to roll off at a rate of 3 dB per octave so that the spectrum of the signal will appear flat when viewed on an octave or fractional octave RTA display. Selecting Pink Noise enables the Level1 spinner in the Generate Options which sets the output signal level.

- **Sine Wave** — Selecting Sine Wave also enables the Level1 spinner along with the Freq1 control which sets the sine wave frequency. You can type a sine wave frequency (in Hertz) in the Freq1 field then press the [Enter] key to apply it or use the slider control immediately to the right to sweep the sine wave frequency from 20 Hz up to the Nyquist frequency for the current sampling rate.

- **Dual Sine** — This option creates an output a signal consisting of two sine waves when the generator is turned on. Both the frequency and level for each of the two
sine waves is independently variable so selecting Dual Sine as the signal type enables both sets of level (Level1 and Level2) and frequency (Freq1 and Freq2) controls. Note that selecting this option also disables the output level spinner in the on-screen Generator control so you may want to keep the Generate Options dialog open when working with the Dual-Sine signal type.

- **File Loop** — Selecting File Loop as the signal type enables the File field and Browse button in the lower portion of the Generate Options dialog box. The Browse button to opens a standard Windows Open file dialog box, allows you to navigate to the drive and directory (folder) containing the file you want to use as your test signal. You can also simply type the entire path to the file you want to use in the File field if you prefer. The amplitude and frequency content of a file loop test signal are determined by the source wave file and so the and all the level and frequency controls are disabled when this signal type is selected.

**Synchronous Signal Types**

The last four options in the Signal list are considered synchronous signal type because they consist of repeating sequences whose length precisely matches the time constant of the FFT size and sampling rates selected in your measurement input parameters. An oddity of FFT analysis is that the FFT calculation assumes it is seeing a finite piece of an infinitely repeating sequence. Without getting too far into the details, let it suffice to say that this assumption leads to “truncation errors” which introduce unwanted artifacts into your measurement when random/asynchronous stimulus signals are used.

There are two common ways around this problem. One is to use a data window function to reduce the amplitude of the data closest to the beginning and end of each “frame” of time-domain before performing the FFT. The other option is to use a stimulus signal that actually does repeat exactly at a rate that is matched to the FFT time constant. This is what the synchronous signal types do. SmaartLive offers two basic synchronous stimulus types, pseudorandom noise and logarithmic sweeps. There are two spectral shaping options available for stimulus type, making a total of four options.

- **Sync Pink** — Synchronous pseudorandom noise with a “pink” frequency spectrum that rolls off at a rate of 3 dB per octave. This signal will appear flat when viewed on an octave or fractional octave RTA display.
• **Sync Red** — Synchronous pseudorandom noise with a “red” spectrum. Red noise is similar in concept to pink noise but rolls off at a higher rate as the frequency increases. This signal type is therefore unsuitable for simple RTA analysis but still has plenty of high-frequency for Transfer Function and Impulse response measurements and is much easier on your ears than pink noise if you have to listen to it for any length of time.

• **Pink Sweep** — A synchronous logarithmic sinusoidal sweep (also called a swept sine wave) with a pink spectrum. This signal will appear flat when viewed on an octave or fractional octave RTA display, even though it changes over time. This is because the entire sweep sequence takes place within the confines of a single FFT frame and one complete sweep contains equal amounts of energy for all frequencies (logarithmically speaking) within that time frame.

• **Red Sweep** — A synchronous logarithmic sinusoidal sweep with a “red” spectrum. As is the case with red noise (see above), the red sweep has a roll-off rate that makes it unsuitable for Spectrum mode measurements but it is an excellent stimulus source for Transfer Function and Impulse measurements and is kinder to both your ears and high-frequency components in the system under test than the Pink Sweep option.

Note that because the Fixed Points Per Octave (FPPO) transfer function option in SmaartLive uses multiple FFTs with multiple time constants, synchronous stimulus options are not available in Transfer Function mode when FPPO is selected. Also note that because data windowing is neither necessary nor desirable for FFT analysis using synchronous stimuli, data windowing is suspended in all cases when the Signal Generator is running with a synchronous signal type selected.
Chapter 4: SmaartLive Commands

**SPL**

Options Menu > SPL

The SPL command opens the Signal Level/SPL Readout Options dialog box. This dialog box sets parameters and calibration options for the Signal Level/SPL Readout. Note that calibration for Signal Level/SPL Readout also applies to SmaartLive’s RTA display in Spectrum mode. Also note that several of these same options may be set from the Inputs tab of the Options dialog box.

**SPL**

The controls in the SPL section determine how the signal level/SPL values are displayed. Remember that *SPL values in SmaartLive values will be accurate only if the RTA display is calibrated to SPL.*

- **Weight** — Sets the weighting curve to be used in the SPL calculations. The options are A-weighted, C-Weighted, or Flat (no weighting). Note that user-defined weighting curves are not available for SPL weighting.

- **Speed** — This field sets the integration time for the SPL display. The available options are Fast, Slow, or Instantaneous (Inst). The instantaneous option simply shows you the unintegrated SPL value of each FFT frame. Instantaneous is a non-standard option that is not the same as the “Impulse” option available on some sound level meters (SLMs) but should give you something very close to the same answer in most cases. When the Fast or Slow options are selected, SmaartLive uses an exponential SPL averaging routines that model the timing characteristics of Fast and Slow time integration circuits in standard SLMs as closely as possible, (given the current input parameters and processing speed of your computer).

- **Calibrate Using Peak** — When you click this button, SmaartLive will automatically find the highest peak in the spectrum of the active input on the RTA display in Spectrum mode and pop up a small dialog box that allows you to specify a decibel value for the peak magnitude. This feature is most commonly used in conjunction with an acoustic microphone calibrator when calibrating SmaartLive to SPL. See
Chapter 4: SmaartLive Commands

Calibrating to SPL for more information. Note that the Calibrate Using Peak button is enabled only when SmaartLive is in Spectrum mode with the RTA display on.

- **Full Scale Calibration** — Clicking this button resets SmaartLive to its default Full Scale calibration scheme. Full scale calibration regards the maximum output of the A/D converter on the selected Wave-In device as zero dB and with all other magnitude values given as dB down from zero.

**Peak Hold**

The following options are available only for Full Scale calibration and are disabled when SmaartLive is calibrated to SPL (or other external reference).

- **Show Peak In Readout** — When this box is checked, the value displayed in the SPL readout above the input level meters is based on the peak level indicator on the channel being monitored for SPL, rather than the current meter value.

- **Hold Peak For** — Specifies the length of time (in seconds) the peak level indicators on the input level meters (and the Signal Level/SPL readout if Show Peak in Readout is checked) hold the most recent peak levels encountered in the inputs signals.

**Alarms 1 and 2**

The controls in this section set parameters for the two user-definable SPL Alarms. Alarm levels are used by both the Signal Level/SPL Readout and the SPL History display in Spectrum mode. On the SPL display the plot color changes to the corresponding Alarm color when SPL exceeds the dB value specified for either alarm. Similarly, the background of the SPL Readout changes to the corresponding Alarm color if either alarm level is exceeded for the specified Duration time and will blink when this threshold is crossed if the “Blink if Exceeded” check box for that alarm is checked.

**SPL Log to File**

This controls in this section set up parameters for simple SPL logging. Note that more advanced sound level and spectral logging features are available through the Time Average/LEQ feature. Also not that entering impulse mode will temporarily suspend SPL logging when active, because SmaartLive reverts to Full Scale calibration in Impulse mode.

- **Interval** — This parameter, specified in seconds, sets the interval at which SPL is sampled for the log file.
• **Logging Enabled** — SPL Logging is enabled when this box is checked. Note that an output file must also be designated before logging can commence.

• **File** — This field is used to specify the output file for SPL Logging. SmaartLive SPL Log files are tab-delimited ASCII text file suitable for import into a spreadsheet or other application. Each entry in the file is stamped with the time and date of the entry in addition to the decibel value, and the weighting and time integration types in use when the entry was sampled.

**Time Average/LEQ Setup**

The Time Average/LEQ Setup button at the bottom of the Signal Level/SPL Readout dialog box is just a shortcut to the Time Average/LEQ Setup dialog box where you can access additional features for measuring spectral and sound level data over time.

**System Presets**

*Options Menu > System Presets*

The Options menu System Presets command opens the System Presets dialog box allowing you to save, load, browse, and edit SmaartLive program settings stored in any of up to 100 System Presets (macros).

• **Number** — the Number selector at the top of the System Presets dialog box is used to select which preset you want to view or edit. You can use the spinner buttons to browse through the stored presets or simply type the number in the field and press the [Enter] key on your keyboard to go directly to a specific preset number.

• **Warn Before Loading** — If this box is checked, SmaartLive will pop up a warning message (as a safety precaution) before loading the selected Preset.

• **Label** — This field is used to assign a name to the selected preset. The label text entered in this field will appear in the title field the main SmaartLive plot when the selected preset is recalled.

**SR / FFT**

• **Mode** — A System Preset can store separate Sampling rate and FFT settings for each of the three real-time measurement modes. The Mode list box in the SR / FFT section sets the current focus of the SR and FFT controls immediately to its right.
• **SR** — Selects a sampling rate to be set for the selected Mode when the Preset is called. Selecting <Don’t Change> in this field will leave the current sampling rate for the selected display mode undisturbed.

• **FFT** — Selects an FFT size to be set for the selected Mode when the Preset is called.

**Delay Parameters**

• **Delay Time** — Stores a delay value to be set by SmaartLive’s internal signal delay when the Preset is called.

• **Delay Channel** — Selects the input channel to which the specified Delay Time will be applied.

**Run Mode**

SmaartLive will automatically switch to the operating mode selected in the Run Mode section of the dialog box when the selected preset is recalled. The options are Spectrum, Transfer Function, or Impulse mode.

• **Spectrum** — If this option is selected, SmaartLive will switch to Spectrum mode when this Preset is recalled. Additionally, you can select any two of the three main Spectrum mode display types (RTA, Spectrograph, or SPL History) to bring up at the same time.

• **Transfer Function** — Selecting this option will cause SmaartLive to switch to Transfer Function mode when the preset is recalled. The following additional display options can also be set at the same time:
  - **Phase** — Turns on the Transfer Function mode Phase display.
  - **Swapped** — Swaps the input channels for Transfer Function mode.
  - **Smoothing** — Sets the amount of smoothing to be used for the Transfer Function trace.

• **Impulse** — When the Impulse option is selected, recalling this preset will automatically switch SmaartLive to Impulse mode. No additional display options are associated with this option.
Trace Information

In this section, averaging options and Y-axis offset can be set for each of the two RTA display traces and the Transfer Function trace independently. The single set of controls is shared by all three traces so the three “radio buttons” on the left (RTA 0, RTA 1, and Transfer) are used to set the focus of the other controls.

MIDI Program Change

- **Send Program Change** — If this option is enabled, the act of loading the selected System Preset also sends a specified MIDI program change on the selected MIDI channel (see below). If you use a MIDI controllable mixer or switcher to control signals coming into the computer, you can set up System Presets for different microphones, EQs, etc., and switch between them with a single command.
- **Channel** — Selects the MIDI channel for the device to which you will send the program change.
- **Program** — Specifies the MIDI program to send on the selected channel.

External Device

The controls in the External Device section can be used to change the external device selection and set some additional options when the selected preset is recalled.

- **Device** — This field designates a configured external device to be selected when the selected preset is recalled. Selecting <Don’t Change> in this field will leave the device selection undisturbed
- **Channel** — External device selected above is a multi-channel device, this control selects the input or output channel you want to control.
- **External Device Mode** — Checking this box will automatically pop up the floating control panel for the selected external device when the preset is recalled.
- **Show EQ Filters Inverted** — Turns EQ filter indicators on the transfer function plot upside-down (normally used only when the Transfer Function inputs are swapped).
Volume Control

Options Menu > Volume Control

The Volume Control command in the Options menu is simply a shortcut to the Recording Control mixer in the standard Windows Volume Control utility. Most Windows-compatible sound hardware devices use this utility to control the input and output signals from various sources both inside and outside the computer.
**Chapter 4: SmartrLive Commands**

**Shortcuts**

**Analyzer Shortcuts**
Operating Mode
Impulse Mode = [I]
Spectrum Mode = [S]
Transfer Function Mode = [T]

**General Controls**
Generate Signal = [G]
Smartr On = [O]
Pause = [P]
Instantaneous = [Ctrl]+[I]
Auto-Locate Delay (Large) = [L]
Reseed Average Buffers = [V]
Load System Preset 1-10 = [Ctrl]+([1]+[10])
Save Settings to Preset 1-10 = [Ctrl]+[Shift]+([1]-[10])
Print = [Ctrl]+[P]
MIDI Program Change = [Ctrl]+[M]
Decrease Delay Time (0.01 ms) = [F3]
Increase Delay Time (0.01 ms) = [F4]
Clear Delay (Reset to 0 ms) = [F5]
Recall Stored Delay Time Preset = [F6]+[F10]

**Spectrum Mode Only**
Trace Difference = [Ctrl]+[F]
Noise Criterion (NC) mode = [Ctrl]+[N]
Reset SPL History Min/Max = [Ctrl]+[R]
Timed Average/LEQ Setup = [F12]

**Transfer Function Mode Only**
Phase Display = [F]
Coherence Function (on/off) = [H]
Subtract Reference Trace from Live Trace = [M]
Wrap/Unwrap Phase Display = [U]
Set Phase Range to -180 -> 180 = [Alt]+[Home]
Set Phase Range to 0 -> 360 = [Alt]+[End]
Swap/Un-Swap Transfer Function Inputs = [W]

**Range, Scale, and Zoom Shortcuts**
Quick Zoom = [Ctrl]+[Q]
Amplitude/Magnitude (y-axis) Range
Zoom Primary In (vertically) = [+=/=]
Zoom Primary Out = [Alt]+[-]
Move Primary Up = [Alt]+[PageUp]
Move Primary Down = [Alt]+[PageDown]
Zoom Secondary In (vertically) = [Alt]+[+=/=]
Zoom Secondary Out = [Alt]+[-]
Move Secondary Up = [Alt]+[PageUp]
Move Secondary Down = [Alt]+[PageDown]

**Frequency/Time (x-axis) Range**
Zoom Primary In = [Up Arrow]
Zoom Primary Out = [Down Arrow]
Move Primary Left = [Left Arrow]
Move Primary Right = [Right Arrow]
Zoom Secondary In = [Alt]+[Up Arrow]
Zoom Secondary Out = [Alt]+[Down Arrow]
Move Secondary Left = [Alt]+[Left Arrow]
Move Secondary Right = [Alt]+[Right Arrow]

**Frequency Zooms (Preset Frequency Ranges)**
Frequency (Zoom) Range 1 = [1]
Frequency (Zoom) Range 2 = [2]
Frequency (Zoom) Range 3 = [3]
Frequency (Zoom) Range 4 = [4]

**Spectrum Mode Frequency Scale**
Narrowband = [5]
1/24-Octave = [6]
1/12-Octave = [7]
1/6-Octave = [8]
1/3-Octave = [9]
Octave = [0]

**Trace Shortcuts**
Make Left Input (0) Active = [Shift]+[0]
Make Right Input (1) Active = [Shift]+[1]
Hide/Show Left Input (0) = [Alt]+[0]
Hide/Show Right Input (1) = [Alt]+[1]
Hide/Show Transfer Function = [Alt]+[2]
Time Windowed Transfer Function On/Off = [Alt]+[3]
Shift (active) Live Trace Up = [Ctrl]+[Up Arrow]
Shift (active) Live Trace Down = [Ctrl]+[Down Arrow]

**Reference Trace**
Capture to Active Register = [Space Bar]
Select/Show/Hide Reference Bank = [A, B, C, D, or E]
Capture to Selected Register in Bank = [Ctrl]+[A, B, C, D or E]
Select Next Register in Bank = [Shift]+[A, B, C, D or E]
Capture to Next Register in Bank = [Ctrl]+[Shift]+[A, B, C, D or E]
Chapter 4: SmaartLive Commands

Reference Information = [Alt]+[R]
Erase Current Reference Trace = [Ctrl]+[Delete]
Erase All Reference Traces = [Ctrl]+[Shift]+[Delete]
Shift Active Reference Trace Up = [Shift]+[Up Arrow]
Shift Active Reference Trace Down = [Shift]+[Down Arrow]
Save Active Reference Trace = [Ctrl]+[S]

External Device Shortcuts
Show/Hide Device Bar = [Ctrl]+[V]
External Device Mode = [X]
Flatten Selected filter = [Del]
Increase Boost = [Up arrow]
Decrease Boost = [Down arrow]
Increase Frequency = [Right arrow]
Decrease Frequency = [Left arrow]
Increase Bandwidth = [Shift]+[Right arrow]
Decrease Bandwidth = [Shift]+[Left arrow]
Select Next Filter = [Tab]
Select Previous Filter = [Shift]+[Tab]

External Device Mouse Shortcuts:
• Mouse Click on filter marker to select.
• Click and drag filter marker to change frequency and/or boost/cut.
• [Shift]+Click on plot sets nearest unused filter to mouse cursor location or creates new filter at mouse cursor position (depends on device type).

Impulse Mode Shortcuts
Impulse Mode = [I]
Open Impulse = [Ctrl]+[O]
Start/Stop Impulse Recorder = [R]
Assign Cursor Position to Delay = [Ctrl]+[Space Bar]
Assign Locked Cursor to Delay Preset = [Ctrl]+[F6-F10]

Impulse Mode Mouse Shortcuts
• Click and drag in thumbnail to zoom in on time axis.
• Click in left margin of plot to zoom out to full Time scale

Note: In Impulse mode, the Frequency Range commands also function as Time Zoom commands.

If Locked Cursor is present:
• [Shift]+Click on Impulse mode plot opens Delay Options, sets Delay Time to Locked Cursor position

If Locked Cursor is not present:
• [Shift]+mouse click on Impulse plot opens Delay Options, sets Delay Time to mouse cursor position

Cursor Shortcuts
Mouse Cursor
Track Nearest Data Point = [Ctrl]+[T]
Move left one data point = [Ctrl]+[Alt]+[Left Arrow]
Move right one data point = [Ctrl]+[Alt]+[Right Arrow]

Set/Remove Locked Cursor
Set at mouse cursor position = [Ctrl] + Click on plot
Set at highest peak on the front trace = [Shift]+[P]
Set at lowest point on the front trace = [Shift]+[L]
Remove Locked Cursor = [Ctrl]+[X] or [Ctrl]+Mouse click off plot

Move Locked Cursor
Move to mouse cursor position = [Ctrl]+Click on plot
Move to highest peak on the front trace = [Shift]+[P]
Move to lowest point on the front trace = [Shift]+[L]
Move to next point higher on trace = [Ctrl]+[Shift]+[P]
Move to next point lower on trace = [Ctrl]+[Shift]+[L]
Track Peak = [Ctrl]+[Shift]+[T]
Move one pixel to left = [Ctrl]+[Left Arrow]
Move one pixel to right = [Ctrl]+[Right Arrow]
Move one data point to left = [Ctrl]+[Shift]+[Left Arrow]
Move one data point to right = [Ctrl]+[Shift]+[Right Arrow]

Harmonics
Show Harmonics = [Ctrl]+[H]
Next Harmonic = [Shift]+[Right Arrow]
Previous Harmonic = [Shift]+[Right Arrow]

Options Menu Shortcuts
Options (All) = [Alt]+[O]
Device Options = [Alt]+[A]
Delay Options = [Alt]+[D]
Graph Options = [Alt]+[G] (or Click on Plot Title)
Input Options = [Alt]+[I]
Impulse/Locator Options = [Alt]+[L]
Preset Options = [Alt]+[P]
Volume (Recording) Control = [Alt]+[P]
External Device Information = [Alt]+[X]
Zoom Options = [Alt]+[Z]
Chapter 5: Basic Concepts and Terminology

This chapter is intended to present “real-world” definitions of some of the basic concepts and terminology used in SmaartLive. The definitions given here are accurate with regard to SmaartLive, but should not be considered comprehensive or mathematically complete. A list of reference titles is provided at the end of the chapter for those who wish to pursue a more in-depth understanding of these topics.

Basic Concepts

Averaging

When using test signals such as music or random noise in Fast Fourier Transform (FFT) measurement, it is often necessary to average the data over a number of FFT frames. That’s because random noise is just that. It does not have energy at all frequencies all of the time. By averaging a number of frames (effectively extending the amount of time you spend “looking at” each frequency), you increase the likelihood that the test signal will have enough energy at any given frequency to make a meaningful measurement.

SmaartLive uses arithmetic Root Mean Square (RMS) averaging, plotting a simple average for each data point using data from the specified number of previous FFT frames. All data used in the average is given equal weight. The number of frames you can include in the average ranges between 1 (no averaging) and 256 (each data point represents an average of the values for that point from the last 256 FFT frames).

Notes: As a general rule, try to select averaging parameters that allow reasonable measurements without taking too long to collect. Changing the number of averages clears the average buffers so it will take some time for the display to “resettle.”

Coherence

The SmaartLive Coherence display represents a complex mathematical function used to determine the linearity between two signals. In SmaartLive, the Coherence function is used to give you an idea of the “quality” of transfer function data for each point along the frequency axis.

The Coherence function yields a value of between 0 and 1 for each frequency. A value of 0 would indicate no coherence. A value of 1 would mean that there is perfect coherence between the two signals. Oddly, the coherence for any two FFT frames
measured using the same input parameters will always be a perfect 1. It is only when you average two signals over some period of time that nonlinearities appear so the Coherence features is disabled when the number of averages is set to 1. Also note that overall coherence tends to decrease as the number of averages is increased.

Examples of factors other than averaging that can adversely affect the coherence of transfer function data include delay between the two signals, insufficient energy in the reference signal at a given frequency to make a measurement, acoustical influences such as reflections, modes and reverberation, and ambient or electrical noise. Nonlinear processors such as compressors and limiters in the measurement signal path can also have a negative influence on coherence and should be bypassed for transfer function and impulse response measurements if possible.

**Data Window Functions**

*Data Window* functions help to reduce truncation errors arising from the segmenting of longer data series into FFT frames. Remember that the Fast Fourier Transform (FFT) requires a data series of finite length. What happened immediately before and after the FFT data series is unknown and so the calculation assumes the data series is infinitely repeating. This can lead to certain anomalies in the Fourier transform results.

All data windows types operate under the same basic principle. They “de-weight” the samples nearest to the beginning and end of the FFT data series to help reduce these truncation errors, or “edge effects.” The only real difference between different the Data Window types is the “shape” of the “window.” SmaartLive provides nine *Data Window* options including Hanning, Hamming, Blackman, Blackman-Harris, Parzen, Welch and Flat Top. The option labeled “None,” (i.e., no data window, also called a “rectangular” window), should probably be avoided for most applications.

**Decibels**

The decibel (dB) is a unit used to express the logarithmic ratio of two amounts of power, voltage or any two values. Typically decibels are used when the two values may differ over a very large range. The need for logarithmic scales in acoustics and audio is a result of the wide range of sensitivity to sound pressure and frequencies that makes up the range of human hearing. Most audio measurements based on voltage or sound pressure and are expressed in decibels. The power and voltage ratios shown in the table on the next page illustrate one reason why a logarithmic scale is needed.
Note that a 60 dB drop in the Power Ratio column represents a decay of *one million times* in terms of energy! A frequent point of confusion regarding decibels is that 0 dB can mean different things. For SmaartLive’s purposes, 0 dB means:

1. In a transfer function measurement, decibel values represent the *difference* between the *reference* and *measurement* input signals. When the energy in both input signals at a given frequency is the same, the transfer function is 0 dB at that frequency. At frequencies where the measurement signal has *more* energy than the reference signal, the transfer function will be a *positive* number of decibels. When the measurement signal has *less* energy, the value will be *negative*.

2. With respect to the input level meters and the default Full-Scale calibration scheme, 0 dB means the maximum possible output of the A/D converter on the selected input device. All other amplitude/magnitude values are given as “dB down” from this maximum.

Actually there is also a third possibility. You may be unlikely to encounter this value in making measurements under field conditions but there is such a thing as 0 dB SPL. The definition of the decibel as *ratio* makes all of these usages valid.

**Decibel Power and Voltage Ratio Table**

<table>
<thead>
<tr>
<th>Power Ratio</th>
<th>Decibels</th>
<th>Voltage Ratio</th>
<th>Decibels</th>
</tr>
</thead>
<tbody>
<tr>
<td>.1</td>
<td>-10</td>
<td>.1</td>
<td>-20</td>
</tr>
<tr>
<td>.5</td>
<td>-3</td>
<td>.5</td>
<td>-6</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
<td>20</td>
</tr>
<tr>
<td>100</td>
<td>20</td>
<td>100</td>
<td>40</td>
</tr>
<tr>
<td>1,000</td>
<td>30</td>
<td>1,000</td>
<td>60</td>
</tr>
<tr>
<td>10,000</td>
<td>40</td>
<td>10,000</td>
<td>80</td>
</tr>
<tr>
<td>100,000</td>
<td>50</td>
<td>100,000</td>
<td>100</td>
</tr>
<tr>
<td>1,000,000</td>
<td>60</td>
<td>1,000,000</td>
<td>120</td>
</tr>
</tbody>
</table>
Fast Fourier Transform (FFT)

The Fast Fourier Transform (FFT) is a special case of the Fourier Transform, a mathematical technique used to transform time-domain data into frequency-domain data. The output of the transform is a set of complex numbers representing both frequency and phase information about the original time series. The term Fast Fourier Transform comes from the fact that if you specify the time-domain data to contain a “power of 2” samples, the transformation can be calculated very quickly by digital computers. Powers of 2 are the values of $2^n$, where $n$ is an integer (1, 2, 3, etc.).

**Examples:**

<table>
<thead>
<tr>
<th>if $n$ is:</th>
<th>the power of 2 ($2^n$) is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>256</td>
</tr>
<tr>
<td>9</td>
<td>512</td>
</tr>
<tr>
<td>10</td>
<td>1024</td>
</tr>
<tr>
<td>11</td>
<td>2048</td>
</tr>
<tr>
<td>12</td>
<td>4096</td>
</tr>
</tbody>
</table>

All frequency transformations done within SmaartLive are FFTs and require the time record to be a power of 2 (samples) in length. For real-time operations, SmaartLive does the frequency domain transformation in pieces (frames).

**Note:** It is certainly possible to calculate the Fourier Transform for a time record with any number of samples. But when the number of samples is not a power of 2, the number of calculations required can become very large. (On a PC, this could result in a very slow Fourier Transform.)

**Frequency Resolution**

The frequency resolution of an FFT is calculated from the sampling rate and FFT size. For a given FFT size, the frequency resolution of the FFT will be equal to the sampling rate, divided by the FFT size. The FFT data points are distributed linearly along the frequency axis every “$Q$” Hertz, from 0 to the “Nyquist” Frequency (one half of the sampling rate), where $Q$ is the frequency resolution. For example, if you are sampling at 44,100 samples per second, an FFT size of 4096 (4k) yields a frequency resolution of 10.77 Hz, meaning the resulting FFT will have one data point every 10.77 Hz, from 0 to 22,050 Hz.
**SmaartLive’s Fixed-Point Per Octave (FPPO) Transfer Function Display**

One problem associated with the linear distribution of FFT data points arises from the fact that we hear frequencies logarithmically. Human hearing perceives each doubling of frequency as an equal interval and so each successive octave contains twice as many frequencies as the one below. Using the same example of a 4k FFT sampled at 44.1kHz discussed on the previous page, note that the resulting frequency of 10.77 Hz means that there will be only three data points between 31.5 Hz and 63 Hz (the center frequencies of the two lowest octaves), providing very poor resolution in this range.

In the two highest octaves, the span between the center frequencies (8kHz and 16kHz) is 8000 hertz. That works out to more than 700 FFT data points in this octave. When viewed using a logarithmic frequency scale, the data points across this range are so densely packed, that the display can be very difficult to interpret.

SmaartLive addresses this problem in Transfer Function mode by using multiple FFTs, at different sampling rates and FFT sizes, then combining the results to provide equal resolution in every octave (except the two lowest). The resolution of the Transfer Function mode display is 24 points per octave above 44 Hz (with a total of 24 points in the two lowest octaves). Note that using several FFTs also results in a longer time window at lower frequencies and a shorter time window at higher frequencies.

**Frequency Resolution and Octave/Fractional Octave Band Displays**

In Spectrum mode, the multiple-FFT technique used in Transfer Function mode is not an option due to a mathematical limitation and so all RTA displays are created from single FFTs. Since the linear distribution of FFT points in a single FFT, yields very low resolution in the lower octaves relative to the higher octaves, there may be bands at the low end that contain only 1 data point or no data point, depending on the display and FFT input parameters.

In octave or 1/3-octave band RTA display modes, SmaartLive will display only bands containing 2 or more FFT data points. The 1/6-, 1/12-, and 1/24-octave displays all require at least one data point per band. The wider spacing between FFT data points in the lower octaves accounts for the “missing teeth” on the low end in banded displays.

Increasing the FFT size, or decreasing the sampling rate will increase the frequency resolution and help to fill in the gaps on the low end. Note that both of these actions increase the time it takes to collect a group of samples. Looking at a signal over a longer period is the real key to increasing frequency resolution.
Impulse Response

You could think of the impulse response as the “signature” of a system (e.g., an audio device, room and/or electroacoustic system). For our purposes, we can define the impulse response as the signal that describes the changes a test signal undergoes as it passes through a device or system under test. The impulse response contains a wealth of information about the system including the delay through the system, frequency response, reflections, reverberation and decay. In fact, it is actually possible to use the impulse response of a room/system as a filter to convolve a “dry” signal, such as speech or music, and hear exactly what it would sound like if actually played through that same system in that room and heard at the position where the measurement was taken.

Pink and White Noise

Pink and white noise are sounds or audio signals containing random (or pseudorandom) broadband energy. Both are commonly used as signal sources in audio testing.

**Pink Noise**

Pink Noise is a signal which (when averaged over a period of time) has equal energy in each octave band. This means that when displayed on an octave band plot the spectrum of pink noise will appear flat. When the spectrum of pink noise is plotted on a narrowband display however, it will appear to “roll-off,” or decrease in energy at the rate of -3 dB per octave.

**White Noise**

White noise is a signal which (when averaged over a period of time) has equal energy for each frequency. This means that if you plot the spectrum of white noise in narrowband resolution, it should look flat. However, because there are twice as many Hertz in...
each successive octave band, white noise plotted on an octave band display will appear to increase 3 dB in energy for each successive octave as shown in the two figures below.

The distinction between these two types of noise is not important in Transfer Function measurements. The transfer function displays a comparison between the two input signals on a frequency-point by frequency-point basis. This is a concern when you are looking at a single channel (RTA) measurement of noise. If it appears flat in narrow band resolution, it is white. If it appears to be slopping down to the right on narrow band resolution (loss at high frequencies) it may be pink.

*Note:* White noise has so much high frequency energy it can damage loudspeakers if used improperly. We do not recommend it as a test signal for most audio applications.

**Sampling Rate**

The *sampling rate* in digital audio is the number of times per second an analog audio signal is sampled and digitized. The most important practical consideration is that the sampling rate limits the frequency content of the signal being digitized. A general rule is that sampling rate must be at least double the number of Hertz in the highest frequency you want to include in the digitized signal. The frequency that is equal to one half of the sampling rate is called the *Nyquist* frequency.

Some other issues affect the highest frequency you can accurately measure in sampled signals. In theory, you can measure to half the sampling frequency but in practice things like aliasing, Sigma/Delta conversion and anti-aliasing filters make frequencies close to the Nyquist tricky to measure.

Compact discs run at a standard sampling rate of 44.1kHz. Professional digital audio recording machines often sample at 48kHz to 96kHz. Computer sound cards generally run at one of several user-selectable sampling rates such as 44.1kHz, 22.05kHz or
11.025kHz. SmaartLive determines the available sampling rates by polling your computer’s sound card each time it loads. Currently, the fastest sampling rate supported by SmaartLive is 48kHz.

The two main things to remember about sampling rates are:

- The sampling rate limits the frequency content of a digitized signal on the high end.
- The sampling rate, together with the FFT frames size, determines both the length of the time window (the FFT time constant) and the frequency resolution of an FFT measurement.

**Signal Alignment**

When performing transfer function measurements, it is essential that the input signals to the sound card be aligned in time. To make a meaningful comparison of two signals, the transfer function calculation needs to “see” the same “piece” of each signal at the same time. With most types of analog audio equipment, this is not an issue and no compensation is normally required.

When measuring a device or system that does produce some propagation or throughput delay, such as a delay line or a loudspeaker with a microphone some distance away, you will need to compensate for delay before you can make a valid transfer function measurement. Compensating for delay requires finding the delay in the measurement signal and adding an equal amount of delay to the reference signal. SmaartLive’s delay locator and internal delay make this process relatively painless.

**Trace Smoothing**

In Transfer Function mode, the Smoothing feature can help to remove much of what appears to be noise in the Transfer Function trace, making overall trends in the response of a system much easier to see. Smoothing increases the apparent bandwidth of the FFT data points without reducing the frequency resolution. SmaartLive offers four smoothing options, 3-, 5-, 7- or 9-point. All smoothing options use running n-point centered averaging routine where the value of each data point on the transfer function trace is averaged with some number of adjacent points. For example, with 3-point smoothing each data point is averaged with the next point immediately higher and the point lower in frequency. 5-point smoothing averages each data point with the two points on either side of it and so on.
The Transfer Function

The transfer function is a *comparison* of two signals, typically a *reference* signal and a *measurement* signal. Most commonly, this comparison is made between the input and output of a device or system, such as an equalizer, sound system, or room. SmaartLive uses the transfer function calculation in both frequency response and impulse response measurements. Transfer function calculations are always performed in the frequency domain using FFT data. The results of the calculation are displayed in either the frequency or time domain, depending on the operating mode.

The *real-time* Transfer Function display plots transfer function results in the *frequency domain* to show the *frequency response* (magnitude and phase) of the device or system under test. In *Impulse mode*, SmaartLive calculates the transfer function using data from very long FFTs then transforms the result back into the time domain to show you the *impulse response* of the device or system under test.

These two types of transfer function measurements go hand in hand. The reference and measurement signals must be synchronized (aligned in time) to obtain a valid (real-time) frequency response measurement. The impulse response measurement is used to *find* the delay time for between the two input signals.
Glossary of Terms

**Analog to Digital (A/D) Conversion**: The process of digitizing an analog signal. This process almost always involves limiting the frequency content of the digitized signal.

**Amplitude**: The size of a real number (e.g., a number of volts), in either the positive or negative direction. The term amplitude typically refers to numbers that are not complex or plotted on a logarithmic scale, such as the numbers stored in the A/D process. (Numbers expressed logarithmically are more properly called magnitudes.)

**Attenuation**: A decrease in the level of a signal. Attenuation can refer to reduction in level for a specified frequency range or a decrease in the overall level.

**Coherence**: A mathematical function that represents the linearity between two signals. Coherence is conventionally expressed as a value between 0 and 1. Note that coherence is affected by measurement conditions and the number of averages used.

**Compressors**: Electronic devices that cause changes in gain (typically attenuation) as a function of the input level. These devices should NOT be used when making transfer function measurements as they are nonlinear by nature.

**Crosstalk**: Undesired energy in one signal (or channel) introduced from an adjacent signal or channel.

**Data Window**: A mathematical function used to reduce the negative effects of truncation that occurs when a finite number of FFT points are used to transform time domain data into the frequency domain. The Data Window(s) work by reducing the amplitude of the time domain data at the beginning and end of the FFT data series.

**Decay Rate**: The rate at which a signal decays (diminishes in magnitude), usually a function of frequency and expressed in either decibels per second, or relative to the amount of time that would be required for the signal to decay 60 decibels at the given rate of decay. *(see Reverberation Time)*

**Decibel**: The decibel, often abbreviated as dB, is a logarithmic ratio between two values. In acoustics, decibels most commonly refer to the ratio of an input level to the output level of a system, or a given level compared to a fixed reference.

**Dynamic Range**: The difference in level between the highest and lowest signal a system can accept or reproduce.
FFT: The Fast Fourier Transform is a mathematical technique used to transform time domain data into the frequency domain. The term “Fast” refers to the fact that when the number of time domain samples is a power of 2 (16, 32, 64, 128, 256, et al.) the calculations can be performed very quickly by a digital computer.

FFT Time Constant: The amount of time it takes to collect all the samples required for a single FFT frame of a given size at a given sampling rate. The time constant of an FFT, also called the time window, can be calculated by dividing the FFT size by the sampling rate. For example, a 4k FFT sampled at 44.1k samples/second has a time window of 0.09 seconds.

Graphic Equalizer: A device with a number of filters used to change the gain or attenuation of a signal at pre-selected frequencies. The bandwidths of the filters are typically set to one- or 1/3-octave and are usually not adjustable by the end user.

Latency: The delay through a given unit or system. Latency is often referred to as the throughput delay of a device. It is typical for digital delays to have a small latency even when they are set to zero time delay.

Linear Scale: The term linear, refers to a set of values or scale of a graph on which values are evenly spaced. On a linear scale, each value (or unit) has equal dimension.

Logarithmic Scale: A scale where each power of a given number (e.g., ten) is given equal dimension.

Magnitude: A number assigned to a quantity so that it may be compared with other quantities. For complex quantities, the magnitude is the square root of the sum of the squares of the real and imaginary parts.

Nyquist Frequency: In digital audio, the Nyquist frequency is equal to one half of the sampling rate. The Nyquist frequency represents the highest frequency obtainable in digitized a signal sampled at a given sampling rate.

Octave-Band Resolution: Octave band resolution combines all data points in a given octave and displays a total energy value for each octave band (as opposed to a linear or logarithmic narrowband display that plots the value of individual FFT data points). Standard octaves used in audio measurement are centered on 16, 31.5, 63, 125, 250, 500, 1k, 2k, 4k, 8k and 16k Hertz (cycles per second).

Overlap: For the purposes of SmaartLive, overlap refers to the amount of data each successive FFT Frame shares in common with the one before. Overlapping FFT frames
are analogous to shingles on a roof. When no overlap is used, each new FFT frame begins where the last one stopped, as beads on a string.

**Parametric Equalizer:** Equalizers are devices with one or more filters that affect the frequency content of a signal. On a *parametric* equalizers, the parameters of the filter(s) including gain or attenuation, frequency and bandwidth are user-adjustable.

**Phase Shift:** A timing difference in a signal (relative to some reference) at one or more frequencies, typically expressed in degrees.

**Pink Noise:** A random (or pseudorandom) signal in which, over a given averaging period, each *Octave-band* has an equal amount of energy.

**Propagation Delay:** The time it takes for sound to travel from one place (typically a loudspeaker) to another place (typically a microphone).

**Reverberation Time:** The amount of time required for audio energy introduced into a system (typically a room) to diminish, or decay a specified number of decibels. Often expressed as an RT60 value.

**RT60:** Reverberation time. The amount of time required for a system, typically a room, to decay 60 decibels. *(see Decay Rate)*

**Sampling Rate:** The number of points per second used in the analog to digital conversion process. Typically expressed in Hertz.

**Spectrograph:** A three-dimensional plot, displayed in two dimensions with color representing the third dimension (or z-axis). The spectrograph is a topographical representation of the common waterfall display.

**Spectrum:** The frequency content of a given signal.

**Speed of Sound:** The speed of sound is dependent on the material of propagation, the temperature and several other factors. Typical values for the speed of sound in air are 1120 ft/sec, or 341.376 m/sec. This is the value SmaartLive uses to calculate distance equivalents for time differences.

**Time Window:** The time constant (or effective time constant) of a measurement or other process.

**White Noise:** A random (or pseudorandom) signal in which over a given averaging period, each *frequency* has equal energy.
Selected Bibliography

The following is a list of publications suggested for readers who want to expand their understanding of the physical and theoretical concepts and mathematical procedures underlying SmaartLive, sound system design and acoustics.


Chapter 6: Troubleshooting

Installation Problems

Problems During Installation

The single most common cause for installation problems with SmaartLive and Windows software in general is a conflict with automatic virus checkers, system monitors and install monitors. Other types of programs can occasionally cause problems during installation as well. We therefore strongly recommend that you close all other Windows programs before installing SmaartLive.

Other possible causes for problems during the installation of SmaartLive include defective install media, not enough free space on the target hard disk, or on NT/2000/XP systems, the user account currently logged in does not have permission to access all the drives and/or directories in which SmaartLive needs to install or update files. Depending on how Windows security settings are configured, Administrator access may be required to install SmaartLive on these OS versions. Problems related to user permissions can also occur after installation on NT/2000/XP systems if the SmaartLive program folder is not designated as accessible to all users.

SmaartLive requires only about 18 Mb of disk space when installed however additional space is required during installation for temporary files. Windows itself may also require the use of some hard disk space reported as free and in general, it's a good idea to keep at least 200 Mb of hard disk space free at all times. If your computer runs too low on available disk space it can cause problems unrelated to SmaartLive.

Problems arising from defective install media can take several forms. The installer can crash or simply lock up with no explanation. You may also get file related error messages from Windows if the installation media is defective. If you believe you have a media-related install problem, contact SIA technical support for replacement media. Contact information for SIA technical support can be found at the end of this chapter.

Problems After Installation

A common source of problems during installation of SIA SmaartLive is a conflict between the installer program and automatic virus checkers, install monitors and system monitor software. The installation program needs to make changes to the
Windows Registry (registration database) and create or replace several files in the Windows System folder to properly install and register SmaartLive and its components with the operating system. Virus checkers and system/install monitor applications understandably protective of system files and folders and may prevent the installer from completing all the necessary steps.

Often, installation problems related to conflicts with other software manifest themselves after a seemingly successful installation. SmaartLive may complain about missing DLL or OCX files and/or refuse to run at all. Shutting down all other programs and repeating the installation will usually correct this problem.

In rare cases, SmaartLive may refuse to run after a seemingly successful installation due to a conflict with a MIDI driver (or conflicts between multiple MIDI drivers). If you attempt to run SmaartLive and receive no error messages but the program window never opens, try disabling all “MIDI Devices and Instruments” on the Devices tab (labeled Advanced in Windows 95) of the Windows Multimedia control panel by double-clicking each entry and selecting “Do not use MIDI features on this device.” Note that you may need to restart Windows after disabling devices for the changes to take affect. If this corrects the problem, you can re-enable these “devices” one at a time to find out which was at fault. In many cases, updated drivers may be available that will correct this problem.

If SmaartLive installed successfully and seems to run properly but you experience audio related problems when you run the program, its likely just a configuration problem. Refer to the sections on Configuring Audio Input/Output Controls, Sound Hardware Problems and Measurement Input Levels later in this chapter for help on troubleshooting audio problems.

**Configuring Audio Input/Output Controls**

If you experience problems getting a signal into SmaartLive from your computer’s line inputs or sending internally generated signals to the outputs, first check to make sure the correct Wave-In (input) and Wave-Out (output) “devices” are selected in SmaartLive’s Device Options, accessible by selecting Devices from the Options menu. Even if you know your computer has only one audio device, Windows may sometimes consider a voice modem driver or a driver for a device that is not even installed to be the “preferred” recording or playback (Wave-In or Wave-Out device).
If the Wave-In and Wave-Out device selections are correct in SmaartLive and you are having problems sending signals, the problem could be that Wave output control for the selected device is muted or turned down in the device’s mixer application. If you are having problems receiving audio signals, check the input mixer for the selected Wave-In device.

Beginning in Windows 95, the Windows Volume Control (mixer) application provides a standardized interface for controlling the audio inputs and outputs on most Windows-compatible sound hardware. A common misconception among new Smaart users is that the Volume Control mixer that you see initially when you open the Volume Control utility from the Windows taskbar controls both input and output signals. In fact, the Volume Control mixer controls only output signals. The input controls are hidden “behind” the volume (output) controls in a separate mixer called Recording Control.

If you have trouble getting a signal into SmaartLive from the computer’s (line-in) inputs or suspect the computer’s internal microphone may be enabled and contaminating your measurements, check the Recording Control mixer settings. To access the input mixer for the selected Wave-In device in SmaartLive, select Volume Control from the Options menu. To access the Recording Control mixer through Windows, use the following procedure.

• Open the Windows Volume Control — double-click the speaker icon (shown above) on the Windows Taskbar or click the Start button and select Programs > Accessories > Multimedia > Volume Control. If you do not have a Multimedia section in your Start menu the Volume Control may be listed under Programs > Accessories > Entertainment.

• In the Volume Control application, select Properties from the Options menu.

• Click the Recording “radio button,” make sure the boxes for Microphone and Line-In are checked in the list below, and click OK to exit the Properties dialog box.

Notice that the title of the Volume Control window changes to Recording Control. Make sure the Select box for Line-In is checked, confirm that the balance control is centered and the fader is set to a useful level. If your computer is equipped with an internal microphone, you will probably also want to un-check the Select box under the Microphone fader before exiting the Recording Control application.
Chapter 6: Troubleshooting

Sound Hardware Problems

General Troubleshooting Procedures

Windows-compatible sound hardware must be present and properly configured for your system to use SmaartLive. Smaart uses standard Windows multimedia interface techniques to access the sound card and should work properly with any Windows-compatible audio device. If your computer has more than one sound hardware and/or MIDI I/O device or driver set installed, you also need to make sure the proper devices are selected for both audio and MIDI I/O on the Devices tab of the Options dialog box (accessible from the Options menu).

If SmaartLive will not recognize your sound hardware, check to see if you can record and play wave files using the Sound Recorder and Media Player. These are standard Windows utilities, usually located under Multimedia or Entertainment in the Accessories section of the Programs menu (accessed by clicking the Start button on the Windows Taskbar).

If you cannot play and record using the Sound Recorder and/or the Media Player will not recognize you sound hardware, check to make sure both the hardware device and the software that drives it are properly installed. Sound hardware setup typically requires loading software drivers and utilities in addition to any hardware installation. Note that Sound Recorder and Media Player access sound hardware on a much more basic level than SmaartLive so the fact that a device works with these utilities it does not necessarily rule out a driver problem. It is nearly certain though, that if a device will not work with Sound Recorder and/or the Media Player it will not work with SmaartLive.

Depending on your system, the sound hardware driver software could be on a disk supplied with the sound card or computer, the Windows setup disk(s), or both. Some sound cards for desktop computers also require that you set jumpers or DIP switches on the card itself before installation. And if you have upgraded the version of Windows running on your computer from a previous version, you may need to obtain updated drivers for your input device from the sound card or computer manufacturer as well.

It is not uncommon for manufacturers to discover device driver software problems after a card or computer ships. If you are sure your hardware and software drivers are properly configured and you continue to experience problems, contact the sound
hardware or computer manufacturer. In many cases you can obtain updated driver software that will correct the problem(s).

**Work-Arounds for Sound Hardware Problems**

**Close Wave-In On Reset**

If you experience problems receiving audio data after changing display modes or input parameters in Smaart Pro, try selecting the check-box labeled *Close Wave-In On Reset* on the Inputs tab of the Options dialog box. This option provides a work-around and for a small number of sound card drivers that may not reset properly when input parameters are changed normally. In most cases SmaartLive does not need to close the sound card driver when resetting wave-in parameters but a few sound card drivers have been found to reset properly only when the driver is actually closed and reopened. When the *Close Wave-In On Reset* box is checked, you may hear pops or interruptions in internally generated test signals as SmaartLive changes wave-in device parameters but the program should perform normally otherwise.

**Use Old Wave Format**

If your input device seem posessed by demons, enabling this option is worth a try. The Use Old Wave Format option, also accessible from the Devices tab of the options dialog, is another work-around for sound hardware driver problems. This option provides compatibility for audio device drivers that do not properly support the updated Windows audio API calls first introduced in Windows 98SE.

Strange things can happen if you are running under Windows 98SE, ME, 2000 or XP with a driver that does not support the new calls properly. The range of problems we have heard reported include input signals building continuously in amplitude until the signal levels go into overload and stay there, high-frequency roll-off in one or both inputs, a stereo device suddenly becoming monaural and SmaartLive crashing outright on changing display modes or input parameters.

Checking the Use Old Wave Format box should correct any problem caused by driver level incompatibilities with the newer wave API calls. Note that this will also limit available sampling resolutions to 16 bits per sample under Windows 98SE, ME, 2000 and XP but to date we have only heard of these problems affecting 16-bit devices, so
that should not be a problem in most cases. Also not that if you are running SmaartLive under Windows 95 or the original release of Windows 98, this option should be turned on by default and should not be turned off.

**Measurement Input Levels**

It is very important to maintain proper input signal levels when performing measurements in SmaartLive. For best results in all types of measurements you need a signal that is strong enough to yield solid data and a good signal-to-noise (S/N) ratio but not so strong that high-level transient peaks may clip the input to the A/D converter. The input level meters in SmaartLive indicate the input signal level at the sound hardware’s A/D converter.

If the signal level is too low to yield a good signal-to-noise ratio, you may not get reliable, repeatable measurement results. If it is too high, the input(s) will overload causing “clipping.” This will not only compromise the accuracy of your measurements but could cause physical damage to your computer or input device in extreme cases.

The input level meters in SmaartLive include a clip indicator for each channel but when using a test signal with a high “crest factor,” such as pink noise, transient peaks in the signal may be too fast for the input level meters to detect. We recommend keeping the overall input signal levels at about –12 dB for random noise to prevent clipping the computer’s A/D converter.

If your computer has both microphone and line level inputs, be sure to avoid sending a line level signal to a microphone input. As a rule, we recommend you avoid using the microphone level inputs on most computer sound hardware altogether. The quality of the preamp circuitry on sound cards typically does not approach that of the preamps on even very modestly priced mixers and using a small mixer to manage input signals for measurements offers other advantages as well.
Problems with the Transfer Function

If the transfer function trace becomes erratic, ensure that there is a sufficient signal level at both inputs. For best results, use a signal containing broadband energy, such as pink noise, for full-range transfer function measurements if possible. All dynamic processors (devices for which the output level is dependent on the input level, such as compressors and limiters) should be bypassed if possible when performing Transfer Function measurements.

It is critical that the two signals be aligned in time for proper transfer function calculation. Any device that introduces a delay (even when in bypass) must be used on both input signals, compensated for by adding an identical delay to the other input channel, or completely removed from both the reference and measurement signal paths. When making acoustic (microphone) measurements you must always remember to find and compensate for the total of any delay through the system under test and the time required for sound to travel between the loudspeaker and measurement microphone.

In reverberant spaces with hard floors, if the microphone is positioned on (or just above) an acoustically reflective surface (such as a concrete floor or wall) comb filtering may occur. You can often reduce or eliminate comb filtering by placing acoustically absorptive materials below or behind the microphone or by placing some kind of obstruction in the path of a reflection to break up the wavefront. For example, a case lid from a mixing console stood on edge can work well for breaking up a floor bounce reflection. Another option is to place the measurement microphone on the floor so that the reflection time from the floor is too short to affect audible frequencies.

We recommend that omnidirectional microphones be used for almost all acoustic measurements. In extremely noisy or reverberant spaces, or when making measurements outdoors in the wind, using a high-quality cardioid microphone may help increase the coherence of transfer function measurement. This practice should generally be avoided though as the directional response of cardioid microphones can vary widely with frequency.
Delay Locator/Impulse Mode Problems

The following are some of the most common problems that affect both Delay Auto-Locator and Impulse mode measurements. Both of these features rely on an impulse response measurement so any problem that affects one will affect the other. And many of the problems – particularly signal-related problems – that can lead to unreliable impulse response measurements can compromise the quality of data in other types of measurements as well.

Poor Signal-to-Noise Ratio

In reverberant spaces, the amplitude of the peak in the impulse response plot is a function of the signal-to-noise ratio of the measurement. If you do not see a strong peak in the Impulse mode plot or the “noise floor” of the measurement is too high to see acoustical information about the room, it may be helpful to increase the gain of the measurement microphone and/or the loudspeaker(s) used to stimulate the room.

Another way to increase the signal-to-noise ratio in impulse response measurements is to increase the number of averages. The number of Averages for both the Small and Large time window presets is set (independently) on the Locator tab of the Options dialog box. If this value is greater than 1, the impulse recorder records the specified number of FFT frames and averages the data from all recorded frames in the impulse response calculation. Each doubling of the number of frames averaged will yield 3 dB more signal to noise (down to the absolute noise floor of the system under test or the measurements system, whichever is quieter).

Overloaded Inputs

If the impulse response plot appears “clipped,” or truncated at the top, make sure the signals coming into the computer are not overloading the sound card inputs. When using pink noise, the input levels shown on the meters should not exceed about –12 dB.

FFT Time Constant Too Short

If the Impulse mode plot appears erratic, without a single strong peak and/or with several peaks of nearly equal amplitude, the reason could be that the FFT Time Constant that is too short. Check to insure that the FFT time constant is set to a value larger than the decay time of the system under test.
Swapped Inputs

An oddity of the impulse recorder mathematics causes “negative” delays to be “wrapped around” and displayed at the end of the time scale, appearing to indicate an unusually long delay time. There are two common causes for this problem.

The most likely cause for “negative” delay is that input channels are “swapped” (the measurement signal is on channel 1, where SmaartLive expects to find the reference signal). In this case, selecting Flip Inputs in the Impulse menu should correct the problem but it’s usually preferable to physically swap the cables for the two input signals to avoid confusion elsewhere.

The other possible cause for a “negative” delay reading is that there really is a delay in the reference signal. This problem can usually be avoided by simply bringing the reference signal to the computer by the most direct route possible. Otherwise it may be necessary to measure and compensate for the reference signal delay using the internal delay or an external delay unit.

Digital signal processing devices are likely suspects for reference signal delay. Many digital delay units introduce some delay, even when set to “bypass” and/or indicating 0 ms delay time. This is called latency or throughput delay. Other digital devices may also introduce unwanted delay. If the reference channel delay is known, it is possible to calculate the actual delay by swapping inputs, running the impulse recorder again, and manually adding the reference delay to the propagation delay time reported.

Operator Error

One of the most common operator errors with regard to impulse response measurements in earlier versions of SIA-Smaart was forgetting to set SmaartLive’s internal signal delay to zero before making a new measurement. The Delay Auto-Locator in SmaartLive automatically bypasses the internal delay and by default, the program will warn you about a nonzero delay setting when you make a new measurement in Impulse mode. If you disable this option for some reason you will need to remember to clear the delay yourself before making an impulse response measurement. To avoid problems with Impulse mode measurements we recommend that you keep either the Warn if Delay Not 0 or Always Set Delay To 0 option enabled on the Locator tab of the Options dialog box.
Performance Issues

By default, SmaartLive attempts to collect and process new audio data from the computer’s audio inputs several times per second. This can result in there being very few leftover processor cycles available for processing key commands and mouse clicks on some machines.

If the program seems sluggish or unresponsive, taking a long time to respond to mouse clicks and keyboard commands try checking the box labeled Slow Computer on the Inputs tab of the Options dialog box. This will force SmaartLive to check the user interface more often and may improve overall responsiveness however it may also reduce the update speed of the display to some extent.

If the computer does not have enough physical RAM to hold all the information SmaartLive needs in memory problem it will utilize “virtual” memory and this can drastically affect the performance of the program. SmaartLive can even appear to hang in some cases. This is usually accompanied by a lot of hard disk activity as the computer pages data in and of physical memory to and from the hard disk.

If you experience this problem, shut down other programs to increase the amount of memory available to Smaart Pro if possible. You can also try keeping the number of used for averages for traces in SmaartLive as low as possible and display reference traces only when necessary. If problems persist, you may need to install additional RAM on your computer.

Font and Display Problems

Title and Label Font Problems

SmaartLive normally uses the Arial (TrueType) font family* for graph titles, labels and legends. These fonts are installed on your system by Windows and although they can be removed just like any other TrueType font, many Windows applications (including SmaartLive) expect them to be available and can behave somewhat erratically if they are not.

While SmaartLive can operate without these fonts, the appearance of on-screen controls and graphs may suffer if they are not available. Results may vary from one computer to another based on what fonts that are available. If one or more of the Arial font files are missing or corrupt, the problem can manifest itself in different ways.
Symptoms may include strange fonts and/or type sizes in graph labels and cursor readouts, and vertical plot labels failing to rotate (reading horizontally).

Control Spacing

You may have noticed that when changing video resolution or color depth in Windows you may also have the option of selecting “Small Fonts” or “Large Fonts.” Some driver sets provide additional choices. These options refer to the bitmapped screen fonts used in menus, dialog boxes, and other control areas. Because these fonts are made up of simple bitmaps (rather than scalable outlines) the display drivers usually include several font sets in varying sizes to accommodate different screen resolutions.

In some cases, button labels and spacing between controls in SmaartLive, particularly in dialog boxes, are based on the bitmapped system fonts loaded by the Windows video drivers. It is possible that some control areas may not display properly in all font/resolution combinations, depending on your display drivers.

* A Windows font family typically consists of four typefaces: the “normal” base font plus bold, italic, and bold italic.

Restoring the Default Configuration

The display and scaling options for SmaartLive are extremely flexible and can sometimes be confusing, especially at first. Nearly all of these options are stored in the current Configuration which is updated each time you exit the program.

When you start SmaartLive it looks up the last Configuration used and loads these settings. Any time you wish to return the program to its “factory” default settings, select Set All Values to Default from the Configuration section of the File menu. This resets all parameters except Color Scheme and Device selections.

Notes on External Devices

SmaartLive is capable of sending commands to external devices very quickly and under certain circumstances, may send instructions faster than a given device can process the incoming data. This can sometimes cause the command buffer on a receiving device to overflow and briefly stop processing incoming instructions. If an overflow occurs, the remote device will typically go “off-line” for a short time causing the message “[No Device Found]” to appear on the SmaartLive plot.
If you notice this happening, you may be making too many changes to the settings on the remote device too quickly. Try using the mouse instead of the arrow keys when you need to make large moves in filter settings. When you use the arrow keys, the computer sends every keystroke to the remote device whereas when you use the mouse to move a filter a command is sent only if you pause for a some length of time or release the mouse button.

A command buffer overflow is normally a non-fatal error and should not endanger the remote device or any other system components. SmaartLive can typically re-establish communication within one or two seconds and will automatically resolve any discrepancies between the current software control states and the external device settings.

The SmaartLive interface for controlling a given external device may not support all features available using the front panel controls or proprietary OEM control software and/or may not be exactly analogous to hardware controls or other control interface software available for the unit. Detailed information about the SmaartLive interface for each supported device type is available for download in PDF format on the SIA web site (www.siasoft.com).

Technical Support Information

Maintenance updates for SmaartLive will be posted on the SIA Software Company, Inc. web site as they become available. The SIA web site is located at www.siasoft.com. You can also find Application Notes, Case Studies, answers to frequently asked questions as well as product news and other information of interest to SmaartLive users on our web site.

Technical Support

Technical support is available through our web site, by e-mail, or by telephone. The SIA web site includes an on-line support forum — an electronic “bulletin board” where Smaart users can post questions and SIA support personnel as well as other users can respond. The web site also lists the most current contact information for SIA technical support in the Support section.

For technical support via e-mail, the address is support@siasoft.com. The telephone number for SIA technical support (in the USA) is (+01) 508-234-9877.
Index

Symbols
1/12-Octave 129
1/24-Octave 129
1/3 - Octave 129
1/6-Octave 129

A
About Sound Hardware 1
Active Input Commands 97
All Options 60, 139
Amplitude 179
Amplitude Range 130
Amplitude Range Commands. See View Menu Commands
Amplitude Scale 121
Amplitude Zoom 130
Analog to Digital (A/D) Conversion 179
Application Notes
Example Applications
  Delay Locator 77
  Measuring A Loudspeaker & Setting an Equalizer 78
  Measuring an Analog Equalizer 72
  SmaartLive as Spectrum Analyzer (RTA) 71
Measuring and Optimizing a Sound System
A Structured Approach 81
Evaluation Listening 82, 83, 84, 85, 89
Approaches to Stabilizing a Sound System 86
ASCII Save 93
Assign Locked Cursor To (Delay Preset) 123
Attenuation 179
Auto Delay Locator 38, 43, 125, 126
Auto Delay Locator Buttons 13
Averaging 170
Averaging and Smoothing 32
Averaging Reference Traces 50

B
Bandwidth
  Decrease 138
  Increase 138
Basic Concepts 170
  Averaging 170
  Coherence 170
  Data Window Functions 171
  Decibel 171
  Fast Fourier Transform (FFT) 173
  Frequency Resolution 173
  Pink / White Noise 175
  Sampling Rate 176
  Signal Alignment 177
  The Transfer Function 178
  Trace Smoothing 177
Bibliography 182
bitmap 69
Block Diagram of a Transfer Function Measurement 26
Boost filter 80

C
Cables and adapters 3
Calibrate to SPL 44
Calibrating the Display 44
Capture 98
Capture Command 98
Capturing a Reference Trace 49
Clear Delay 103
Clock 157
Coherence 34, 170, 179
Coherence Blanking 34, 36
Coherence Command 115
Color Options 139
Compare Delay Presets 124
Compressors 179
Configuration 58, 90, 91, 142, 164, 194
  Delete 91
  Export 91
  Import 91
  Load 90
  Restoring the Default Configuration 58, 194
Save 90
Save As 90
Saving and Restoring Configurations 58
Set All Values to Default 91
Configuration Commands. See File Menu Commands
Configuring External Devices 56, 158
Configuring the Screen 57
Configuring Windows Audio Controls 71, 185
Continuous Mode 122
Critical listening 84
Crosstalk 179
Cursor Commands. See View Menu Commands
Cursor Readout 7
Cursor Tracking 132

D
Data Window 179
Data Window Functions 171
Decay Rate 179
Decibel 171, 179
Decibel Amplitude Scaling 121
Decrease Boost 138
Decrease Delay 103
Decrease Frequency 138
Decrease Width 138
Delay 43, 125, 126
Assign Locked Cursor to (Delay Preset 123
Set Delay To Peak 123
The Internal Delay 63
Delay and Impulse Response Measurements 38
Delay Locator 38, 43. See also
   Delay; Impulse Mode; Locator Menu Commands
Continuous Mode 122
Flip Inputs 122
Locator Options 147
Start/Stop 121
Time Zoom 126
Delay Locator and Impulse Mode Problems 191
Delay Options 140
Delay Preset (F6 - F10) 103
Delay Time Commands 103
Delete Configuration 91
Deviation from Minimum Group Delay 29
Device Bar 8, 134
Device Options 142
Display 133
   Configuring 57
   Display and Font Problems 193
   Display Calibration 44
   Display Mode Buttons 10
   Dynamic Range 179

E
EQ 53
   Notes on External Equalizers 194
Erase All Reference Traces 100
Erase Reference Trace 99
Example Applications 71, 72, 74, 78
   Measuring a Loudspeaker and Setting an Equalizer 78
   Measuring an Analog Equalizer 72
   SmaartLive as a Spectrum Analyzer 71
Export Configuration 91
External Device
   Decrease Boost 138
   Decrease Frequency 138
   Decrease Width 138
   External Device Mode Command 136
   Flatten Selected Filter 137
   Increase Boost 138
   Increase Width 138
   Select Next Filter 137
   Select Previous Filter 137
External Device Control 11, 136
External Device Control Interface 53
External Device Information 56, 158
External Device Mode Command 136
External Devices 56, 158
   Device Bar 134
   External Device Control Interface 11, 53
External Equalizer Notes 194
External Hardware 2
   Cables and adapters 3
   Measurement Microphone 2
   Microphone Calibrator and/or SPL Meter 3
   Mixer or other level adjustment device 3
F
Fast Fourier Transform (FFT) 173
FFT 180
FFT Parameters 21
FFT Time Constant 180
Figures
Application Notes
  Figure #1 71
  Figure #3 72, 74
  Figure #4 78
  Figure #5 87
Pink Noise 175
White Noise 175
Filter
  Select Next 137
  Select Previous 137
Find Low 106
Find Next Higher 105
Find Next Lower 105
Find Peak 104
Flatten Selected Filter 137
Flip (Delay Locator) Inputs 122
Flip Reference Trace 99
Font and Display Problems 193
FPPO 174
Frequency Range
  Commands. See View Menu Commands
Frequency Range Move/Zoom Commands 126
Frequency Range Presets 129
Frequency Resolution 21, 173
  in Octave Band Displays 174
  in the Transfer Function Display 174
Frequency Response 26, 28
Frequency Response Measurements 26
Frequency Scale Commands 129
Frequency Zoom Options 156
Frequency Zooms 129
Frequency Zooms (1 - 4) 129
G
Generate Signal 96
Getting Started 1
  System Hardware 1
    About Sound Hardware 1
    Minimum Configuration 1
    Recommended Configuration 1
Glossary of Terms 179
Graph Options 144
Graphic Equalizer 180
Group Delay 29
H
Harmonics 106
  Next Harmonic 106
  Previous Harmonic 106
  Show 106
Hide All Reference Traces 100
Hide Input 109
I
Import Configuration 91
Impulse Mode 38, 121
  Working with Impulse Response Data 40
Impulse Mode Command 121
Impulse Mode Measurement Parameters 39
Impulse Mode Problems 191
Impulse Response Measurements 38
Increase Boost 138
Increase Delay 103
Increase Frequency 138
Increase Width 138
Input
  Active 97
    Show/Hide 109
Input Level Meters 12
Input Levels 189
Input Options 150
Input Signals 167
Installation 4
Installation Problems 184
Installing SIA SmaartLive 4
| Instantaneous 96 | Move Down 130 |
| Internal Delay 63 | Move Left 126 |
| Internal Delay Control 13 | Move Right 126 |
| Internal Signal Generator 65 | Move to Next Register 98 |
| Jumping to Other Programs 60 | Move Up 130 |

| Latency 180 | Narrowband 129 |
| Left (0) 97 | Navigating in SmaartLive 6 |
| LEQ 23 | Auto Delay Locator Buttons 13 |
| LEQ Report from File 110 | Cursor Readout 7 |
| Linear Amplitude Scaling 121 | Display Mode Buttons 10 |
| Linear Scale 180 | External Device Controls 10 |
| Load Configuration 90 | Input Level Meters 12 |
| Locator 125, 126 | Internal Delay Control 13 |
| Locator Options 147 | Mode Specific Controls 10 |
| Locked Cursor 67 | On and Pause Buttons 10 |
| Remove 107 | Plot Area 8 |
| Locked Cursor Commands. See Control Menu Commands | Plot Title and Clock 7 |
| Logarithmic Amplitude Scaling 121 | Set Delay To Peak button 13 |
| Logarithmic Frequency Scale 129 | Show / Hide Trace Buttons 12 |
| Logarithmic Scale 180 | Signal Generator Controls 11 |
| Magnitude 180 | Signal Level / SPL Display 12 |
| Magnitude Thresholding 36 | System Preset Controls 11 |
| Making a Screen Capture 69 | The Menu Bar 7 |
| Measurement Examples 71 | The Plot Area 8 |
| Measurement Microphone 2 | NC Rating 113 |
| Measurement Setup | NC Rating Table 113 |
| Typical Real-World Transfer Function Setup 62 | Next Harmonic 106 |
| Measurement Signal 26, 34, 36 | Noise Criterion Curves 144 |
| Menu Bar 7 | Noise Criterion Mode 112 |
| MIDI 11, 53, 56, 158 | Noise Criterion Rating 113 |
| MIDI Connection Setup 142 | Notes on External Equalizers 194 |
| MIDI Program Change 97 | Nyquist Frequency 180 |
| Minimum Configuration 1 | Octave 129 |
| Mixer or other level adjustment device 3 | Octave Band 129 |
| Mode Specific Controls 10 | Octave-Band Resolution 180 |
| Move Cursor 133 | On and Pause Buttons 10 |
| ON Button 95 | On-screen External Device Controls 136 |
Options. See Options Menu Commands

- All 60, 139
- Clock 157
- Color 139
- Delay 140
- Devices 142
- External Devices 56, 158
- Graph 144
- Input 150
- Locator 147
- Printing 152
- Spectrograph 153
- System Presets 164
- Volume Control 167
- Zooms 156
- Overlap 180

P

- Parametric Equalizer 181
- Pause Button 9
- Pause Command 95
- Performance Issues 193
- Phase Command 115
- Phase Display 28
  - Unwrapped 29
- Phase Range. See View Menu Commands
- Phase Shift 181
- Pink Noise 175, 181
- Pink/White Noise 175
- Plot Area 8
- Plot Title 144
- Plot Title and Clock 7
- Presets 58
- Previous Harmonic 106
- Primary X Range 126
- Print 94
- Print Preview 94
- Print Setup 95
- Printing 94, 95, 152
  - Print Preview 94
  - Print Setup 95
- Printing Options 152
- Problems with the Transfer Function 190
- Propagation Delay 181

Q

- Quick and Dirty SPL Calibration 46
- Quick Auto Delay 43
- Quick Auto Delay Large 125
- Quick Auto Delay Small 126
- Quick Zoom 133

R

- Real-Time Spectrum Analyzer 16
- Recommended Configuration 1
- Reference Commands. See Control Menu
  - Commands
- Reference Files 51
- Reference Information Dialog Box 51
- Reference Signal 26, 34, 36
- Reference Trace 48
  - Capture 98
  - Erase 99
  - Erase All 100
  - Flip 99
  - Hide All 100
  - Move to Next Register 98
  - Reference Information 100
  - Save Active 103
  - Saving and Comparing Traces 48
  - Select and Capture 98
  - Select Next and Capture 98
  - Show (Reference) 98
  - Subtract From 120
  - Use E as an Averaging Register 99
- Reference Traces
  - Saving and Retrieving Files 51
- Remove Locked Cursor 107
- Reseed Averages 96
- Restoring the Default Configuration 58, 194
- Reverberation Time 181
- Right (1) 97
- RT60 181
- RTA 108
- RTA Measurements 16
- rtjumps.txt 60
- Run 95
Sampling Rate 176, 181
Save (Configuration) As 90
Save Active Reference Trace 103
Save As 90
Save Configuration 90
Saving a Reference Trace 75
Saving and Restoring Program Configurations 58
Saving and Retrieving Reference Files 51
Screen Layout 6
Screen shots 69
Select and Capture 98
Select Next and Capture 98
Select Next Filter 137
Select Previous Filter 137
Selected Bibliography 182
Selected Device Readout 136
Set All Values to Default 91
Set Delay To Peak 123
Set Delay To Peak button 13
Set Equalizers and Delay Settings 84
Shift Active Trace 132
Shift Reference Trace 132
Show (Reference) 98
Show / Hide Trace Buttons 12
Show Harmonics 106
Show Inputs (View Menu) 109
Show Reference Information 100
Show Smoothed Transfer Function 116
Signal Alignment 177
Signal Generator
  Synchronous Stimulus Signals 66
Signal Generator Controls 11
Signal Level / SPL Display 12
Signal Level / SPL Readout 47
Smaart On 95
SmaartLive Commands
  Control Menu. See Control Menu Commands
  External Devices Menu. See External Devices Menu Commands
  File Menu. See File Menu Commands
  Locator Menu. See Locator Menu Commands
  Options Menu. See Options Menu
  View Menu. See View Menu Commands
SmaartLive Functions 14
SmaartLive Window Layout 6
Smoothing 32, 34
Sound Hardware 167, 185, 187
Sound Hardware, About 1
Sound Pressure Level 47
Spectrogram: 181
Spectrograph 17, 108
Spectrograph Command 109
Spectrograph Options 153
Spectrum 181
Spectrum Analyzer 16, 71
Spectrum and SPL Measurements 14
Spectrum Mode 108
Spectrum Mode Measurement Parameters 20
Spectrum Mode Overview 14
Speed of Sound 181
SPL
  Calibrating to 44
SPL History 108
SPL History Display 18
SPL Logging 23
SPL Measurements 44
SPL Readout 47
Stability Testing 85
Start 95
Start/Stop Delay Locator 121
Stored Measurement Data 48
Storing and Comparing Traces 48
Subtract From Reference Trace 120
Swap Transfer Function Inputs 26, 115
System Hardware 1
  Minimum Configuration 1
  Recommended Configuration 1
System Preset Commands 107
System Presets 58
  Commands. See Control Menu Commands
  Options 164
  System Preset Commands 107
  System Preset Controls 11
  System Presets (Options Menu) 164
Technical Support Information 195
The Delay Locator 38, 43
The Spectrograph 17
Thresholding 34, 36
Time Measurements 110
Time Window 181
Time Windowing 30
Timed Averaging and Logging 23
Timed Spectral / LEQ Measurements 23
Trace Difference 113
Trace Smoothing 177
Track Nearest Data Point 132
Transfer Function 73, 88, 178
  Averaging and Smoothing 32
  Coherence 34, 115
  Coherence Blanking 34
  Magnitude Thresholding 36
Overview 26
Phase 115
Phase Display 28
Show Smoothed Transfer Function 116
Smoothing 34
Swap Inputs 115
Transfer Function Mode 114
Troubleshooting 190
  Typical Real-World Measurement Setup 62
Transfer Function Block Diagram 26
Transfer Function Commands. See Control Menu Commands
Transfer Function Mode 114
Troubleshooting

Configuring Windows Audio Controls 71, 185
Delay Locator and Impulse Mode 191
Font and Display Problems 193
Input Levels 189
Installation Problems 184
Notes on External Equalizers 194
Performance Issues 193
Restoring the Default Configuration 58, 194
Sound Hardware 185, 187
Technical Support Information 195
Transfer Function 190
Typical Real World Transfer Function Setup 62

Unwrapped Phase Display 29
Use E as an Averaging Register 99

Vector vs. RMS Averaging 32
Volume Control 167

Weighting Curves 20, 68
White Noise 175, 181
Window Elements 6

z-axis 48, 97, 144
Zoom 133
Zoom In 126, 130
Zoom Options 156
Zoom Out 126, 130
Zooms (1 - 4) 129